
DETAILED
INSTRUCTIONS

DIGITAL VOICE
RECORDER

Thank you for purchasing an Olympus
Digital Voice Recorder.

Please read these instructions for information
about using the product correctly and safely.

Keep the instructions handy for future reference.

To ensure successful recordings, we recommend that
you test the record function and volume before use.
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Introduction

• The contents of this document may be changed in the future without advanced notice. 
Contact our Customer Support Center for the latest information relating to product names 
and model numbers.

• The screen and recorder illustrations shown in this manual were produced during the 
development stages and may differ from the actual product. The utmost care has been 
taken to ensure the integrity of the contents of this document. In the unlikely event that 
a questionable item, error, or omission is found, please contact our Customer Support 
Center.

• Any liability for passive damages or damage of any kind occurred due to data loss incurred 
by a defect of the product, repair performed by the third party other than Olympus or an 
Olympus authorized service station, or any other reason is excluded.

Trademarks and registered trademarks

• IBM and PC/AT are the trademarks or registered trademarks of International Business 
Machines Corporation.

• Microsoft, Windows and Windows Media are registered trademarks of Microsoft 
Corporation.

• Macintosh and iTunes are the trademarks of Apple Inc.
• microSD and microSDHC are the trademarks of SD Card Association.
• MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.
• EUPHONY MOBILETM is a trademark of DiMAGIC Corporation.
• DVMTM is a trademark of DiMAGIC Corporation.
• The product was developed based on noise-canceling technology under license from NEC 

Corporation.
• Nuance, the Nuance logo, RealSpeak and VoCon are trademarks or registered trademarks of 

Nuance Communications, Inc. or its subsidiaries in the United States and/or other countries. 
• The Daisy OK mark is a trademark of the Daisy Consortium.
Other product and brand names mentioned herein may be the trademarks or registered 
trademarks of their respective owners.
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The software in this product includes third party software. Any third party software is subject 
to the terms and conditions, imposed by the owners or licensers of that software, under 
which such software is provided to you. Those terms and conditions are shown below.

PCRE LICENCE:  PCRE is a library of functions to support regular expressions whose syntax 
and semantics are as close as possible to those of the Perl 5 language.  Release 5 of PCRE is 
distributed under the terms of the "BSD" licence, as specified below. The documentation for 
PCRE, supplied in the "doc" directory, is distributed under the same terms as the software 
itself.

Written by: Philip Hazel <ph10@cam.ac.uk> University of Cambridge Computing Service, 
Cambridge, England. Phone: +44 1223 334714

Copyright (c) 1997-2004 University of Cambridge All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

Redistributions of source code must retain the above copyright notice,  this list of conditions 
and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of the University of Cambridge nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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f Danger
If the product is used without 
observing the information given 
under this symbol, serious injury 
or death may result.

f Warning
If the product is used without 
observing the information given 
under this symbol, injury or death 
may result.

f Caution
If the product is used without 
observing the information 
given under this symbol, minor 
personal injury, damage to the 
equipment, or loss of valuable 
data may result.

Caution for usage environment

• To protect the high-precision 
technology contained in this 
product, never leave the recorder 
in the places listed below, no 
matter if in use or storage:
• Places where temperatures and/or 

humidity are high or go through 
extreme changes. Direct sunlight, 
beaches, locked cars, or near other 
heat sources (stove, radiator, etc.) or 
humidifiers.

• In sandy or dusty environments.
• Near flammable items or explosives.
• In wet places, such as bathrooms 

or in the rain. When using products 
with weatherproof designs, read their 
manuals as well.

• In places prone to strong vibrations.
• Never drop the recorder or 

subject it to severe shocks or 
vibrations.

• The recorder may malfunction 
if it is used in a location where 
it is subject to a magnetic/ 
electromagnetic field, radio 
waves, or high voltage, such 
as near a TV set, microwave, 
video game, loud speakers, 
large monitor unit, TV/radio 
tower, or transmission towers. 
In such cases, turn the recorder 
off and on again before further 
operation.

• Avoid recording or playing back 
near cellular phones or other 
wireless equipment, as they may 
cause interference and noise. 
If you experience noise, move 
to another place, or move the 
recorder further away from such 
equipment.

EN

Before using your new recorder, read this 
manual carefully to ensure that you know 
how to operate it safely and correctly. 
Keep this manual in an easily accessible 
location for future reference.

•  The warning symbols indicate important 
safety related information. To protect 
yourself and others from personal injury or 
damage to property, it is essential that you 
always read the warnings and information 
provided.

Safety precautions
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• Do not use organic solvents such 
as alcohol and lacquer thinner to 
clean the unit.

<Warning regarding data loss>

Recorded content in memory may 
be destroyed or erased by operating 
mistakes, unit malfunction, or during 
repair work.

It is recommended to back up and save 
important content to other media such as 
a computer hard disk.

Any liability for passive damages or 
damage of any kind occurred due to data 
loss incurred by a defect of the product, 
repair performed by the third party other 
than Olympus or an Olympus authorized 
service station, or any other reasons is 
excluded from the Olympus’s liability.

Handling the recorder

f Warning:
• Do not use the recorder near 

flammable or explosive gases.

• Keep young children and infants 
away from the recorder.

 Always use and store the recorder out of 
the reach of young children and infants 
to prevent the following dangerous 
situations which could cause serious 
injury:

1 Becoming entangled in the recorder 
strap, causing strangulation.

2 Accidentally swallowing the battery, 
cards or other small parts.

3 Accidentally being injured by the 
moving parts of the recorder.

• Do not use or store the recorder 
in dusty or humid places.

• Do not disassemble, repair or 
modify the unit yourself.

• Use microSD/microSDHC memory 
cards only. Never use other types 
of cards.

 If you accidentally insert another type 
of card into the recorder, contact an 
authorized distributor or service center. 
Do not try to remove the card by force.

• Do not operate the unit while 
operating a vehicle (such as a 
bicycle, motorcycle, or car).

f Caution:
• Stop using the recorder 

immediately if you notice any 
unusual odors, noise, or smoke 
around it.

 Never remove the batteries with bare 
hands, which may cause a fire or burn your 
hands.

• Be careful with the strap.
 Be careful with the strap when you carry 

the recorder. It could easily catch on stray 
objects and cause serious damage.

• Do not leave the recorder in 
places where it may be subject to 
extremely high temperatures.

 Doing so may cause parts to deteriorate 
and, in some circumstances, cause the 
recorder to catch fire. Do not use the 
charger or AC adapter if it is covered (such 
as a blanket). This could cause overheating, 
resulting in fire.

• Handle the recorder with care to 
avoid getting a low-temperature 
burn.
• When the recorder contains metal 

parts, overheating can result in a low-
temperature burn. Pay attention to the 
following:

• When used for a long period, the 
recorder will get hot. If you hold on 
to the recorder in this state, a low-
temperature burn may be caused.

EN

Safety precautions
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• To prevent causing battery leaks 
or damaging their terminals, 
carefully follow all instructions 
regarding the use of batteries. 
Never attempt to disassemble a 
battery or modify it in any way, 
solder, etc.

• Do not connect the battery 
directly to a power outlet 
or a cigarette lighter of an 
automobile.

• If battery fluid gets into your 
eyes, flush your eyes immediately 
with clear, cold running water 
and seek medical attention 
immediately.

f Warning:
• Keep batteries dry at all times.

• If rechargeable batteries have 
not been recharged within the 
specified time, stop charging 
them and do not use them.

• Do not use a battery if it is 
cracked or broken.

• Never subject batteries to strong 
shocks or continuous vibration.

• If a battery leaks, becomes 
discolored or deformed, or 
becomes abnormal in any other 
way during operation, stop using 
the recorder.

• If a battery leaks fluid onto your 
clothing or skin, remove the 
clothing and flush the affected 
area with clean, running cold 
water immediately. If the fluid 
burns your skin, seek medical 
attention immediately.

• Keep battery out of the reach of 
children.

• In places subject to extremely cold 
temperatures, the temperature of the 
recorder’s body may be lower than 
the environmental temperature. If 
possible, wear gloves when handling 
the recorder in cold temperatures.

• Do not touch the metallic parts of 
the recorder for a long period of 
time at low temperatures.

 This may damage your sk in. At low 
temperatures, handle the recorder while 
wearing gloves.

Battery handling precautions

Follow these important guidelines 
to prevent batteries from leaking, 
overheating, burning, exploding, or 
causing electrical shocks or burns.

f Danger:
• The recorder uses a lithium ion 

battery specified by Olympus. 
Charge the battery with the 
specified AC adapter or charger. 
Do not use any other AC adapters 
or chargers.

• Batteries should never be 
exposed to flame, heated, short-
circuited or disassembled.

• Never heat or incinerate 
batteries.

• Take precautions when carrying 
or storing batteries to prevent 
them from coming into contact 
with any metal objects such as 
jewelry, pins, fasteners, etc.

• Never store batteries where 
they will be exposed to direct 
sunlight, or subjected to high 
temperatures in a hot vehicle, 
near a heat source, etc.

EN

Safety precautions
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• If you notice anything unusual 
when using this product such as 
abnormal noise, heat, smoke, or a 
burning odor:
1 remove the battery immediately while 

being careful not to burn yourself, 
and;

2 call your dealer or local Olympus 
representative for service.

f Caution:
• Please recycle batteries to help 

save our planet’s resources. When 
you throw away dead batteries, 
be sure to cover their terminals 
and always observe local laws and 
regulations.

• Always charge a battery when 
using it for the first time, or if 
it has not been used for a long 
period.

• Rechargeable battery have 
limited lifetime. When the 
operating time becomes shorter 
even if the rechargeable battery 
is fully charged under the 
specified condition, replace it 
with a new one.

• The battery may become hot 
during prolonged use. To avoid 
minor burns, do not remove 
it immediately after using the 
recorder.

EN

Safety precautions

AC adapter

f Danger:
• Be sure to use the AC adapter 

with the proper voltage (AC 100 - 
240 V). Using it with other voltage 
levels may cause fire, explosion, 
overheating, electric shock or 
injury.

• For safety, be sure to unplug 
the AC adapter from the outlet 
before performing maintenance 
or cleaning. Also, never plug in or 
disconnect the power plug with a 
wet hand. This may cause electric 
shock or injury.

f Warning:
• Do not attempt to disassemble, 

repair or modify the AC adapter 
in any way.

• Keep foreign objects including 
water, metal, or flammable 
substances from getting inside 
the product.

• Do not moisten the AC adapter or 
touch it with a wet hand.

• Do not use the AC adapter in 
the vicinity of flammable gas 
(including gasoline, benzine and 
lacquer thinner).

In case

• ... the internal parts of the AC adapter 
are exposed because it has been 
dropped or otherwise damaged:

• ... the AC adapter is dropped 
in water, or if water, metal 
flammable substances or other 
foreign objects get inside it:
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Safety precautions

• Do not use or keep the AC adapter 
in very hot places, such as in 
direct sunlight, in a closed car 
on a sunny day, near a heater, 
on an electric carpet, etc. Do not 
use the AC adapter if something 
is covering it (such as a blanket). 
This may cause fire, explosion, 
leakage or overheating.

• ... you notice anything unusual 
when using the AC adapter such 
as abnormal noise, heat, smoke, 
or a burning odor:
1 do not touch any of the exposed parts;
2 immediately disconnect the power 

supply plug from the power outlet, 
and;

3 call your dealer or local Olympus 
representative for servicing. Continued 
use of the AC adapter under these 
circumstances could result in electric 
shock, fire or injury.

f Caution:
• Do not use the AC adapter if the 

power plug is damaged or the 
plug is not completely connected 
to the outlet. This may cause fire, 
overheating, electric shock, short 
circuit or damage.

• Unplug the AC adapter from AC 
outlet when not using. If this 
precaution is not followed, fire, 
overheating or electric shock may 
occur.

• Make sure to hold the plug when 
removing the power plug from 
the outlet. Do not bend the 
cord excessively or put a heavy 
object on it. This may cause fire, 
overheating, electric shock or 
damage.

• If something appears to be wrong 
with the AC adapter, unplug the 
AC adapter from the outlet and 
consult your nearest service 
center. Using the AC adapter may 
cause fire, overheating, electric 
shock or injury.

LCD monitor

• The LCD used for the monitor 
is made with high-precision 
technology. However, black 
spots or bright spots of light may 
appear constantly on the LCD 
Monitor. Due to its characteristics 
or the angle at which you are 
viewing the monitor, the spot 
may not be uniform in color 
and brightness. This is not a 
malfunction.
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Main features

s This recorder can tag recorded files 
or files transferred from a personal 
c o m p u t e r  w i t h key w o r d s t o 
manage a file database (☞ P.77).

 It is possible to search for files by file date 
or keyword (☞ P.55).

s It features a scheduling function 
(☞ P.101). You can record voice 
memo into an event (☞ P.106). 
You can also display and playback 
any audio file recorded in the 
recorder folder directly from the 
event display (☞ P.108).

s The settings and functions of this 
recorder can be controlled using 
speech recognition (☞ P.118) (For 
DM-4).

s By connecting a digital camera, 
you can import and view images 
(☞ P.114) (For DM-4).

s This recorder can import text 
data and read it aloud (☞ P.170) 
(For DM-4).

s Supports the linear PCM format, 
which is capable of recording 
sound quality equivalent to or 
surpassing CD-level.

 Capable of realistically recording various 
different sound sources. High resolution 
recording at a high sampling frequency 
equivalent or superior to that of a music 
CD (Sampling frequency 44.1 kHz, Bit 
count 16bit) is possible (☞ P.69).

s Supports a wide range of 
recording formats. Can handle 
the MP3 format (MPEG-1 Audio 
Layer 3), and the Windows Media 
Audio (WMA) format (☞ P.69).

 This device can save files in a highly 
compressed manner, thereby allowing 
for extended recording times. In 
addition, when connected to an external 
device, the recorder can encode 
incoming analog audio signals without a 
PC (☞ P.47).

s Supports high capacity recording 
media.
Besides the 8GB (DM-4) or 4GB 
(DM-2) built-in memory, you can 
also record onto a commercially-
available microSD card (☞ P.32).

s You can playback WAV, WMA, and 
MP3 format files transferred from 
a computer in addition to files 
recorded by the device itself.

 You can enjoy music at any time.
s It has a built-in Variable Control 

Voice Actuator (VCVA) function 
(☞ P.71).

s The Low Cut Filter minimizes 
air conditioner noise and other 
similar noises while recording 
(☞ P.71).

s The recording level can be 
adjusted automatically or 
manually (☞ P.69).

s A Noise Cancel function (☞ P.73) 
and a Voice Filter function 
(☞ P.73) cut noise and enable 
clear audio playback.

s For WMA-format recording, you 
can select one of 6 recording 
modes such as stereo or monaural 
(☞ P.69).

Getting started
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s Has built in recording scene 
setting (☞ P.84) and playback 
scene setting (☞ P.88) functions 
to register the recording or 
playback sound quality or mode 
according to different usages.

s You can move or copy files 
between the built-in memory 
and microSD card, and within the 
folders in the memory (☞ P.95).

s You can divide files (☞ P.97), 
or delete part of a file (☞ P.66) 
recorded in PCM format in this 
recorder.

s It has a 2.2 inch TFT color LCD panel 
(☞ P.16).

s It features various playback 
functions (☞ P.74, P.75).

s Index mark features allow you 
to quickly find desired locations 
(☞ P.53).

s The playback speed can be 
controlled as preferred (☞ P.75).

s The guidance feature (in English 
and other languages) gives 
audio notification of operating 
conditions. Various functions can 
be operated easily. There is also a 
function to read file information 
aloud (☞ P.89) (For DM-4).

s You may assign your own names 
to folders (☞ P.72).

s Timer recording (☞ P.85) and 
Alarm playback features (☞ P.91) 
enable automatic recording and 
playing at a set time.

s A directional microphone feature 
has been included that allows 
switching between broad stereo 
recording and recording with 
a highly directional quality 
(☞ P.70).

s EUPHONY MOBILE has been 
included to produce a natural, 
realistic experience without 
degrading sound quality (☞ P.73).

s Fast forward and rewind are 
possible at set intervals (☞ P.75).

s It’s possible to simplify the 
[Home] menu items display 
according to your purpose 
(☞ P.76) (For DM-4).

s Comes with “Olympus Sonority” 
software for Windows and 
Macintosh (☞ P.121).

 If you transfer voice files recorded with 
the recorder to a PC, you can easily 
playback, organize, and edit the files.

 You can perform waveform editing, file 
joining, and file splitting.

 If you connect the recorder to a 
computer, you can use it as a USB 
microphone or USB speaker (☞ P. 178).

s The “Olympus Sonority” can 
be upgraded to a “Olympus 
Sonority”, which is equipped with 
enhanced functionality (Option) 
(☞ P.148).

 In addition to the “Olympus Sonority” 
functions, editing of MP3 files and 
creation of music CDs can be performed.

Main features
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s This recorder is compatible 
with USB 2.0, enabling fast data 
transfer to a computer.

s It has a USB charging function 
(☞ P.25).

s It is compatible with DAISY 
(☞ P.144) (For DM-4).

 DAISY files can be transferred from the 
“Olympus Sonority” software and played 
from this recorder.

 The recorder can be connected to 
another DAISY compatible device to 
directly import content (☞ P. 120).

s It is compatible with Audio Book 
(☞ P.169).

s It is compatible with Podcasting 
(☞ P.139).

 If favorite Podcast URLs are registered 
in the “Olympus Sonority”, the latest 
broadcasting content will be received 
automatically. Open the [Podcast] folder 
on the recorder to quickly listen to the 
program (file) transferred from the 
“Olympus Sonority”.

s Compatible with Audible 
broadcasting (☞ P.171).

Main features
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Identification of parts

1 MIC (Microphone) jack

2 Built-in stereo microphone

3 LED indicator light

4 VOICE button (For DM-4)

 HOME button (For DM-2)

5 POWER/HOLD switch

6 Strap hole

7 Display(LCD Panel)

8 REC (Record) button

9 9 button

0 ̀ OK button (Play/Set)

! Fn button (F1/F2/F3)

@ STOP button

# + button

$ 0 button

% – button

^ Built-in speaker

& EAR (Earphone) jack

* Card cover

( Battery cover

) USB connector

- Power jack
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• Remove the screen protector on the 
display.
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[Home] menu display

When the power is turned on, the [Home] menu is displayed. 
The [Home] menu provides links to various functions. 
For more details about these functions, refer to their 
respective page numbers below.
• To move to the [Home] menu from another screen, 

press and hold the STOP button for more than 2 
seconds.

 
It’s possible to simplify the [Home] menu items display 
according to your purpose (☞ P.76) (For DM-4).
 When [Accessibility] is set to [Off]:

 1 2 3 4 7 8 9
 When [Accessibility] is set to [On]:

 1 2 5 6 8 9

Identification of parts

Menu Function

1 A Recorder

Records files to one of five voice recording folders (Folder 

A through Folder E) (☞ P.41). Recorded files can be tagged 
with keywords so that the files can be managed in a 
database (☞ P.77).

2 B Music
Manages music files imported from music software such 
as Windows Media Player and iTunes. This recorder can be 
used as a music player (☞ P.150, P.162).

3 C Podcast
Manages podcasts transferred to this recorder using the 
supplied “Olympus Sonority” software (☞ P.139).

4 D Audiobooks Manages DAISY books (☞ P.144) (For DM-4) and Audio Books 
(☞ P.169) transferred to this recorder using the supplied 
“Olympus Sonority” software. Also manages text files 
(☞ P.170) (For DM-4) directly transferred to this recorder. 5 u DAISY

6 t Text Speech
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When the recorder is displayed the [Home] menu display, Fn buttons (F1, F2, F3) works as 
follows.

[F1] button Displays the date and time, informs even in the voice guide.

[F2] button Informs the battery remaining in the voice guide.Informs the battery remaining in the voice guide.

[F3] button Returns to the playback screen during file playback.

Menu Function

7 E Picture
You can import images by connecting a digital camera to 
this recorder (☞ P.114) (For DM-4).

8 F Audio Diary Registers and manages schedules (☞ P.101).

9 G Preferences Sets various functions of the recorder.

Identification of parts
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Identification of parts

[Recorder] mode display

1 File name

2 Folder name

3 Current file number/
Total number of recorded files in 
the list

4 Recorder status indicator

5 Level meter

6 Index indicator

7 Function guide indicator

8 Current time

9 Recording mode indicator

0 Elapsed recording time

! Remaining recording time

Playback displayRecording display

1 File name

2 Folder name/Keyword/Date

3 Current file number/Total number 
of recorded files in the list

4 Playback position bar indicator

5 Recorder status indicator

6 Index indicator/File information 
indicator

7 Function guide indicator

8 Current time

9 File format

0 File length

! Elapsed playback time

[h][g] Memory indicator

[j] Timer indicator

[i] Alarm indicator

[k] Battery indicator

[A]  Microphone Sensitivity indicator

[Z] VCVA indicator

[c] Low Cut Filter indicator

Icon display (For all modes)

[Q] Zoom Mic indicator

[a] Noise Cancel indicator

[b] Voice Filter indicator

[W] EUPHONY indicator

[d][e] Repeat indicator

[f] Random indicator

1

8

7

2

3

5

6

4

9

0
!

1

8

7

2

3

5

6

4

9

!
0
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[Music] [Podcast] mode display

Podcast playback display*Music playback display

1 File name

2 Search category

3 Current file number/
Total number of recorded files in 
the list

4 Playback position bar indicator

5 Recorder status indicator

6 Information display area

7 Function guide indicator

8 Current time

9 File format

0 File length

! Elapsed playback time

1 File name

2 Program name

3 Current file number/
Total number of recorded files in 
the folder

4 Playback position bar indicator

5 Recorder status indicator

6 Information display area

7 Function guide indicator

8 Current time

9 File format

0 File length

! Elapsed playback time

 
* When [Accessibility] is set to [On], this 

function can not be used. To use this 
function, please set [Accessibility] to [Off] 
(☞ P.76) (For DM-4).
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Identification of parts

[Audiobooks] mode display

Audio book playback display*DAISY playback display (For DM-4)

1 Table of contents indicator 

2 Contents name

3 Playback position bar indicator

4 Recorder status indicator

5 Text display area

6 Function guide indicator

7 Current time

8 File format

9 File length

0 Elapsed playback time

1 File name

2 Contents name

3 Current file number/Total number 
of recorded files in the folder

4 Playback position bar indicator

5 Recorder status indicator

6 Information display area

7 Function guide indicator

8 Current time

9 File format

0 File length

! Elapsed playback time

 
* When [Accessibility] is set to [On], this 

function can not be used. To use this 
function, please set [Accessibility] to [Off] 
(☞ P.76) (For DM-4).
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Identification of parts

[Audiobooks] mode display

Calendar displayText playback display (For DM-4)

1 File name

2 Folder name

3Playback position bar indicator

4 Recorder status indicator

5 Text display area

6 Function guide indicator

7 Current time

8 File format

1 Title indicator

2 Year and month

3 Calendar display area

4 Schedule information display 
area

 [ ] Voice memos number   
 indicator

 [ ] Events number indicator

 [ ] Recorded files number  
 indicator

5 Function guide indicator

6 Current time

7 Day registered in schedule

8 Current day

[Audio Diary] mode display

1

6

5

2

3

4

7

8

1

7

5

6

4

3

2
8
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Power supply

 1 W h i l e p u s h i n g d ow n o n t h e 
grooves using both thumbs, slide 
the battery cover in the direction 
indicated by the arrow.

Inserting the battery

This recorder uses a lithium ion battery 
specified by Olympus (LI-50B). Do not use 
any other type of battery.

 2 With the back label of the battery 
facing up, line up the terminals of 
the recorder and battery. Insert the 
battery by sliding in direction A 
while pushing down in direction B.

 3 Close the battery cover by sliding 
all the way in direction B while 
pushing down in direction A.

• Be careful of the direction of the 
battery when inserting it.

• The supplied rechargeable battery 
is not fully charged. Before using the 
unit the first time or after long periods 
of disuse, it is recommended that you 
charge it until full (☞ P.24).

 Notes

• Be sure to stop the recorder before replacing 
the battery. Unloading the battery while the 
recorder is in use may corrupt the file.

• The battery cover is not attached at the 
time of purchase.

• Do not use too much force when inserting 
the battery. Use only the method listed 
above to install and remove the battery. 
Otherwise, damage may occur.

• If it takes longer than 15 minutes to replace 
the dead battery or if you take the battery 
in and out repeatedly at short intervals, you 
may have to reset the time when you have 
loaded fresh batteries (☞ P.30).

• Remove the battery if you are not going to 
use the recorder for an extended period of 
time.

P
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Power supply

Charge the battery

Lithium ion battery is self 
discharging. After unpacking 
this product, charge the supplied 
lithium ion battery before using 
the recorder for the first time.

Charging using AC adapter

The included AC adapter (A515) can be connected 
to this recorder for charging. We recommend 
using the AC adapter when recording or 
operating the recorder for long periods.

 1 Connect the AC adapter in to an 
AC outlet.

 2 Connect the AC adapter to the 
recorder.

• Charging has star ted when LED 
indicator light is orange and the battery 
indicator on the display changes to the 
charging indicator.

• When playing a voice/music file, the 
recorder may be reset due to the 
reduction of the voltage output of the 
battery depending on the volume level 
even if [k] is displayed in the battery 
indicator. In this case, lower the volume of 
the recorder.

• When replacing rechargeable battery, be 
sure to use lithium ion battery (LI-50B) 
specified by Olympus. The use of other 
manufacturers' products can damage the 
recorder and should be avoided.
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Power supply

 Notes

• Do not put in or take out the battery or AC 
adapter when the recorder power is on or 
when this recorder is connected to another 
device. It may cause problems with the 
values and functions set in the recorder.

• The charger can be used within the range of 
AC 100 V to AC 240 V (50/60 Hz). When using 
the charger abroad, you may need a plug 
adapter to convert the plug to the shape of 
the AC wall outlet. For details, ask at your 
local electrical shop or travel agent.

• Do not use travel voltage converters as they 
could damage your charger.

Charging by connecting to a 
computer via USB

You can charge the battery by connecting 
to a PC's USB port. When charging, be sure 
to correctly place the rechargeable battery 
(supplied) into the recorder (☞ P.23).

 1 Boot the PC.

 2 Connect the USB connection 
cable to the USB port of the PC.

 3 While the recorder is during stop 
mode or hold mode, connect 
the USB cable to the connecting 
terminal on the bottom of this 
recorder.

• Charging has star ted when LED 
indicator light is orange and the battery 
indicator on the display changes to the 
charging indicator.
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Connect to the USB connecting AC 
adapter (optional) to charge

It can be charged by connecting to the USB 
connecting AC adapter (A514) (optional).
Before connecting the AC adapter, switch 
the USB Connection setting to [AC] (☞ P.98).

 1 Plug the AC adapter into AC 
outlet.

 2 Plug the recorder’s USB 
connecting cable into the AC 
adapter.

 3 Make sure that the recorder is 
turned off, connect the USB cable 
to the connecting terminal on the 
bottom of this recorder.

• Charging has started when LED 
indicator light is orange and the 
battery indicator on the display 
changes to the charging indicator.

 Notes

• The recorder cannot be charged when the 
PC is not turned on. Also, it may not be 
charged when the PC is not switched on, 
or when it is in the standby, hibernate or 
sleep mode.

• Do not charge the recorder with the USB 
hub connected.

• Charging is completed when battery 
indication becomes [<] (charging time: 
approximately 3 hours *).

 *  It shows the approximate time when 
charging the rechargeable battery fully 
from no remaining power at the room 
temperature. The charging time will be 
changed depending on the remaining 
amount and the state of battery.

• You cannot charge when [;]*1 or [=]*2 
is displayed. Charge the battery at the 
temperature from 5°C to 35°C (41°F to 95°F).
*1  [;]:  When surrounding temperature is 

low.
*2 [=]:  When surrounding temperature is 

high.
• When using time becomes notably short 

even after the battery are fully charged, 
replace them with new ones.

• Be sure to push the USB connector all the 
way in. Otherwise, the recorder may not 
operate properly.

• Be sure to use the attached dedicated 
cable for the USB connection cable. If 
any other company’s cable is used, it 
may cause problems. Also, please do not 
connect this dedicated cable to any other 
company’s product.

Power supply
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Cautions concerning the rechargeable batteries

Read the following descriptions carefully 
when you use the lithium ion battery (LI-
50B).

Discharging:

The rechargeable batteries self-discharge 
while this is not in use. Be sure to charge 
them regularly before use.

Operating temperature:

The rechargeable batteries are chemical 
products. The rechargeable batteries 
efficiency may fluctuate even when 
operating within the recommended 
temperature range. This is an inherent 
nature of such products.

Recommended temperature range:

When operating appliance:

 0°C - 42°C/ 32°F - 107.6°F
Charging:

 5°C - 35°C/ 41°F - 95°F
Storage for a long period:

 –20°C - 30°C/ –4°F - 86°F

Power supply

Using the rechargeable battery outside 
the above temperature range may result in 
declining efficiency and shorter battery life. 
In order to prevent battery leakage or rust, 
remove the rechargeable battery from the 
products when you will not be using them 
for a long time, and store them separately.

Battery indicator

The battery indicator on the display changes 
as the battery loses power.

k { l { m
• When [m] appears on the display, 

charging the battery as soon as possible. 
When the battery is too weak, [n] and 
[Battery Low] appears on the display, the 
recorder shuts down.

• While charging, the battery indicator 
constantly changes and does not show the 
actual amount of power remaining.

 Notes

• This recorder is designed to fully charge 
batteries regardless of their energy level. 
However, for best results when charging 
newly purchased rechargeable batteries 
or batteries that have not been used 
for a long time (more than one month), 
it is recommended to fully charge the 
batteries then discharge repeatedly for 2 
to 3 times.

• When disposing rechargeable batteries, 
always observe the local laws and 
regulations. Contact your local recycling 
center for proper disposal methods.

• If lithium ion batteries are not fully 
discharged, protect against short-
circuiting (e.g. by taping the contacts) 
before disposing.
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• The LED light will light up then power will 
be turned on and the display will turn on 
showing the OLYMPUS logo.

• When the home screen is displayed, you can 
operate the recorder. The home screen will 
appear after [Please Wait] appears on the 
screen.

Turning on the power

While the recorder is turned off, 
slide the POWER/HOLD switch in the 
direction indicated by the arrow for 
2 seconds or longer.

Turning on/off the power

When the recorder is not being used, turn 
the power off to reduce battery consumption 
to a minimum. Even if the power is turned 
off, existing data, mode settings, and clock 
settings will be maintained.

Power supply

Turning off the power

Slide the POWER/HOLD switch in the 
direction indicated by the arrow for 
1 seconds or longer.

• The display shuts off, and the power will 
be turned off.

Auto Power off mode

If the recorder is on and stops for 10 minutes  
or longer (default setting), the recorder enters 
Auto Power off mode and turns off the power. 
You can set the time to enter power save 
mode from among [5minutes], [10minutes], 
[30minutes], [1hour], [2hours], [3hours] and 
[Off] (☞ P.79).
To exit Auto Power off mode , turn on the 
power again.
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Set the recorder to HOLD mode

Slide the POWER/HOLD switch to the 
HOLD position.

If you bring the POWER/HOLD switch to the 
HOLD position, the current conditions will be 
preserved, and all buttons and switches will 
be disabled. This feature is useful when the 
recorder has to be carried in a bag or pocket. 
Also, you can stop to prevent accident during 
recording.

• After [Hold] appears on the display, the 
recorder is set to HOLD mode.

Exit HOLD mode

Slide the POWER/HOLD switch to the 
A position.

 Notes

• If you press any button in Hold mode, the 
LED indicator light flashes blue but no 
operation is performed.

• If HOLD is applied during playback 
(recording), operation is disabled with 
the playback (recording) state unchanged 
(When playback has ended and the 
recording has ended due to the remaining 
memory being used up, it will stop). H

O
LD
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If you set the time and date beforehand, 
the information when the file is recorded is 
automatically stored for each file. Setting the 
time and date beforehand enables easier file 
management.

 1 Press the 9 or 0 button to 
select the item to set.

• Select the item from the “hour”, 
“minute”, “year”, “month” and “day” 
with a flashing point.

 2 Press the + or − button to set.

Setting time and date [Time & Date]

When you use this recorder for the 
first time after purchasing, or when 
you switch it on after removing the 
batteries for more than 15 minutes 
when exchanging batteries etc, the 
[Set Time & Date] will appear. When 
the “hour” is flashing, conduct the 
setup from Step 1.

• Follow the same steps by pressing the 
9 or 0 button to select the next 
item, and press the + or − button to 
set.

• You can select between 12 and 24 hour 
display by pressing the F2 (24H) button 
while setting the hour and minute.

 Example: 10:20 P.M

10:20 PM
(Initial setting)

22:20

• You can select the order of the “month”, 
“day” and “year” by pressing the F2 
(M/D/Y) button while setting them.

 Example: April 15, 2010

2010Y 4M 15D

(Initial setting)

4M 15D 2010Y

15D 4M 2010Y

 3 Press the `OK button to 
complete the setting.

• The clock will start from the set date 
and time. Press the `OK button 
according to the time signal.

 Notes

• If you press the `OK button during the 
setup operation, the recorder will save the 
items that were set to that point.

• After setup, a message will sound saying 
that if the guidance is not required, select 
[Off], and the display goes into [Voice 
Guide] (☞ P.89) setup. If you don’t want 
the guidance feature, select [Off].
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The voice control function 
can be used with this setting 
(☞ P.118) (For DM-4).
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 1 Select [Time & Date] from the 
menu on the [System Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P. 67).

 2 Press the 9 or 0 button 
to select the item to set.

• Select the item from the “hour”, 
“minute”, “year”, “month” and “day” 
with a flashing point.

Changing the time and date

If the current time and date is not correct, 
set it using the procedure below.

 3 Press the + or − button to set.

Setting time and date [Time & Date]

The voice control function can 
be used with this setting
(☞ P.118) (For DM-4).

• Follow the same steps by pressing 
the 9 or 0 button to select 
the next item, and press the + or − 
button to set.

 4 After the date and time have 
been set, press the `OK 
button.
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Inserting and ejecting a microSD card

 2 Face the microSD card the correct 
way and insert it into the card 
slot as shown in the diagram.

The “microSD” indicated in the instruction 
manual refers to both microSD and 
microSDHC. This recorder can be used with 
commercially available microSD cards as 
well as the built-in memory.

Inserting a microSD card

 1 While the recorder is during stop 
mode, open the card cover.

• Insert the microSD card keeping it 
straight.

• Inserting the microSD card the wrong 
way or at an angle could damage the 
contact area or cause the microSD 
card to jam.

• If the microSD card is not inserted all 
the way, data cannot be written to the 
microSD card.

 3 Close the card cover securely.

• When you insert the microSD card, 
the recording media changeover 
display will appear.

 4 When you are recording to a 
microSD card, press the + or − 
button and select [Yes].

 5 Press the `OK button to complete 
the setting.

 Notes

• It is possible to switch the recording media 
over to the built-in memory (☞ P.78).

• In some cases microSD card which have 
been formatted (initialized) by another 
device, such as a computer, cannot be 
recognized. Be sure to format them with 
this recorder before using (☞ P.99).
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Ejecting a microSD card

 1 While the recorder is during stop 
mode, open the card cover.

 2 Push the microSD card inward to 
unlock it, and let it eject partially.

• The microSD card is visibly out of the 
slot and can be removed safely.

• When [Memory Select] is set to 
[microSD Card], [Built-in Memory 
Selected] will appear.

 3 Close the card cover securely.

Inserting and ejecting a microSD card

 Notes

• Releasing your finger quickly after pushing 
the microSD card inward may cause it to 
eject forcefully out of the slot.

• Depending on the microSD card maker 
or type, some microSD cards may not be 
recognized properly due to incompatibility 
issues with the recorder.

• Be sure to read the instruction manual 
supplied with the microSD card before using 
it.

• In the case when the microSD card cannot 
be recognized, remove the microSD card 
then put it in again to see if this recorder 
recognizes the microSD card.

• The processing performance reduces in a 
microSD card when you repeat writing and 
delete. In this case, format the microSD card 
(☞ P.99).

• There is no guarantee that all microSD cards 
work with the recorder.

• See the Olympus support homepage for 
a list of microSD cards verified for this 
recorder in accordance with the Olympus 
standards.

 http://olympus-imaging.com/
 Although verified SD card makers are 

shown on the Olympus homepage, 
Olympus doesn’t guarantee compatibility 
in all cases.

 Also, according to changes in card 
specifications, support may become no 
longer available.
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Notes on the folders

The built-in memory or the microSD card can be used for the recording media. Regardless 
of the recording media, voice file, music files, and contents files are separated and saved 
respectively into the folders organized in a branching tree-style.

About the folders for voice recordings

[Folder A] - [Folder E] within the [Recorder] folder are the folders for voice recordings.
When recording with this recorder, select any one of the five folders and then record.

 Note

• Files or folders located under the folder [Recorder] will not be indicated on the recorder.

Each folder can store up to 999 files.

Folders for voice recordings

Folder list 
display

VOC_100201-0001.wav

VOC_100201-0002.mp3

VOC_100201-0003.wav

VOC_100201-0004.wma

File list 
display

Folder File

Recorder

Folder A

Folder B

Folder C

Folder D

Folder E

File names will be automatically created for files recorded by this recorder.

1 User ID:
The user ID name that has been set on 
the Digital Voice Recorder. The user 
ID can be changed in the Olympus 
Sonority.

2 Recording date:
The recording date is displayed using 
six digits. 

Example: February 1, 2010 is displayed 
as “100201”.

3 File number:
A serial number automatically 
assigned by a Digital Voice Recorder.

4 Extension:
These are the file name extensions for 
the recording format when recording 
with this device.
• Linear PCM format:  .wav
• MP3 format:  .mp3
• WMA format:  .wma
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Notes on the folders

About the folder for music playback

When transferring music files to the device using Windows Media Player, a folder is 
automatically created within the [Music] folder which has a layered structure as shown in the 
diagram below.

• It can be stored a total of 999 files and folders in the each folders of [Music] folder.
• Up to 8000 (6000*) songs can be transferred to the [Music] folder.
• Up to 1000 (100*) playlists can be transferred to the [Music] folder.
* For DM-4

File searches are 
performed to the 
4th layer.

Music Artist

Artist

Artist

Artist

Album

Album

Album

Album

Folder

File

File search 
display

Artist list 
display

Album list 
display

File list display 

Folder configuration image

Screen display example

First layer Second layer Third layer
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Folder configuration image

Screen display example

Notes on the folders

• It can be stored a total of 999 files and folders in the each folders of [Podcast] folder.
• Up to 8000 (6000*) files can be transferred to the [Podcast] folder.
* For DM-4

File searches are 
performed to the 
4th layer.

About the folder for Podcast contents

A [Podcast] folder to store podcasts is prepared in advance. Programs (files) transmitted 
from the “Olympus Sonority” can be played. With the recorder stopped, open the [Podcast]* 
folder at the [Home] menu to display a list of files and folders stored in the folder.
 For “Podcast” please see ☞ P.139.
* When [Accessibility] is set to [On], this function can not be used. To use this function, 

please set [Accessibility] to [Off] (☞ P.76) (For DM-4).

Folder

File

Podcast Program

Program

Program

Program

Program list 
display

File list 
display

File display

First layer Second layer
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Screen display example

Notes on the folders

About the folder for electronic book contents and text files

A folder to store electronic book files such as DAISY content and audiobooks is prepared in 
advance. Electronic book files that have been transferred to the recorder can be listened to. 
Furthermore, a folder to manage text data imported to the recorder is also prepared in advance. 
For “DAISY” please see ☞ P.144, for “Audio Book”* please see ☞ P.169, for “Text Speech” please 
see ☞ P.170.
* When [Accessibility] is set to [On], this function can not be used. To use this function, 

please set [Accessibility] to [Off] (☞ P.76) (For DM-4).

Book list 
display

Contents list 
display

File list display File display

Folder configuration image

DAISY*

Contents

Contents

Folder

File

First layer Second layer

• It can be stored a total of 999 files and folders in the each folders of [DAISY] folder.
• Up to 100 contents can be transferred to the [DAISY] folder.

Contents

Contents

* For DM-4
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Screen display 
example

Folder configuration image

Folder configuration image

Audio Book

Text Speech Data

Screen display 
example

Book list 
display

Contents list 
display

File display

Book list 
display

File list display File display

Notes on the folders

Folder File

First layer Second layer

• It can be stored a total of 999 files and folders in 
the each folders of [Audio Book] folder.

• Up to 1000 contents can be transferred to the 
[Audio Book] folder.

• All the contents transferred will be listed in the 
[AudioBook] folder.

• It can be stored a total of 999 files and folders in 
the each folders of [Text Speech] folder.

• Up to 1000 files can be transferred to the [Text 
Speech] folder.

Folder File
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Notes on the folders

Screen display example

Folder configuration image

About the folder for Audible contents

Audible files can be redirected from the Audible website to the recorder using the 
AudibleManager (☞ P.171) or Windows Media Player.
When redirecting Audible files to this recorder using the AudibleManager, an [Audible] 
folder for playing Audible files will automatically be created in the [Audiobooks] folder, and 
the files stored there.
When redirecting Audible files to this recorder using the Windows Media Player, an [Artist] 
folder for playing will be created in the [Audiobooks] folder, just like for music files, and the 
files will be stored there.

First layer Second layer Third layer

It can be stored a total of 999 files and folders in the each folders of [Audible] folder.

Audible Artist

Artist

Artist

Artist

Album

Album

Album

Album

Folder

File

Artist list 
display

File list 
display

File displayBook list 
display
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Screen display example

Folder configuration image

Notes on the folders

About the folder for picture

A folder to store images imported from a connected digital camera is prepared in advance. 
The [IMAGE]* folder is managed by the dates images were taken.
For “Viewing images” please see ☞ P.114.
* When [Accessibility] is set to [On], this function can not be used. To use this function, 

please set [Accessibility] to [Off] (☞ P.76) (For DM-4).

IMAGE

Date

Date

Folder

File

First layer Second layer

Date

Date

• Each folder can store a total of 999 items, including files and folders.
• When the recorder displays image files, only thumbnails are displayed.

Folder display Date list display File list display File display 
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Basic operations

Recording

Settings relating to Recording

Various recording settings can be made to 
match the recording environment (☞ P.69 
to P.72).

[Rec Menu] Setting Items:

[Mic Sense]
(☞ P.69) 

Sets the sensitivity of the 
built-in stereo microphone.

[Rec Mode]
(☞ P.69)

Sets the recording rate for 
each recording format.

[Rec Level]
(☞ P.69) 

Sets the recording level.

[Zoom Mic]
(☞ P.70) 

Sets the directionally of the 
built-in stereo microphone.

[Low Cut Filter]
(☞ P.71) 

This function can reduce 
noise from air conditioners, 
projectors and other similar 
noises.

[VCVA]
(☞ P.71)

Sets the threshold level for 
the Variable Control Voice 
Actuator (VCVA).

[Rec Scene]
(☞ P.84)

Saves recording settings in 
advance for specific record-
ing situations.

[Timer Rec]
(☞ P.85) 

Sets timer recording.

[Folder Name]
(☞ P.72)

You can change folder names 
registered in the template.

• Each audio recording is saved automatically 
with a generated file name (☞ P.34).

• Audio recordings can be tagged with a 
keyword to make file management easier 
(☞ P.77).

Recording to a recording folder

Before starting recording, select a voice 
recording folder between [Folder A] to 
[Folder E] in the [Recorder] folder. These 
five folders can be selectively used to 
distinguish the kind of recording; for 
example, [Folder A] might be used to 
store private information, while [Folder B] 
might be dedicated to holding business 
information.

 1 Select the recording folder. 

 2 Press the REC button to start 
recording.

• The LED indicator light glows orange 
and [ ] will appear on the display.

• Turn the microphone in the direction 
of the source to be recorded.
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Recording

a

 3 Press the STOP button to stop 
recording.

Specifying a keyword before 
recording

A keyword that matches the contents to be 
recorded can be specified before recording 
starts. This function is very useful for classifying 
recordings by keywords.

 1 In the Folder list display, press 
F1(SEARCH) to show the Keyword 
search display (☞ P.55).

 2 Press the + or − button to specify 
the desired keyword, and then 
press the `OK or 9 button.

 3 Press the REC button to start 
recording.

 4 Press the STOP button to stop 
recording.

• Recorded files are automatically 
tagged with the specified keyword 
and managed using the keyword list.

• Recorded files are saved in [Folder A]. 
If [Folder A] is full, files are saved in 
[Folder B].

a File length
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• Stop recording and the file that was just 
recorded will be played back.

Pause

While the recorder is during recording 
mode, press the REC button.

• The recorder will time out after 120 
minutes when left in “Rec Pause”.

Resume Recording:

Press the REC button again.

• Recording will resume at the point of 
interruption.

To quickly check on the recorded contents

While the recorder is during 
recording mode, press the `OK 
button.

 Notes

• When a microSD card is inserted in the 
recorder, be sure to confirm the recording 
media as either [Built-in] or [microSD] so 
that there is no mistake (☞ P.78).

• If the REC button is pressed when a 
function other than the record function is 
specified, [Cannot record in this folder] 
is displayed. Select a folder from [Folder 
A] through [Folder E] and start recording 
again.

• To ensure recording from the beginning, 
start speaking after you see the LED indicator 
light on.

• When remaining recording time is less 
than 60 seconds, the LED indicator light 
starts flashing. When the recording time 
is decreasing to 30 or 10 seconds, the light 
flashes faster.

• When [Folder Full] appears, the recorder 
will not be able to record anymore. Delete 
any unnecessary files before recording any 
further (☞ P.62).

• Recorder will not be able to record 
anymore when [Memory Full] appears. 
Delete any unnecessary files before 
recording any further (☞ P.62).

• We recommend formatting the record 
media in the recorder before recording 
(☞ P.99).

Recording
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Listening while audio is recorded

If you start recording after inserting the 
earphone into the EAR jack on the recorder, 
you can hear the sound being recorded. The 
recording monitor volume can be adjusted by 
pressing the + or − button.
Connect the earphone to the EAR jack 
on the recorder.

• After recording has started, you can hear 
the sound being recorded through the 
earphone.

 Notes

• Recording level cannot be controlled using 
the volume button.

• When using the earphones, do not set the 
volume too high. Listening at very high 
volume may lead to hearing loss.

• Do not place earphones near a microphone 
as this may cause feedback.

Recording
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Recording

Recommended settings by recording condition

The recorder is initially set to the [ST XQ] mode so that you can make high quality stereo 
recordings immediately after purchasing it. The various functions relating to recording can 
be configured in detail to suit the recording conditions.
The following table shows the standard recording settings with the recording environment 
as an example.

Recording

condition

Recommended Settings

[Rec Mode]

(☞ P.69)

[Mic Sense]

(☞ P.69)

[Low Cut Filter]

(☞ P.71)

[Zoom Mic]

(☞ P.70)

Recording for 
conferences 
and other large 
groups.

[PCM]: [44.1kHz]
[WMA]:[ST XQ]

[MP3]: [320kbps]
[High]

[On]

[Wide]

Meetings and 
business negotia-
tions with a small 
number of people.

[WMA]:[ST XQ]
[WMA]:[ST HQ]

[MP3]: [256kbps]
[MP3]: [192kbps]

[Middle] [Wide]

Dictation with a 
lot of background 
noise.

[HQ] [Low] [Off]

Music playing, 
wild birds sing-
ing, and railway 
sounds.

[PCM]: [48kHz]
[PCM]: [44.1kHz]

Set the micro-
phone sensitivity 
according to the 

volume being 
recorded.

[Off] [Off]

Dictation in a 
quiet environ-
ment.

It can be used in any type of setting.
Select a setting for recording.
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Recording from external microphone 
or other devices

The external microphone and other devices 
can be connected and the sound can be 
recorded. Connect as follows by the device 
to be used.
Do not plug and unplug devices into the 
recorder’s jack while it is recording.

Recording with external 
microphone:
Connect an external microphone to 
the MIC jack of the recorder.

Applicable external microphones 

(optional) 

2 channel microphone 
(omni-directional): ME30W

 These are highly sensitive omni-
directional microphones supported by 
plug-in power which are well-suited to 
recording musical performances.

Highly sensitive noise-cancellation 
monaural microphone (unidirectional): 
ME52W

 This microphone is used to record 
sound at a distance while minimizing 
surrounding noise.

Compact Gun Microphone 
(unidirectional): ME31

 The directional microphones are useful 
for recordings such as outdoor recording 
of wild birds singing. The metal-cut 
body provides a sturdiness to the high 
rigidity.

Tie clip microphone (omni-directional): 
ME15

 Small concealing microphone with a 
tie-clip.

Telephone pickup: TP7

 Earphone type microphone can be 
plugged into your ear while phoning. 
The voice or conversation over the 
phone can be clearly recorded.

 Notes

• The built-in microphone will become 
inoperable when an external microphone 
is plugged into the recorder’s MIC jack.

• Microphones supported by plug-in power 
can also be used.

• When an external monaural microphone 
is used while [Rec Mode] is set to a stereo 
recording mode, it enables recording only 
with the L channel microphone (☞ P.69).

Recording
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 Note

• The detailed input levels cannot be 
adjusted with this recorder (☞ P.69). When 
external devices are connected, perform a 
test recording and then adjust the output 
level for the external devices.

Recording the sound of other 
devices with this recorder:
The sound can be recorded when 
connecting to the audio output terminal 
(earphone jack) of the other device, and the 
MIC jack of the recorder with the connecting 
cord KA333 (optional) for dubbing.

 Note

• When you adjust the various sound 
quality settings related to playback on 
the recorder, the audio output signal sent 
out from the EAR jack will change as well 
(☞ P.73).

Recording the sound of this 
recorder with other devices:
The sound of this recorder can be recorded 
to other devices when connected to the 
audio input terminal (microphone jack) 
of other devices and the EAR jack of this 
recorder, with the connecting cord KA333 
(optional) for dubbing.

Recording
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 2 Press the + or − button to adjust 
to a comfortable listening 
volume.

 1 To start playback, select the file 
to be played, and then press the 
`OK button (☞ P.55 to P.61).

 3 Press the STOP button at any 
point you want to stop the 
playback.

• The volume can be adjusted within a 
range from [00] to [30].

Settings relating to playback

A playback mode can be selected to match 
your objectives and preferences (☞ P.73 
to P.75).

[Play Menu] Setting Items:

[Noise Cancel]
(☞ P.73) 

If recorded audio is difficult 
to understand because of 
noisy surroundings, adjust 
the Noise Cancel setting 
level.

[EUPHONY]
(☞ P.73)

Level adjustments of
the [EUPHONY] setting can 
be set to four stages accord-
ing to preference.

[Voice Filter]
(☞ P.73) 

The recorder has a Voice 
Filter Function to cut low 
and high frequency tones 
during normal, fast, or slow 
playback, and enable clear 
audio playback.

[Repeat]
(☞ P.74) 

The repeat playback method 
can be specified as desired.

[Random]
(☞ P.74) 

Files are searched for, selected 
and played at random.

[Play Speed]
(☞ P.75)

Playback speed can be 
adjusted as necessary.

[Skip Space]
(☞ P.75)

The skip interval length can 
be set.

[Play Scene]
(☞ P.88) 

Playback settings of your 
choice can be saved to suit 
different sound qualities and 
playback methods.

• This will stop the file being played 
back midway. 

• When [Accessibility] is set to [On], 
the resume function will be active. 
The recorder will memorize the file 
it was playing back and the last stop 
position even if the power is turned 
off (☞ P.76) (For DM-4).

The recorder can playback WAV, MP3 and 
WMA format files. 

Playback
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Rewinding

While the recorder is during stop 
mode, press and hold the 0 
button.

• If you release the button, it will stop.
Press the `OK button to start playback 
from where it was stopped.

While the recorder is during 
playback mode, press and hold the 
0 button.

• When you release the button the recorder 
will resume normal playback.

• If there is an index mark in the middle 
of the file, the recorder will stop at that 
location (☞ P. 53).

• The recorder stops when it reaches the 
beginning of the file. Continue pressing 
the 0 button to proceed with the 
review from the end of the previous file.

Forwarding

While the recorder is during stop 
mode, press and hold the 9 
button.

• If you release the button, it will stop.
Press the `OK button to start playback 
from where it was stopped.

While the recorder is during 
playback mode, press and hold the 
9 button.

• When you release the button the recorder 
will resume normal playback.

• If there is an index mark in the middle 
of the file, the recorder will stop at that 
location (☞ P. 53).

• The recorder stops when it reaches the 
end of the file. Continue pressing the 9 
button to proceed with the cue from the 
beginning of the next file.

Locating the beginning of the file

While the recorder is during stop 
mode or playback mode, press the 
9 button.

• The recorder skips to the beginning of the 
next file.

While the recorder is during 
playback mode, press the 0 
button.

• The recorder skips to the beginning of the 
current file.

While the recorder is during stop 
mode, press the 0 button.

• The recorder skips to the beginning of the 
previous file. If the recorder stops midway 
of the file, return to the beginning of the 
file.

While the recorder is during 
playback mode, press the 0 
button twice.

• The recorder skips to the beginning of the 
previous file.

 Notes

• When you skip to the beginning of the file 
during playback, the recorder will stop at 
the position of the index mark. The index 
mark will be skipped when you perform 
the operation in stop mode (☞ P. 53).

• When [Skip Space] set to other than 
[File Skip], the recorder will skip forward/
reverse the specified time, then will start 
playback (☞ P. 75).

Playback
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Playback through earphone

An earphone can be connected to the EAR 
jack of the recorder for listening.
• When the earphone is used, the recorder 

speaker will be switched-off.

 Notes

• To avoid irritation to the ear, insert the 
earphone after turning down the volume 
level.

• When you listen with the earphone during 
playback, do not raise the volume too 
much. It may cause hearing impairment 
and decrease in hearing ability.

About music file

In cases where the recorder is unable 
to playback music files that have been 
transferred to it, check to make sure that the 
sampling rate and bit rate are in the range 
where playback is possible. Combinations of 
sampling rates and bit rates for music files 
which the recorder can playback are given 
below.

File 
format

Sampling
frequency

Number of bit 
and Bit rate

WAV 
format 44.1 kHz, 48 kHz 16 bit

MP3 
format

MPEG1 Layer3:
32 kHz, 44.1 kHz, 
48 kHz
MPEG2 Layer3:
16 kHz, 22.05 kHz, 
24 kHz

From 8 kbps up to 
320 kbps

WMA 
format

8 kHz, 11 kHz,
16 kHz, 22 kHz, 
32 kHz, 44.1 kHz, 
48 kHz

From 5 kbps up to 
320 kbps

• Variable bitrate MP3 files (in which 
conversion bitrates can vary) may not play 
properly.

• This recorder does not support the Digital 
Rights Management system (DRM) of the 
Microsoft Corporation.

Playback

Playback through Hi-fi components or Car Audio

The KA333 (optional) connects from the 
EAR jack of a voice recorder to the audio 
input of another recording device. You 
will also be able to use in your car via the 
AUX-IN connection. Additional plug adapter 
to convert 3.5 to 2.5 and vice versa are 
included.
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 1 Selecting the content file in the 
[Podcast], [Audiobooks](DAISY, 
Audible, Audio Book, Text 
Speech) folder.

 2 Press the `OK button to start 
playback.

Playback Position mode

The recorder has a playback position mode 
to automatically memorize the latest position 
where you previously stopped playback for files 
transferred to the [Podcast] and [Audiobooks] 
(DAISY, Audible, Audio Book, Text Speech) 
folders. Even if the recorder is stopped while a 
file is being played back, the last stop position is 
recalled from the file, and the file can be played 
back from that position next time.

Playback

• When you play the file which you have 
previously played back, the playback 
starts from the last stop position.

 3 Press the STOP button at any 
point you want to stop the 
playback.

 4 Playing back the contents file 
which has been played back 
halfway.

• Stop a file playback at any point. 
The stop position is memorized as a 
Playback Position in the file. In this 
status, even if you select an empty 

• Press the `OK button to start playing 
back from where it was stopped.

 Note

• For DAISY files, an audio sentence stopped 
in the middle will restart playing from the 
beginning of the file.

Forwarding

While the recorder is during stop 
mode, press and hold the 9 button.

➥ When you release the button, the 
recorder stops.

 The Playback position is updated. If the 
`OK button is pressed, playback starts 
from this position.

While the recorder is during playback 
mode, press and hold the 9 button.

➥ When you release the button the 
recorder will resume normal playback.

• If an index mark (☞ P.53) or Playback 
Position is marked in the middle of the file, 
the playback stops once at that position.

• The recorder stops when it reaches the 
end of the file. Continue pressing the 9 
button to proceed with the cue from the 
beginning of the next file.

Forwarding operation does not work for the 
DAISY files and text files.

file, move to the other folder, or turn 
the recorder off, the playback starts 
from the last memorized position 
when you play the same file.
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Rewinding

While the recorder is during stop 
mode, press and hold the 0 button.

➥ When you release the button, the 
recorder stops.

 The Playback position is updated. If the 
`OK button is pressed, playback starts 
from this position.

While the recorder is during playback 
mode, press and hold the 0 button.

➥ When you release the button the 
recorder will resume normal playback.

• If an index mark (☞ P.53) or Playback 
Position is marked in the middle of the file, 
the playback stops once at that position.

• The recorder stops when it reaches the 
beginning of the file. Continue pressing 
the 0 button to proceed with the review 
from the end of the previous file.

• If the 0 button is kept pressed while the 
recorder is stopped at the start of the top 
file, the recorder will fast rewind starting 
from the end of the last file.

Rewinding operation does not work for the 
DAISY files and text files.

To skip a file

While the recorder is during stop 
mode, press the 9 button.

➥ It skips to the Playback Position of the 
next file.

While the recorder is during stop 
mode, at the beginning of the file, 
press the 0 button.

➥ It skips to the Playback Position of the 
previous file.

While the recorder is during stop 
mode, in the middle of the file, press 
the 0 button.

➥ It skips to the head of the file.

For DAISY files, the recorder skips the unit 
specified by the [Skip Mode] of the [Book 
Menu] (Daisy Menu) (☞ P.81).

Text files skips by the phase unit.

Locating the Beginning of the File

While the recorder is during 
playback, slow playback, or fast 
playback, press the 9 button.

➥ The next file is cued and playback 
starts at the previously set speed.

While the recorder is during 
playback, slow playback, or fast 
playback, press the 0 button.

➥ The f ile being played is cued and 
playback starts at the previously set 
speed.

While the recorder is during 
playback, slow playback or fast 
playback, press the 0 button 
twice.

➥ The previous file is cued and playback 
starts at the previously set speed.

• If an index mark (☞ P.53) is marked in the 
middle of the file, it reproduces from the 
position.

• If the skip space is set at other than file skip 
(☞ P.75), the recorder will F. Skip (forward 
skip) or R. Skip (reverse skip) for a set time 
before playback.

For DAISY files, the recorder skips the unit 
specified by the [Skip Mode] of the [Book 
Menu] (Daisy Menu) (☞ P.81).

You cannot skip to the beginning of the file 
for text files.

 Note

• If the file is deleted with this recorder, the 
Playback Position information is deleted 
simultaneously.
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• Index numbers after the erased index 

number will automatically move up.

 Notes

• Up to 16 index marks can be set in a file. If 
you try to place more than 16 index marks, 
the [Index Full] message will appear for 
index marks.

• Index marks cannot be set or erased in a 
locked file (☞ P.77).
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 1 Press the Fn (INDEX) button during 
file recording, recording pause, 
playing, or playback pause.

Setting an index mark

If index marks are placed, you can quickly 
find a location you want to listen to in fast 
forward and fast rewind and when cuing 
a file.

Playback

• A number and recording position 
appears on the display and an index 
mark will be placed.

• Even after an index mark is placed, 
recording or playback will continue 
so you can place index marks in other 
locations in a similar manner.

Clearing an index mark

 1 Locate the index mark you want 
to clear.

 2 Press the 9 or 0 button to 
select the index mark to erase.

 3 While the index number is 
displayed (approximately 2 
seconds), press the Fn (ERASE) 
button.

This operation can be performed 
when the [INDEX] function has 
been assigned to a Fn button (F1 
or F2) (☞ P.78).

This operation can be performed 
when the [Erase] function has been 
assigned to a Fn button (F1 or F2) 
(☞ P.78).
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Playback

 1 To start playback, select a file that 
has a segment you would like to 
playback repeatedly, and then 
press the `OK button (☞ P.55 to 
P.61).

 2 Press the Fn (A-B) button at the 
point you want to start segment 
repeat playback.

• Fast forwarding and rewinding can 
be conducted when [ ] is flashing 
in the same manner as during normal 
playback, and you can quickly 
proceed as far as the end position 
(☞ P.49).

• When it reaches to the end of the file 
while [ ] is flashing, the point will 
become the end position, and repeat 
playback will start.

How to begin segment repeat 
playback

This function enables repeated playback of 
part of the file being played.

 3 Press the Fn (A-B) button again at 
the position where you want to 
end segment repeat playback.

• The recorder repeatedly plays back 
the segment until the segment repeat 
playback is canceled.

Cancel the segment repeat playback function

Pressing any of the following 
buttons will release the segment 
repeat playback.

a Press the STOP or `OK button
Pressing the STOP or `OK button will 
release segment repeat playback and 
stop playback.

b Press the Fn (CANCEL) button
Pressing the Fn (CANCEL) button will 
release segment repeat playback and 
stop playback.

This operation can be performed 
when the [A-B] function has been 
assigned to a Fn button (F1 or F2) 
(☞ P.78).
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File search

This recorder manages recorded files and 
music files imported from a personal computer 
using a database. Files are automatically 
sorted using items such as date and keyword, 
which makes searching for files easier.

Opening the file search display from 
the [Recorder] folder

File search type:

[Browse] Search
(☞ P.56) 

The folder system (Folder A 
to Folder E) is used to search 
for files.

[Day] Search
(☞ P.56)

Files are searched for by 
recording date.

[Keyword] 
Search
(☞ P.57) 

Files are searched for by a 
keyword.

 1 From the [Home] menu display, 
select [Recorder], and then press 
the `OK or 9 button to open 
the folder list display.

When [Accessibility] (☞ P.76) is set to 
[On] (For DM-4):
1 From the [Home] menu display, select 

[Recorder], and then press the `OK 
or 9 button.

2 Press the F3 (Menu) button to display 
the menu.

3 Press the + or – button to select [List], 
and then press the `OK button.

4 Press the 0 button.
•   Go back one step up in the 

hierarchy.

 2 Press the F1 (SEARCH) button to 
open the file search display.

• The search display changes every time 
the F1 (SEARCH) button is pressed.

Select the type of file search. Next, 
proceed to “File search display 
operations of the [Recorder] folder”.

File se
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2 Press the + or – button to select file, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

When searching using the [Day] search

Search for a file using the recording date. The 
most recent recording date is highlighted. 
Highlight the desired recording date.

1 Press the + or – button to select the 
recording date, and then press the `OK 
or 9 button.

2 Press the + or – button to select file, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

When searching using the [Browse] search

Specify a folder to search for files recorded 
by this recorder.

1 Press the + or – button to select folder, 
and then press the `OK or 9 button.

EN

File search

File search display operations of the 
[Recorder] folder
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When searching using the [Keyword] search

Search for files recorded by this recorder using 
a keyword. Files recorded by this recorder 
can be tagged using a keyword for f ile 
management purposes (☞ P.77).

1 Press the + or – button to select keyword, 
and then press the `OK or 9 button.

2 Press the + or – button to select file, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

EN
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Opening the file search display from 
the [Music] folder

File search type:

[Artist] Search
(☞ P.59) 

Files are searched for from a 
list of artists.

[Album] Search
(☞ P.59)

Files are searched for from a 
list of album names.

[All Music] 
Search (☞ P.60)

Files are searched for from a 
list of all songs.

[Browse] Search
(☞ P.60)

A list of all songs and albums 
in the [Music] folder is dis-
played.

[Heard Recently] 
Search (☞ P.60)

Files played on this recorder 
are displayed reverse chrono-
logical order.

[Play Count] 
Search (☞ P.60)

Files are displayed in order of 
the number of times they have 
been played on this recorder.

[Playlists] 
Search (☞ P.61) 

Displays playlists transferred 
to the recorder.

 1 From the [Home] menu display, 
select [Music] folder, and then 
press the `OK or 9 button to 
open the search display.

When [Accessibility] (☞ P.76) is set to 
[On] (For DM-4):
1 From the [Home] menu display, select 

[Music], and then press the `OK or 
9 button.

2 Press the F3 (Menu) button to display 
the menu.

3 Press the + or – button to select [List], 
and then press the `OK button.

4 Press the 0 button until the search 
display will be displayed.

 2 Press the + or − button to select 
the file search type, and then press 
the `OK or 9 button.

• If you make a mistake during the search, 
use the0 button to return to the 
previous display.

Select the type of file search. Next, 
proceed to “File search display 
operations of the [Music] folder”.

File search
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When searching using the [Artist] search

Search for a specific artist.

1 Press the + or – button to select artist, and 
then press the `OK or 9 button.

2 Press the + or – button to select album 
or song, and then press the `OK or 9 
button.

• If a song is selected, playback starts.
• If an album is selected, its songs are 

displayed as a list.

3 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

File search display operations of the 
[Music] folder

When searching using the [Album] search

Search by specific album.

1 Press the + or – button to select album, 
and then press the `OK or 9 button.

2 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

EN
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When searching using the [Heard Recently] 

search

A list of recently played files is displayed in 
reverse chronological order.

1 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

When searching using the [Play Count] search

A list of frequently played files is displayed in 
reverse chronological order.

1 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

When searching using the [Browse] search

Browse directly from a list of all files and 
folders in the [Music] folder.

1 Press the + or – button to select a song to 
be played or to select an artist, and then 
press the `OK or 9 button.

• If an artist is selected, songs in the 
folder are displayed as a list. Press the 
+ or – button to select a song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

Selecting from a list of [All Music]

Files are searched for from a list of [All 
Music].

1 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

EN

File search
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2 Press the + or – button to select a 
playlists, and then press the `OK or 9 
button.

3 Press the + or – button to select song, and 
then press the `OK or 9 button.

• Press the `OK button to start 
playback of the file.

When searching using the [Playlists] search

Select a playlist.
For details on importing playlists, please see 
☞ P.158.

1 Press the + or – button to select [Playlists], 
and then press the `OK or 9 button.

EN
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Erasing

A selected file can be erased from a folder. It 
is also possible to erase a selected folder or 
all files in a folder.

Erasing from the file display

 1 In the File list display, press the 
F3 (MENU) button.

• Files cannot be erased during playback.
 4 Press the + button to select 

[Start], and then press the `OK 
button.

 3 Press the + button to select [File 
Erase], and then press the `OK or 
9 button.

 2 Press the + or − button to select 
[r Erase], and then press the `OK 
or 9 button. • The display changes to [Erase!] and 

erasing will start. [Erase Done] is 
displayed when the file is erased.

Era
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Erasing from the file list display

 1 Select the file to erased from the 
file list display.

 3 Press the + or − button to select 
[File Erase], and then press the 
`OK or 9 button.

 2 While the recorder is during 
stop mode, press the F2 (ERASE) 
button.

 4 Press the + button to select 
[Start], and then press the `OK 
button.

• The display changes to [Erase!] and 
erasing will start. [Erase Done] is 
displayed when the file is erased.

Erasing
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Erasing all files in a folder

 1 Select the folder to be erased 
from the folder list display, 
and then press the `OK or 9 
button (☞ P.55 to P.61).

Erasing

 2 While the recorder is during 
stop mode, press the F2 (ERASE) 
button.

 3 Press the + or − button to select 
[Erase in Folder], and then press 
the `OK or 9 button.

 4 Press the + button to select 
[Start], and then press the `OK 
button.

• The display changes to [Erase!] and 
erasing will start. [Erase Done] is 
displayed when the file is erased.
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Erasing a folder

 1 Select the folder to be erased 
from the folder list display 
(☞ P.55 to P.61).

 2 In the folder list display, press 
the F3 (ERASE) button.

 3 Press the + or − button to select 
[r Erase], and then press the `OK 
or 9 button.

 4 Press the + button to select 
[Start], and then press the `OK 
button.

• The display changes to [Erase!] and 
erasing will start. [Erase Done] is 
displayed when the file is erased.
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 1 Play the file you want to partial 
erase.

• Forward a file to the position that 
shall be erased. If the file is long, 
use the 9 button to move to the 
position you want to delete.

 2 In the starting position of the 
partial erase, press the Fn (ERASE) 
button.

Partially erase a file

Only a PCM file recorded in the recorder can 
be partially erased.

 3 In the position you want to end 
partial erase, press the Fn (ERASE) 
button again.

• [Start point] and [End point] on the 
display flash alternatively. When the 
lights are flashing, playback continues 
and you can rewind or fast-forward as 
usual and fast-forward to the end of 
erase. If the file reaches the end during 
the flashing of the lights, that will be 
the position where erase ends.

 4 Press the Fn (ERASE) button 
again.

• The display will switch to [Partial 
erasing !] and start the partial 
erase. The deletion is completed 
when [Partial erase completed.] is 
displayed.

• Playback will stop at the end location 
of the partial erase.

 Notes

• Partial erase is not applicable to files 
recorded in the WMA or MP3 formats.

• The file created date will not change even 
if the file is partially erased.

• An erased file cannot be restored. When a 
microSD Card is inserted in the recorder, 
be sure to confirm the recording media as 
either [Built-in] or [microSD] so that there 
is no mistake.

• The locked files and files set as read-only 
cannot be erased (☞ P.77).

• If an action is not selected within 8 
seconds, the recorder will return to stop 
status.

• Never perform operations such as the 
following while processing, as they may 
damage the data. In addition, carefully 
check the remaining battery level in order 
to ensure that the battery will not run out 
while processing.

 1 Unplugging the AC adapter while  
 processing.

 2 Removing the battery while processing.
 3 Remove the microSD card during  

 processing when [microSD] is   
 being used as the recording media.

• [Recorder] folder (A-E) as well as [Music], 
[Podcast], [Audiobooks](DAISY, Audio 
Book, Text Speech, Audible) folders cannot 
be deleted.

Erasing

This operation can be performed 
when the [Erase] function has 
been assigned to a Fn button (F1 
or F2) (☞ P.78).
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Making settings from [Preferences] on 
the [Home] menu display

From menu on the [Home] menu display, 
following settings can be made: [Rec Menu], 
[Play Menu], [LCD/Sound Menu] and [System 
Menu] You can perform various settings on 
this recorder before recording or playback.

Menu setting

 1 From the [Home] menu display, 
select [Preferences], and then 
press the `OK or 9 button to 
open the menu item display.

 2 Press the + or − button to select 
a menu item, and then press the 
`OK or 9 button.

 3 Press the + or − button to select 
the setting item, and then press 
the `OK or 9 button.

• Moves to the setting of the selected 
item.

• If you make a mistake while performing 
a setting, press the0 or F1 (BACK) 
but ton to return to the previous 
display.

You can set the various functions of this 
recorder. You can set each menu item as 
follows.

• You will be informed that the settings 
have been established via the display.

 4 Press the + or − button to change 
the setting, and then press the ̀ OK 
button to complete the setting.

 5 Press the F3 (HOME) button to 
close the menu display.
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Performing menu settings during 
recording, playback, and stop modes

Menu settings can be performed while this 
recorder is being operated. In addition to [Rec 
Menu] and [Play Menu] settings, [File Menu] 
settings for file management can also be 
performed from the menu during operation.

 1 While the recorder is recording, 
playing back, paused, and stopped, 
press the F3 (MENU) button.

 2 Press the + or − button to select 
a menu item, and then press the 
`OK or 9 button.

 3 Press the + or − button to select 
the setting item, and then press 
the `OK or 9 button.

• Moves to the setting of the selected 
item.

• If you make a mistake while 
performing a setting, press the0 
or F1 (BACK) button to return to the 
previous display.

 5 Press the F3 (CLOSE) button to 
close the menu display.

• When the display is in the menu 
display during recording or playback, 
pressing the F3 (CLOSE) button will 
allow you to return to the playback 
display without interrupting 
recording or playback.

 4 Press the + or − button to change 
the setting, and then press `OK 
button to complete the setting.
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Menu setting method

Rec Mode

The recorder can record in the linear PCM 
format. High resolution recording at a high 
sampling rate and high bit rate equivalent 
or superior to that of a music CD is possible. 
Moreover, it also supports the MP3 and 
WMA formats.

 1 Select [Rec Mode] from the menu 
on the [Rec Menu].

 2 Select [PCM], [MP3] or [WMA].

[PCM]:
  This is an uncompressed audio format  

 which is used for music CDs and the like.

[MP3]:
  MPEG is the international standard  

 established by a working group of  
 the ISO (International Organization for  
 Standardization).
[WMA]:

  This is an audio compression
 encoding method that was 
 developed by the Microsoft   
 Corporation in the US.

 3 Set the recording rate.

When [PCM] is selected:
 [48kHz/16bit] or [44.1kHz/16bit]
When [MP3] is selected:
 [320kbps] to [128kbps]
When [WMA] is selected:
 [ST XQ], [ST HQ], [ST SP], [HQ], [SP], [LP]

• To record a meeting and lecture clearly, set 
other than [LP] in Rec Rate.

•  When the external monaural microphone 
is used while [Rec Mode] is set to a stereo 
recording mode, it enables recording only 
with the L channel microphone.

G Rec Menu

Mic Sense

Microphone sensitivity is adjustable to meet 
recording needs.

 1 Select [Mic Sense] from the menu 
on the [Rec Menu].

 2 Select [High], [Middle] or [Low].

[High]:
  Highest recording sensitivity suitable  

 for conferences with large crowds  
 and recording audio at a distance or  
 low volume.
[Middle]:

  Suitable for recording meetings and  
 seminars with a small number of  
 people.
[Low]:

  Lowest recording sensitivity suitable  
 for dictation.

• When you would like to clearly record 
a speaker’s voice, set [Mic Sense] to 
[Low] and hold recorder’s built-in stereo 
microphone close to the speaker’s mouth 
(5-10 cm) before recording.

Set the method for adjusting the recording level 

[Rec Level]

You can set the device to automatically or 
manually adjust the recording level.

 1 Select [Rec Level] from the menu 
on the [Rec Menu].

 2 Select [Manual] or [Auto].

[Manual]:
  Recording is performed by manually  

 adjusting the recording level.
[Auto]:

  Recording is performed by   
 automatically adjusting the recording  
 level. This is useful for when you will  
 be recording right away.
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Adjust the recording level:

 1 Press the 9 or 0 button 
while the recorder is recording or 
paused to adjust the recording 
level.

• The recording level will be automatically 
adjusted when the recording level is set 
to [Auto]. Set the recording level to 
[Manual] to use the recording level 
adjustment feature.

• When the unit is set to [Manual] , 
the limiter function will be disabled.
Distorted sound will be recorded 
during [OVER] is displayed. Adjust the 
recording level so that [OVER] is not 
displayed. If sound distortions do not 
disappear even after the recording 
level has been adjusted, change the 
setting for microphone sensitivity 
(☞ P.69) and adjust the recording level 
again .

• [OVER] may be displayed even when 
the indicator of the recording level 
meter does not reach or is over to the 
right.

• Inputting a ver y loud sound may 
produce noise even when the recording 
level is set to [Auto].

• The level can be adjusted from [01] to 
[16]. The higher the number, the higher 
the level and the larger the indicator 
position on the level meter.

Zoom Mic

The directional microphone function utilizes 
DiMAGIC’s (DiMAGIC Co., Ltd.) DiMAGIC 
Virtual Microphone (DVM) technology. DVM 
is an audio pickup system which allows you 
to record by focusing on sound from any 
direction. From expansive stereo recording 
to high directivity recording, DVM represents 
the latest in directional control methods 
that allow you to switch to a single exclusive 
microphone.

 1 Select [Zoom Mic] from the menu 
on the [Rec Menu].

 2 Select [Zoom], [Narrow], [Wide] or 
[Off].

[Zoom]:
  Recording with monaural, however  

 you can record high directivity sound.
[Narrow]:

  Recording by a directivity stereo  
 sound.
[Wide]:

  Recording by an expansive stereo  
 sound.
[Off]:

  Disables this function.

About the Zoom Mic function:

Directivity 
(high)

Directivity 
(low)

Sound 
collection 
(narrow)

Sound 
collection 
(wide)
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Low Cut Filter

The recorder has a Low Cut Filter function to 
minimize low-frequency sounds and record 
voices more clearly. This function can reduce 
noise from air conditioners, projectors and 
other similar noises.

 1 Select [Low Cut Filter] from the 
menu on the [Rec Menu].

 2 Select [On] or [Off].

[On]:
 Enables the Low Cut Filter function.
[Off]:
 Disables this function.

VCVA

When the microphone senses that sounds have 
reached a preset threshold volume level, the 
built-in Variable Control Voice Actuator (VCVA) 
starts recording automatically, and stops 
when the volume drops below the threshold 
level. The VCVA feature extends recording 
time and conserves memory by stopping 
recording during silent periods, which helps 
the playback to be more efficient.

 1 Select [VCVA] from the menu on 
the [Rec Menu].

 2 Select [On] or [Off].

[On]:
 Enables the VCVA function. Will start  
 recording in VCVA mode.
[Off]:
 Disables this function. Will resume  
 recording in normal mode.

Adjust the start/stop actuation 
level:

• If the surrounding noise is loud, the 
starting sensitivity of the VCVA can be 
adjusted according to the recording 
situation.

 1 Press the REC button to start 
recording.

• When the sound volume is lower than 
the preset threshold sound level, 
recording automatically stops after 
1 sec approximately, and [Standby] 
flashes on the display. The LED 
indicator light glows orange when 
recording starts and flashes when 
recording pauses.

 2 Press the 9 or 0 button to 
adjust the start/stop actuation 
level.

a Level meter (varies according to the 
sound volume being recorded)

b Start level (moves to the right/left 
according to the set level)

• The VCVA level can be set to any of 23 
different values ([-1]~[-42]).

• The higher the value, the more 
sensitive the recorder to sounds. At 
the highest value, even the faintest 
sound will activate recording.

• Press the F1 button to change the 
recording level (☞ P.69) during VCVA 
recording. The recording level can be 
adjusted. 

Menu setting method

a

b
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• The start/stop actuation level also varies 
depending on the selected microphone 
sensitivity mode (☞ P.69).

• If the starting level is not adjusted within 
2 seconds, the display will return to the 
previous.

• To ensure successful recordings, prior 
testing and adjustment of the start/stop 
actuation level is recommended.

VCVA standby monitor setting:
When [Standby] is set to [On] with the menu 
setting, the recording will not be output 
from the earphone while in VCVA standby. 
When you monitor your recording with the 
earphone connected, you can check whether 
VCVA is launched or not by checking if an 
audio is output.
[On]:
 Enables the Standby Monitor function.
[Off]:
 Disables this function.

Car Train Plane

Work Interview Business trip

Conference Lecture Class

Memo Record Telephone 
recording

Conversation Hobby Lesson

Language 
lesson Music Event

Folder A Folder B Folder C

Folder D Folder E

Rec Scene

Refer to “Setting the recording scene [Rec 
Scene]” (☞ P.84).

Timer Rec 

Refer to “Timer recording [Timer Rec]” 
(☞ P.85).

Folder Name

You can change the folder names of [Folder A] 
to [Folder E] for recording into names preset 
in the template.

 1 Select [Folder Name] from the 
menu on the [Rec Menu].

 2 Press the + or − button to select 
the folder name you want to 
change, and then press the `OK 
or 9 button.

 3 Press the + or − button to select the 
folder name you want to change 
from the template, and then press 
the `OK button.

Template list:
 Sets a folder name from the preset 

template.

The voice control function can be 
used with this setting 
(☞ P.118) (For DM-4).

Menu setting method
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Menu setting method

G Play Menu

Noise Cancel

If recorded audio is difficult to understand 
because of noisy surroundings, adjust the 
Noise Cancel setting level.

 1 Select [Noise Cancel] from the 
menu on the [Play Menu].

 2 Select [High], [Low] or [Off].

[High] [Low]:
  Enables the Noise Cancel function.  

 Noise will be reduced in the file when  
 it’s played back for better sound  
 quality.

[Off]:
  Disables this function.

EUPHONY

This recorder is equipped with “EUPHONY 
MOBILE”, the latest in surround sound systems 
which combines bandwidth correction, 
expansion technology, and virtual acoustical 
source processing technology. In addition 
to its natural, expansive feel, the recorder 
is equipped with the exceptional feature 
wherein listeners are less prone to developing 
a compressed or closed-in feel, or to growing 
tired over extended listening.
Level adjustments of the [EUPHONY ] 
setting can be set to four stages according 
to preference.

 1 Select [EUPHONY] from the menu 
on the [Play Menu].

 2 Select [Power], [Wide], [Natural] or 
[Off].

[Power]:
  This mode focuses more on lower  

 sound registers.

[Wide]:
  This mode has an even more   

 expansive feel.
[Natural]:

  This mode achieves natural   
 bandwidth correction and acoustical  
 field expansion.

[Off]:
  Disables this function.

Voice Filter

The recorder has a Voice Filter Function to cut 
low and high frequency tones during normal, 
fast, or slow playback, and enable clear audio 
playback.

 1 Select [Voice Filter] from the 
menu on the [Play Menu].

 2 Select [On] or [Off].

[On]:
  Enables the Voice Filter function.

[Off]:
  Disables this function.
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Repeat

The repeat playback settings can be set as 
desired.

 1 Select [Repeat] from the menu on 
the [Play Menu].

 2 Select [1 File], [List] or [Off].

[1 File]:
  A single file is played repeatedly.

[List]:
  The displayed file list is played  

 repeatedly.
[Off]:

  Disables this function.

Performing settings with Fn 
buttons:

 1 Press the Fn (RPT) button.

• Every time the Fn (RPT) button 
is pressed, the display switches 
between [d] and [e].

Random

The displayed file list is played repeatedly.

 1 Select [Random] from the menu 
on the [Play Menu].

 2 Select [On] or [Off].

[On]:
  Enables the Random Playback  

 function.
[Off]:

  Disables this function.

Performing settings with Fn 
buttons:

This operation can be performed 
when the [Repeat] function has 
been assigned to a Fn button (F1 
or F2) (☞ P.78).

This operation can be performed 
when the [Random] function has 
been assigned to a Fn button (F1 
or F2) (☞ P.78).

 1 Press the Fn (RDM) button.

• If the Fn (RDM) button is pressed, [f] 
is displayed and a random playback is 
enabled.
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Play Speed

The playback speed of the file can be changed 
between [50%] and [600%] times speed. 
Change the speed according to need such as 
listening to meeting content at a fast speed 
or reviewing spots that you couldn't catch in 
a language lesson at a slow speed.

 1 Select [Play Speed] from the 
menu on the [Play Menu].

 2 Set the playback speed.

[50%] to [600%]

This operation can be performed 
when the [Play Speed] function has 
been assigned to a Fn button (F1 or 
F2) (☞ P.78).

Performing settings with Fn 
buttons:

 1 Press the Fn (SPD) button.

 2 Press the + or − button to specify 
a speed setting, and then press 
the `OK button.

• Even if playback is stopped, the changed 
playback speed will be retained. The 
next playback will be at that speed.

Restrictions on double speed playback:

Normal operation may not be available 
depending on the sampling frequency and the 
bit rate of the file to be played back. In such a 
case, reduce the speed of the fast playback.
• If [Play Speed] has been assigned in the 

[Fn. setting] settings (☞ P.78), use the 
assigned button to enter the [Play Speed] 
setting display.

• The [Speed] setting in the [Voice Guide] 
settings (☞ P.90) is disabled during file 
playback.

Skip Space

This function enables you to skip (forward) or 
reverse skip (rewind) a file being played for 
a set period. This function is convenient for 
quickly skipping to another playback position 
or repeatedly playing back short phrases.

 1 Select [Skip Space] from the menu 
on the [Play Menu].

 2 Select [Forward Skip] or 
[Reverse Skip].

 3 Set the skip space.

When [Forward Skip] is selected:
• Playback starts after skipping forward 

the specified interval.
 [File Skip] [10sec. Skip] [30sec. Skip]

[1min. Skip] [5min. Skip] 
[10min. Skip]

When [Reverse Skip] is selected:
• Playback starts after skipping back 

the specified interval.
 [File Skip] [1sec. Skip] to [5sec. Skip]

[10sec. Skip] [30sec. Skip]
[1min. Skip] [5min. Skip]
[10min. Skip]

Forward/Reverse Skip Playback:

 1 Press the `OK button to start 
playback.

 2 Press the 9 or 0 button.

• The recorder will skip (forward) or 
reverse skip (rewind) a set space and 
start playing back.

• If there is an index mark or a cue 
closer than the skip space, the 
recorder will forward skip/reverse 
skip to that position.

Play Scene

Refer to “Setting the playback scene [Play 
Scene ]” (☞ P.88).
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G LCD/Sound Menu

Backlight

The display will remain lit for about 10 (Initial 
setting) seconds when a button on the 
recorder is pressed.

 1 Select [Backlight] from the menu 
on the [LCD/Sound Menu].

 2 Select [Lighting Time], 
[Dim light Time] or [Brightness].

When [Lighting Time] is selected:
 [5 seconds] [10 seconds] 

[30 seconds] [1minute] [Always On]
When [Dim light Time] is selected:
 [30 seconds] [1minute] [2minutes] 

[5minutes] [Always On]
When [Brightness] is selected:
 Adjust the setting between [01] and 

[03].

 3 Press the + or − button to change 
the setting, and then press `OK 
button to confirm the setting.

LED

You can set it so the LED indicator light does 
not turn on.

 1 Select [LED] from the menu on the 
[LCD/Sound Menu].

 2 Select [On] or [Off].

[On]:
  LED light will be set.

[Off]:
  Disables this function.

Beep

The recorder beeps to alert you to button 
operations or warn you of errors. System 
sounds may be turned off.

 1 Select [Beep] from the menu on 
the [LCD/Sound Menu].

 2 Select the beep level.

• Adjust the setting between [05] and [00].

Language (Lang)

You can select the display language for this 
recorder.

 1 Select [Language] from the menu 
on the [LCD/Sound Menu].

 2 Set the Language.

[English] [Français] [Español]:
• The selectable language differs 

depending on the region.

Voice Guide

Refer to “Guidance [Voice Guide]” (☞ P.89).

Alarm

Refer to “Alarm playback function [Alarm]” 
(☞ P.91).
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Accessibility (For DM-4)

This function can switch the structure of 
the [Home] menu items according to your 
purpose. This is useful when using frequently 
the [DAISY] and [Text Speech] functions.
When [Accessibility] is set to [On], file selection 
operation will be easier. If you choose one of the 
playback functions (Recorder, Music, DAISY, 
Text Speech) in the [Home] menu, the last file 
played will be displayed automatically. Playback 
will start when you press the `OK button.



77

3

EN

M
e

n
u

 se
ttin

g
 m

e
th

o
d

Menu setting method

G File Menu

Keyword

Voice files recorded by this recorder can be 
tagged with a keyword for file management. 
File lists can be created by keyword file 
searches (☞ P.57).

 1 Select the file you want to tag 
with a keyword (☞ P.55 to P.61).

 2 Select [Keyword] from the menu 
on the [File Menu].

 3 Press the + or − button to select 
the desired keyword, and then 
press the `OK button.

Car Train Plane

Work Interview Business trip

Conference Lecture Class

Memo Record Telephone 
recording

Conversation Hobby Lesson

Language 
lesson Music Event

Erase Lock

Locking a file keeps important data from 
being accidentally erased. Locked files are 
not erased when you select to erase all files 
from a folder (☞ P.64).

 1 Select the file you want to file 
lock (☞ P.55 to P.61).

 2 Select [Erase Lock] from the menu 
on the [File Menu].

 3 Select [On] or [Off].

[On]:
  Locks the file and prevents it from  

 being erased.
[Off]:

  Unlocks the file and allows it to be  
 erased.

File Move/Copy

Refer to “Moving/Copying files [File Move/
Copy]” (☞ P.95).

File Divide

Refer to “Dividing files [File Divide]” 
(☞ P.97).

[Off]: 
Recorder/Music/Podcast/Audiobooks/
Picture/Audio Diary/Preferences

[On]: 
Recorder/Music/DAISY/Text Speech/
Audio Diary/Preferences

• When [Accessibility] is set to [On], the 
[Podcast] and [Pictures] functions can 
not be used. To use these functions, set 
[Accessibility] to [Off].

• When [Accessibility] is set to [On], the 
resume function will be active. The 
recorder will memorize the file it was 
playing back and the last stop position 
even if the power is turned off.

Keyword list:
 Sets a keyword from the preset template.
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Property

File and folder information can be 
confirmed from the menu display.

 1 Select the file or folder with 
information you want to view in 
advance (☞ P.55 to P.61).

 2 Select [Property] from the menu 
on the [File Menu].

 3 Set the property.

When the file is selected:

[Name] (File name), [Date] (Time stamp), 
[Size] (File size), [Bit Rate]*1 (File format) 
[Artist]*2 (Artist name) and [Album]*2 
(Album name) will appear on the display.
*1 When a linear PCM format file has 

been selected, [Bit Rate] area 
displays the sampling frequency and 
bit rate.

*2 When a file contains no tag 
information, [UNKNOWN_ARTIST], 
[UNKNOWN_ALBUM] will appear on 
the display.

When the folder is selected:

[Name] (File name), [Folder] (Number of 
folder) and [File]* (Number of file) will 
appear on the display.
*  Files which cannot be recognized by this 

recorder are not included in the number 
of files.

• Select the files for which you would like 
to confirm information in advance before 
operating the menu.

Menu setting method

G System Menu

Fn. setting

The Fn buttons (F1 and F2) of this recorder 
can be assigned to suit your desired method 
of use. Assigned buttons can be operated 
during recording and playback.

 1 Select [Fn. setting] from the 
menu on the [System Menu].

 2 Select the [F1] or [F2].

• You can assign settings to suit the way you 
use the recorder.

Fn button list:
 Sets a Function Key from the preset 

template.

 3 Press the + or − button to select 
the item you want to assign, and 
then press the `OK button.

• Repeat Steps 2 and 3 to continue registering 
the function keys.

Off Repeat

Random Play Speed

INDEX A-B

Erase DISPLAY

LIST

Memory Select

When a microSD card is inserted you 
can select to record to either the built-in 
memory or to the microSD card (☞ P.32).

 1 Select [Memory Select] from the 
menu on the [System Menu].

 2 Select the [Built-in] or [microSD].
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Menu setting method

Auto Power Off

If the recorder remains in stop mode for over 
10 minutes (Initial setting), the power will be 
turned off.

 1 Select [Auto Power Off] from the 
menu on the [System Menu].

Time & Date

Refer to “Setting time and date [Time & 
Date]” (☞ P.30).

USB Settings

Refer to “Changing the USB Class [USB 
Settings]” (☞ P.98).

System Standby

The system standby mode allows you to 
switch off the display without turning off the 
power, while the recorder is not operated.

 1 Select [System Standby] from the 
menu on the [System Menu].

 2 Select the [On] or [Off].

[On]:
  System standby will be set.

[Off]:
  Disables this function.

• To restart from system standby, set the 
POWER/HOLD switch to on. The recorder 
quickly recovers from system standby.

 Notes

• The recorder uses battery power in system 
standby, so be aware of the remaining 
battery level.

• When [Auto Power Off] is not set to [Off], 
and [System Standby] is set to [On], the 
recorder automatically enters system 
standby mode when the specified time for 
[Auto Power Off] is reached.

• System standby mode is effective for 
a maximum of 24 hours. When the 
maximum time is exceeded, the recorder 
automatically turns off.

 2 Select the [5minutes], [10minutes], 
[30minutes], [1hour], [2hours], 
[3hours] or [Off].

[5minutes] [10minutes] [30minutes] 
[1hour] [2hours] [3hours]:

  Set the length of time before the  
 power will be turned off.

[Off]: Disables this function.

Reset Settings

This returns the functions back to their initial 
settings (factory default).

 1 Select [Reset Settings] from the 
menu on the [System Menu].

 2 Press the + button to select 
[Start], and then press the `OK 
button.

[Start]:
 Returns the settings to their initial values.
[Cancel]:
 Takes you back to the [System Menu].

Menu settings after setting reset 
(initial settings):

Rec Menu:

[Mic Sense] [Middle]
[Rec Mode]
 [WMA] [ST XQ]
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[Rec Level] [Auto]
[Zoom Mic] [Off]
[Low Cut Filter] [Off]
[VCVA]  
 [On/Off] [Off]
 [Standby] [Off]
[Rec Scene] [Off]
[Timer Rec] [Off]
[Folder Name] [Initial setting]

Play Menu:

[Noise Cancel] [Off]
[EUPHONY] [Off]
[Voice Filter] [Off]
[Repeat]  [Off]
[Random] [Off]
[Play Speed] [100]
[Skip Space]
 [Forward Skip] [File Skip]
 [Reverse Skip] [File Skip]
[Play Scene] [Off]

LCD/Sound Menu:

[Backlight]
 [Lighting Time] [10seconds]
 [Dim light time] [30seconds]
 [Brightness] [Level 02]
[LED]  [On]
[Beep]  [Volume 3]
[Language(Lang)] [English]
[Voice Guide]
 [Menu Guide] [On]
 [File Guide] [On]
 [Speed] [100]
 [Volume] [Volume 3]
[Alarm]  [Off]
[Accessibility]*1 [Off]

System Menu:

[Fn. setting]
 [F1]  [LIST]
 [F2]  [INDEX]
[Memory Select] [Built-in]
[System Standby] [Off]
[Auto Power Off] [10minutes]
[USB Settings]
 [USB Connect] [PC]
 [USB Class] [Storage]

Book Menu (Daisy Menu)*2 
(Text Speech Menu)*2:

[Skip Mode] [Section]
[Characters] [ANSI]
[Text Language] [English]
 
*1 For DM-4
*2 When [Accessibility] is set to [On] 

(For DM-4).

 Note

• After resetting the settings, the time 
settings and file numbers will be 
preserved from before the reset and will 
not return to their initial settings.
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Memory Info.

The recordable capacity remaining and 
overall capacity of the recording media can 
be displayed from the menu display.
• When no microSD card is inserted only 

information for the built-in memory will 
be displayed.

• The domain area which uses the 
administrative files which the recorder 
uses is included in the remaining capacity 
for the recording media. For microSD 
cards in particular, in addition to this 
administrative domain the administrative 
domain area for the microSD card is added 
in as well. Owing to this, the remaining 
capacity will be displayed as less than the 
card’s specified capacity, yet this is not 
abnormal.

Menu setting method

Format

Refer to “Formatting the recorder 
[Format]” (☞ P.99).

System Info.

You can check the recorder’s information on 
the menu display. [Model] (Model Name), 
[Version] (System version) and [Serial No.] 
(Serial Number) appears on the display.

G Book Menu

You can change the skip space settings for 
DAISY contents stored in the [DAISY] folder 
or change the character code and language 
preferences for text files stored in the [TEXT] 
folder.
• When [Accessibility] (☞ P.76) is set to [On], 

the [Book Menu] will be reorganized into 
[Daisy Menu] and [Text Speech Menu] 
(For DM-4).

Skip Mode

DAISY contents are divided in units of 
chapters, sections, paragraphs, pages, etc. 
It is possible to quickly move from one 
location to another. In addition to chapters, 
sections, paragraphs, and pages, movable 
units also include groups, phrases, and 
bookmarks. It is possible to specify the 
desired skip mode to meet the playback 
method of contents file.

 1 From the [Home] menu display 
select [Audiobooks], and then 
press the `OK or 9 button.

• When [Accessibility] is set to [On], 
select [DAISY].

 2 In the Book list display, press the 
F3 (MENU) button.

• When [Accessibility] is set to [On], 
press the F3 (Menu) button in the file 
display.

 3 Press the + or − button to select 
[Book Menu], and then press the 
`OK or 9 button.

• When [Accessibility] is set to [On], 
select [Daisy Menu].

 4 Press the + or − button to select 
[Skip Mode], and then press the 
`OK or 9 button.
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Characters

You can change the setting of the display 
character to match the character code of the 
text file stored in the [TEXT] folder. In order to 
have the recorder read out the text file created 
in diverse environments, change the character 
code if necessary.

 1 From the [Home] menu display 
select [Audiobooks], and then 
press the `OK or 9 button.

• When [Accessibility] (☞ P.76) is set to 
[On], select [Text Speech].

 2 In the Book list display, press the 
F3 (MENU) button.

• When [Accessibility] is set to [On], 
press the F3 (Menu) button in the file 
display.

 3 Press the + or − button to select 
[Book Menu], and then press the 
`OK or 9 button.

• When [Accessibility] is set to [On], 
select [Text Speech Menu].

 4 Press the + or − button to select 
[Characters], and then press the 
`OK or 9 button.

 5 Select the [ANSI], [UTF-8] or [UTF-16].

Menu setting method

 5 Select [Section], [Group], 
[Page], [Sentence], [Phrase] or 
[Bookmark].

When [Section] is selected:
 [Level 1] [Level 2] [Level 3] [Level 4] 

[Level 5] [Level 6]

Skip mode list:

[Section]
(Level 1~6)

Denotes chapters, sections, 
paragraphs, etc. in DAISY 
contents.
Example: [Level 1] is 
equivalent to chapters, 
[Level 2] is equivalent to 
sections, and [Level 3] is 
equivalent to paragraphs.

[Group]

A portion within a section 
is called a group. Groups 
are sometimes set for the 
beginning and end of 
diagram explanations.

[Page]
Equivalent to the page 
of book.

[Sentence]

When reading a text 
aloud, a breathing 
interval is created at the 
punctuation between 
sentences. The audio 
between this interval and 
the next interval is called a 
“Sentence”.

[Phrase]
The recorder will skip 
a word, phrase, or an idiom.

[Bookmark]
Indicates a location where 
an index mark (bookmark) 
is set.

 Note

• Depending on the DAISY contents, there 
are cases where there is no location 
corresponding to a dividing interval.
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Text Language

You can change the language for reading out 
the text files stored in the [TEXT] folder.

 1 From the [Home] menu display 
select [Audiobooks], and then 
press the `OK or 9 button.

• When [Accessibility] (☞ P.76) is set to 
[On], select [Text Speech].

 2 In the Book list display, press the 
F3 (MENU) button.

• When [Accessibility] is set to [On], 
press the F3 (Menu) button in the file 
display.

 3 Press the + or − button to select 
[Book Menu], and then press the 
`OK or 9 button.

• When [Accessibility] is set to [On], 
select [Text Speech Menu].

 4 Press the + or − button to select 
[Text Language], and then press 
the `OK or 9 button.

 5 Set the Language.

[English] [Français] [Español]:

Menu setting method

 Notes

• When the [LCD/Sound Menu] – [Voice 
Guide] setting (☞ P.89) is set to [On], the 
[Text Language] setting cannot be changed. 
Set the [Voice Guide] setting to [Off], and 
then specify the [Text Language] setting.

• When the [Voice Guide] setting (☞ P.89) 
is [On], the language for reading out text 
files will be the same as that set for the 
voice guidance in [Text Language].
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Setting the recording scene 
[Rec Scene]

The recording setting can be selected from 
the [Dictation], [Conference], [Lecture] 
templates to suit the recording scene or 
situation. You can also save a recording 
setting of your choice.

 1 Select [Rec Scene] from the menu 
on the [Rec Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Select [Scene Select] or [Scene 
Save].

Template for Setting a Recording scene

In [Scene Select], you can select a recording scene that is most suitable for the recording 
scene or situation from three templates. The recording settings for the respective recording 
scenes are as follows.

Record Setting
Recording Scene

Off Dictation Conference Lecture

[Mic Sense] Middle Low Middle High

[Rec Mode] ST XQ HQ ST XQ ST XQ

[Rec Level] Auto Auto Auto Auto

[Zoom Mic] Off Off Wide Zoom

[Low Cut Filter] Off On On On

[VCVA] Off Off Off Off

[Standby] Off Off Off Off

When [Scene Select] is selected:

1 Press the + or – button to select the 
recording scene you want to set.

2 Press the `OK button to complete 
the selection.

• To confirm the respective recording 
scene settings, press the + or – button 
in the [Scene Select] display to select 
the item you want to confirm, then 
press the 9 button to confirm in 
the setting confirmation display. To 
end the setting confirmation display, 
press the 0 button and the display 
will return to the [Scene Select] 
display.

When [Scene Save] is selected:

Besides the [Rec Scene] templates found 
in the recorder, you can also save the menu 
settings of a recording you have set to 
your choice.
[Scene Save] cannot be used during 
recording. While the recorder is paused, 
enter the menu from the [Home] menu 
display, and then perform this setting.
1 Press the + or – button to select the 

[User Setting] you want to save.
2 Press the `OK button to complete 

the settings.

 3 Press the F3 (HOME) button to 
complete the setting.

Menu setting method



85

3

EN

Timer recording [Timer Rec]

Timer recording is the function to execute a 
recording at a set time. You can program up to 
three desired settings (Preset 1-3) ([On/Off], 
[Day], [Start Time], [Stop Time], [Rec Mode], 
[Mic Sense], [Memory Select], [Folder], and 
[Keyword]).

 1 Select [Timer Rec] from the menu 
on the [Rec Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Press the + or − button to select a 
preset number, and then press the 
`OK or 9 button.

 3 Press the + or − button to select 
the item to set, and then press the 
`OK or 9 button.

• Select items you want to set from 
among [On/Off], [Day], [Start Time], 
[Stop Time], [Rec Mode], [Mic Sense], 
[Memor y Selec t] ,  [Folder] ,  and 
[Keyword].

[On/Off] setting:

1 Press the + or – button to select between 
[On] and [Off].

[On]:
 Setting will be applied.
[Off]:
 Setting will not be applied.

2 Press the `OK button to exit [On/Off] 
selection.

[Day] setting:

1 Press the + or – button to select from [One 
Time], [Everyday], and [Every Week].

Menu setting method

[One Time]:
 Records only once at the specified 

time.
[Everyday]:
 Records every day at the specified 

time.
[Every Week]:
 Make a recording at a set time on a 

specified day of the week.
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Select [Every Week] and press the `OK 
button to move to the selection of [Day]. 
Press the + or – button to select a day of 
the week.

2 Press the `OK button to exit [Day] 
selection.

Menu setting method

[Start Time] and [Stop Time] setting:

1 Press the 9 or 0 button to select 
“Hour” and “Minute” in the [Start Time] 
and “Hour” and “Minute” in the [Stop 
Time].

2 Press the + or – button to set.
3 Press the `OK button to exit [Start Time] 

and [Stop Time] selection.

[Rec Mode] setting:

Regardless of the regular [Rec Mode] 
(☞ P.69), timer recording will start in a set 
recording mode.

1Press the + or – button to select a 
recording mode.

2Press the `OK or 9 button.

The voice control function can be 
used with this setting
(☞ P.118) (For DM-4).

3Press the + or – button to select a 
recording rate.

4Press the `OK button to exit [Rec Mode] 
selection.

[Mic Sense] setting:

Regardless of the recorder’s microphone 
sensitivity setting (☞ P.69), timer recording 
will start at a set microphone sensitivity.
1Press the + or – button to select from 

[High], [Middle], and [Low].
2Press the `OK button to exit [Mic Sense] 

selection.
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Menu setting method

[Memory Select] setting:

1Press the + or – button to select the 
destination to save to (Memory).

2Press the `OK button to exit [Memory 
Select] setting selection.

[Folder] setting:

1Press the + or – button to select the 
destination to save to (Folder).

2Press the `OK button to exit [Folder] 
setting selection.

[Keyword] setting:

Tag a keyword to file to be recorded using 
the timer.

1Press the + or – button to select the 
desired keyword, and then press the 
`OK button.

Completing the setting:

 4 Press the F2 (GO) button to 
complete the setting.

The voice control function can be 
used with this setting
(☞ P.118) (For DM-4).

a

Programmed settings will be applied and 
the display will return to the preset number 
selection menu. If the [On/Off] setting is 
set to [On], [j] will appear on the display.

a When setting to [On]
To set other preset numbers, repeat the 
above mentioned procedure.
When the 9 button is pressed in the 
Select in Advance Menu, the settings 
selected can be confirmed.
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Setting the playback scene 
[Play Scene]

Voice files recorded in the recorder and 
music files downloaded from the PC can be 
saved in the playback settings of your choice 
to suit the different sound qualities and 
playback methods.

 1 Select [Play Scene] from the menu 
on the [Play Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Select [Scene Select] or [Scene 
Save].

When [Scene Select] is selected:

1 Press the + or – button to select the 
playback scene you want to set.

2 Press the `OK button to complete the 
selection.

 Notes

• If the recorder is in use at the preset start 
time, the timer recording will start directly 
after stopping the recorder.

• Even if the power is turned off or the 
recorder is put on Hold, timer recording will 
start at a specified time.

• If three timer recordings have the same 
starting times, [Preset 1] has the highest 
priority and [Preset 3] has the lowest.

• If the starting time for timer recording and 
alarm playback (☞ P.91) is set for the same 
time, timer recording will have priority.

• If the batteries run out while recording 
based on the timer setting, the recorder will 
stop recording. Check the battery power 
before starting the timer recording.

• If the [Time & Date] is not correct, timer 
recording cannot be set at the specified 
time, so make sure the [Time & Date] is 
correct before setting timer recording. If it 
is not correct, reset [Time & Date] (☞ P.31).

• The recorder will record in the built-in 
memory [Folder A] when the microSD 
card is selected as the recording 
destination and the microSD card is not 
inserted during Timer Recording. 
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• After purchase, all the settings from 
1 to 5 of [User Setting] are the same 
(initial settings). Register the user 
settings in the [Scene Save] then 
select playback scene.

• To confirm the respective playback 
scene settings, press the + or – button 
in the [Scene Select] display to select 
the item you want to confirm, then 
press the 9 button to confirm in 
the setting confirmation display. To 
end the setting confirmation display, 
press the 0 button and the display 
will return to the [Scene Select] 
display.

Menu setting method

When [Scene Save] is selected:

You can save the menu settings of a play-
back you have set to your choice.
1 Setting the menu of a playback in the 

recorder to your choice (☞ P.73).
2 Press the + or – button to select the 

[User Setting] you want to save.
3 Press the `OK button to complete 

the settings.

 3 Press the F3 (HOME) button to 
complete the setting.

Guidance [Voice Guide]

This feature gives voice announcements 
of recorder operating conditions and 
file tag information (For DM-4). Adjust 
the speed and the volume of guidance 
announcements.

 1 Select [Voice Guide] from the 
menu in [LCD/Sound Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Press the + or − button to select 
the item to set, and then press 
the `OK or 9 button.

[Menu Guide] setting:

Provides voice guidance for menu settings.
1Press the + or – button to select between 

[On] and [Off].
[On]:
 [Menu Guide] will be provided.
[Off]:
 Guidance will be canceled.

2Press the `OK button to exit [Menu 
Guide] selection.
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[File Guide] setting:

Provides voice guidance for file tag 
information.
1Press the + or – button to select between 

[On] and [Off].
[On]:
 [File Guide] will be provided.
[Off]:
 Guidance will be canceled.

2Press the `OK button to exit [File Guide] 
selection.

[Speed] setting:

Sets the voice guidance speed.
1Press the + or – button to set the playback 

speed.
2Press the `OK button to exit [Speed] 

selection.

[Volume] setting:

Sets the voice guidance volume.
1Press the + or – button to select from 

[Volume5], [Volume4], [Volume3], 
[Volume2], and [Volume1].

2Press the `OK button to exit [Volume] 
selection.

 3 Press the F3 (HOME) button to 
complete the setting.

 Notes

• The starting tune/closing tune when the 
power is turned On/Off (☞ P.28) can be 
canceled if you set the guidance to [Off].

• Set the starting tune/closing tune at the 
guidance [Volume] setting.

• If [Play Speed] has been changed, the 
[Speed] setting in the [Voice Guide] 
settings cannot be changed.
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Alarm playback function [Alarm]

The alarm playback function can be set to play 
a selected file at a pre-set time.
You can program up to three desired settings 
(Preset 1-3) ([On/Off ], [Day], [Start Time], 
[Volume] , [Alarm Sound] and [Playback 
File]).

 1 Select [Alarm] from the menu on 
the [Play Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Press the + or − button to select a 
preset number, and then press the 
`OK or 9 button.

 3 Press the + or − button to select 
the item to set, and then press the 
`OK or 9 button.

• Select items you want to set from 
among [On/Off] [Day] [Start Time] 
[Volume] [Alarm Sound] [Playback 

File].

[On/Off] setting:

1Press the + or – button to select between 
[On] and [Off].

2Press the `OK button to exit [On/Off] 
selection.
[On]: 
 Setting will be applied.
[Off]: 
 Setting will not be applied.

Menu setting method

[Day] setting:

1Press the + or – button to select from 
[One Time], [Everyday], and [Every 
Week].
[One Time]:

 Alarm Playback will be performed  
 only once at the specified time.

[Everyday]:
 Alarm Playback will be performed at  
 the specified time every day.

[Every Week]:
 Make a Alarm Playback at a set time  
 on a specified day of the week.
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Select [Every Week] and press the `OK 
or 9 button to move to the selection of 
[Day]. Press the + or – button to select a day 
of the week.
2Press the `OK button to exit [Day] 

selection.

Menu setting method

[Start Time] setting:

1 Press the 9 or 0 button to select 
“Hour” and “Minute” in the [Start Time] 
and “Hour” and “Minute” in the [Stop 
Time].

2 Press the + or – button to set.
3 Press the `OK button to exit [Start Time] 

selection.

[Volume] setting:

1 Press the + or – button to adjust the 
volume. Press the `OK button to check 
the volume.

2 Press the `OK button to exit [Volume] 
selection.

[Alarm Sound] setting:

1 Press the + or – button to select an alarm 
sound from among [Alarm1], [Alarm2] 
and [Alarm3]. Press the `OK button to 
check the alarm sound.

2 Press the `OK button to exit [Alarm 
Sound] selection.

The voice control function can 
be used with this setting
(☞ P.118) (For DM-4).
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Menu setting method

When [File Select] is selected:

1 Press the + or − button to select the 
memory with the file to be played as 
an alarm, and then press the `OK or 
9 button.

2 Press the + or − button to select a 
folder, and then press the `OK or 
9 button.

3 Press the + or − button to select a 
folder, and then press the `OK or 
9 button.

4 Press the + or − button to select the 
file to be played as an alarm, and then 
press the `OK  button.

Completing the setting:

 4 Press the F2 (GO) button to 
complete the setting.

[Playback File] setting:

1 Press the + or – button to select from [No 
File Play], [File Select].
[No File Play]:

 Sounds alarm only. 
 If [No File Play] has been selected,  
 proceed to the procedure listed  
 under “Completing the setting”.

[File Select]:
 Plays back a selected file after the  
 alarm.
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Menu setting method

 Notes

• If [Everyday] is selected, the alarm will 
sound at the scheduled time every day 
unless alarm playback is canceled.

• The alarm will sound for five minutes 
and then stop. Even if a file is selected for 
Alarm Playback, it will not be automatically 
played when the alarm sounds.

• If three alarm playback have the same 
starting times, [Preset 1] has the highest 
priority and [Preset 3] has the lowest.

• If the recorder is in use or if operations are 
being performed at the scheduled time, 
the Alarm Playback function will not be 
available.

• The alarm will sound at the scheduled 
time even if the power is turned off or the 
recorder is set to Hold mode. The recorder 
begins to play the selected file when you 
press any button, and stops playing when 
you press the STOP button.

a

Programmed settings will be applied 
and the display will return to the preset 
number selection menu. If the [On/Off] 
setting is set to [On], [i] will appear on 
the display.

a When setting to [On]
To set other preset numbers, repeat the 
above mentioned procedure.
When the 9 button is pressed in the 
Select in Advance Menu, the settings 
selected can be confirmed.

• If the selected file is moved, erased or the 
microSD card removed, file playback will 
not be performed and only the alarm will 
sound.

• If the starting times for timer recording and 
alarm playback are set for the same time, 
timer recording will have priority (☞ P.85).
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Moving/Copying files 
[File Move/Copy]

Files saved in the built-in memory or the 
microSD card can be moved or copied 
within the memory. Files can also be moved 
or copied between memory.

 1 Select the folder where the file 
you want to move or copy is 
saved (☞ P.55 to P.61).

 2 Select [File Move/Copy] from the 
menu on the [File Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 

method” (☞ P.67).

 3 Press the + or − button to select 
the position to move or copy the 
file to.

 4 Press the `OK or 9 button.

[move > memory]

Move a file in the built-in 
memory or microSD card 
to another folder within 
the built-in memory.

[copy > memory]

Copy a file in the built-in 
memory or microSD card to 
another folder within the 
built-in memory.

[move > microSD]

Move a file in the built-in 
memory or microSD card 
to another folder in the 
microSD card.

Menu setting method

[copy > microSD]

Copy a file in the built-in 
memory or microSD card 
to another folder in the 
microSD card.

 5 Press the + or − button to select 
the number of files to move or 
copy.

[1file]
Select only the specified 
file.

[Selected files] Select multiple files.

[All files]
Select all files in the 
folder.

 6 Press the `OK or 9 button to 
move to the respective setting.

When you select [1file]:

1 Press the + or − button to select the 
file you want to move or copy.

2 Press the `OK button to select the 
file. Proceed to Step 7.
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Menu setting method

When you select [Selected files]:

1 Press the + or − button to select the 
file you want to move or copy.

2 Press the `OK button to check the 
file(s) selected.

3 Repeat steps 1 and 2 until all the 
files you want to move/copy are 
selected then press the F2 (GO) 
button.

When you select [All files]:

 When all files are selected, all the files 
in the folder will be automatically 
selected and the recorder will move 
to the [Folder to move] screen.

 7 Press the 9 , 0, + or − 
button to select the folder you 
want to move or copy the file to.

 8 Press the F2 (Go) button.

• File move or file copy will start if 
[Moving!] or [Copying!] appears on 
the display.
The process is completed when [File 
move completed] or [File copy 
completed] is displayed.

 Notes

• The recorder cannot copy when the 
memory capacity is not sufficient.

• The recorder cannot move or copy when 
the number of file exceeds 999.

• Do not remove the battery during moving 
or copying. This may damage the datas.

• A file cannot be moved or copied to the 
same folder.

• When the operation is canceled during 
moving or copying, only the file that is 
being moved or copied is effective, all 
other files will become not effective.

• Files which are locked (☞ P.77) will remain 
so even after they are moved or copied.

• DRM files cannot be moved or copied.
• Files cannot be moved or copied directly 

under the [Recorder] folder.
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Dividing files [File Divide] 

Files with large capacities and long 
recording times can be divide so that they 
are easier to manage and edit.

 1 Select the file you want to divide 
(☞ P.55 to P.61).

 2 Start Playback or fast-forward 
the file, and stop the playback at 
divide position.

• In the file display, the stop position 
becomes the divide position.

• During playback, press and hold the 
9 or 0 button to fast-forward 
or rewind (☞ P.49).

• It is useful to set index marks on 
marking in advance at the divide 
position (☞ P.53).

 3 Select [File Divide] from the menu 
on the [File Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

• A file cannot be divide during an 
operation such as playback by the 
recorder.

 4 Press the + button to select 
[Start], and then press the `OK 
button.

• [Dividing!] will be displayed and 
file splitting will start. Splitting 
is completed when [File divide 
completed] is displayed.

 Notes

• The file divide cannot be done when the 
file list is displayed.

• The recorder cannot divide files when the 
number of files in the folder exceeds 998.

• Locked files (☞ P.77) cannot be divide.
• After splitting the fi le, the front part of the 

fi le will be renamed as [File name_1.MP3] 
and the latter part of the fi le will be named 
as [File name_2.MP3].

• If a file has an extremely short recording 
time, it may not be divide even if it is a 
PCM file.

• Do not remove the battery during dividing 
file. This may damage the data.

Menu setting method

Only PCM and MP3 files recorded 
on this recorder can be divide.



98

3

EN

Menu setting method

M
e

n
u

 se
ttin

g
 m

e
th

o
d

 1 Select [USB Settings] from the 
menu on the [System Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Press the + or − button to select 
[USB Connect] or [USB Class].

 3 Press the `OK button to move to 
the respective setting.

 4 Press the + or − button to select 
the item to set.

When [USB Connect] is selected:

[PC]:
 Setting for when the recorder is 

connected to the PC and used as a 
storage device or composite device. 
Connected as storage or composite.

[AC]:
 Setting for connecting to the USB 

connecting AC Adapter (A514) 
(optional) using the USB cable 
provided. The recorder can be 
operated on during charging.

[EACH]:
 Setting to confirm the connection 

method each time a USB connection 
is made.

Changing the USB Class [USB Settings]

Besides settings such as [PC], which is using 
the USB cable provided to connect to the 
PC to transmit files, etc. and [AC], which is 
connecting the USB Connecting AC Adapter 
(A514) (optional) for charging.

When [USB Class] is selected:

[Storage]:
 Recognized as an external memory 

device from the PC.
[Composite]:
 Setting when connected to the PC 

and used as an external memory 
device, USB speaker or microphone.
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Menu setting method

 5 Press the `OK button to 
complete the setting.

 6 Press the F3 (HOME) button to 
close the menu display.

• When this recorder is connected 
to the computer for the first time 
under [Storage] or [Composite], the 
driver will be installed automatically 
to the computer. The display will 
show [Remote] when the recorder is 
connected to the PC.

 Notes

• When the USB Connecting AC Adapter is 
connected in the [PC] status, the recorder 
will display [Please wait] and cannot be 
operated on. Only charging is possible.

• The PC cannot recognize when the 
recorder is connected to the PC when 
setting for the [USB Connect] is set to 
[AC].

• Switch to [Storage] when the recorder is 
not recognized as an external memory 
device by the PC even if the [Composite] 
setting is selected.

 1 Select [Format] from the menu on 
the [System Menu].

• For details on how to enter the menu 
settings, please see “Menu setting 
method” (☞ P.67).

 2 Press the + or − button to select 
the recording media to format, 
and then press the `OK or 9 
button.

 3 Press the + button to select 
[Start], and press the `OK button.

• After the [Data will be cleared] 
message is on for two seconds, 
[Start], [Cancel] will turn on.

Formatting the recorder [Format]

If you format the recorder, all files 
will be removed and all function 
settings will return to defaults except 
date and time settings. Transfer any 
important files to a computer before 
formatting the recorder.
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 4 Press the + button again to select 
[Start], and then press the `OK 
button.

• Formatting begins and [Formatting !] 
flashes on the display.

• [Format Done] appears when 
formatting ends.

 Notes

• When an microSD card is inserted in the 
recorder, be sure to confirm the recording 
media as either [Built-in] or [microSD] so 
that there is no mistake (☞ P.78).

• Never perform operations such as the 
following while processing, as they may 
damage the data. In addition, carefully 
check the remaining battery level in order 
to ensure that the battery will not run out 
while processing.

Menu setting method
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 1 Unplugging the AC adapter while  
 processing.

 2 Removing the battery while processing.
 3 Remove the microSD card during  

 processing when [microSD] is   
 being used as the recording media.

  Performing any of these operations  
 may damage the data.

• Never format the recorder from a PC.
• When the recorder is formatted, all the 

saved data, including locked files and 
read-only files, are erased.

• When returning the settings for the 
functions to their initial settings, use 
[Reset Settings] (☞ P.79).

• Formatting on the recorder will be 
Quick Format. If you format the microSD 
card, information of file management 
is refreshed and the data inside the 
microSD card is not deleted completely. 
Formatting or deleting the contents of 
the microSD card or built-in memory does 
not completely erase the data. When you 
dispose of media, we recommend that 
you take measures to prevent the loss 
of sensitive data, such as destroying the 
media before disposal.
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Schedule settings [Audio Diary]

The recorder has a scheduling function. 
Besides simple scheduling, it is also possible 
to register voice memos in the desired date 
using the voice recording function.

Displaying the calendar

 1 From the [Home] menu display 
select [F Audio Diary], and then 
press the `OK or 9 button.

• A monthly calendar display is 
displayed.

 Note

• The calendar does not display national 
holidays.

Switching the calendar display

It is possible to switch the calendar screen 
between a monthly, weekly, and daily 
display.

 1 In the calendar display, press the 
F3 (MENU) button.

 2 Press the + or − button to select 
[s DISPLAY], and then press the 
`OK button.

• The calendar display switches to a 
weekly display.

• From the weekly display, move the 
cursor to the day you want to display. 
Press the `OK button to switch to the 
daily display.

• If the calendar function is exited, the 
monthly display is displayed the next 
time the calendar display is opened.
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Operations at the calendar display

Operations at the monthly display:

[F1] button
The display returns to the 
[Home] menu display.

[F2] button

Changes the month that 
is displayed. At the popup 
menu display, press the + 
or - button to select the 
previous or next month.

[F3] button
The menu will appear on 
the display.

Operations at the weekly display:

[F1] button
The display returns to the 
[Home] menu display.

Operations at the daily display:

[F1] button
The display returns to the 
weekly display.

[F2] button
Displays the details of the 
daily schedule.

[F3] button
The menu will appear on 
the display.

Schedule settings [Audio Diary]
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[F2] button Disables this function.

[F3] button
The menu will appear on 
the display.
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Add a schedule

Adds a schedule. It is possible to register 
a schedule’s starting/ending time, its 
frequency, the schedule’s keywords and the 
voice keywords recorded using the voice 
recording function.

 1 From the calendar display, press 
the 9 , 0 , + or − button to 
select the date to which you want 
to add a schedule, and then press 
the F3 (MENU) button.

 2 Select [F Audio DiaryMenu], 
and then press the `OK or 9 
button.
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Schedule settings [Audio Diary]

 3 Press the + or − button to select 
[New], and then press the `OK or 
9 button.

 4 Move the cursor to the item you 
want to set, and then press the 
`OK or 9 button.

[Date] setting:

1 Press the 9, 0, + or – button, set 
the “Year”, “Month”, and “Date”. Press the 
`OK button.

The voice control function can be 
used with this setting
(☞ P.118) (For DM-4).

[Start Time] and [Stop Time] setting:

1 Press the 9, 0, + or – button, set 
the “Hour” and “Minute” in the [Start 
Time] or [Stop Time]. Press the `OK 
button.

The voice control function can be 
used with this setting
(☞ P.118) (For DM-4).
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[Repeat] setting:

1 Press the + or − button to select the item 
to set, and then press the `OK button.

• You can specify the event frequency from 
[One Time], [Everyday], [Every Week], 
[Every Month], and [Every Year].

[Keyword] setting:

1 Press the + or – button to select the 
desired keyword, and then press the `OK 
button.

Schedule settings [Audio Diary]

The voice control function can be 
used with this setting
(☞ P.118) (For DM-4).

Keyword list:
 Sets a keyword from the preset template.

Car Train Plane

Bus Work Interview

Business trip Conference Lecture

Class Memo Record

Telephone 
recording Diary Conversation

Favorites School Hospital

Hobby Meal Shopping

Travel Lesson Learning a 
language

Drive Sport Camping

Music Family Kids

Partner Friend Event

Holiday Date Birthday

Payday
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[Voice Keyword] setting:

1 Press the REC button to record a voice 
keyword or a comment for the schedule.

2 When you record a voice keyword, 
pressing the STOP button will stop the 
recording.
• In schedules that contain a voice 

keyword,  will be displayed.
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[Alarm] setting:

1 Press the + or − button to select [Alarm] 
setting, and then press the `OK button.
[Off]:
 Disables this function.
[1] to [3]:
 Select the alarm sound for the alarm 

notification.

Completing the setting:

 5 Press the F2 (GO) button to 
complete the setting.

• A day with a schedule is underlined.

 Notes

• A maximum of 1000 events can be 
scheduled.

• A maximum of 1 minute can be recorded 
in a voice keyword.

Schedule settings [Audio Diary]

• Moving the cursor to [Voice 
keyword] in the schedule’s details 
display will make the voice keyword 
playback automatically.
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Registering a voice memo

It is possible to register a voice memo in 
the selected date using the voice recording 
function.

When registering from the monthly 
display:

 1 From the calendar display, press the 
9, 0, + or − buttons to choose 
the date you want to register into, 
and then press the REC button.

• The voice memo recording starts.

 2 Press the STOP button to stop 
recording.

• The number of registered voice 
memo will be displayed.

When registering from the weekly 
display:

 1 From the weekly display, press the 
+ or – button to choose the day you 
want to register, and then press 
the REC button.

• The voice memo recording starts.

 2 Press the STOP button to stop 
recording.

• The number of registered voice 
memo will be displayed.
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When registering from the daily 
display:

 1 From the daily display screen, 
press the + or – button to move the 
cursor to a voice memo, and then 
press the REC button.

• The voice memo recording starts.

 2 Press the STOP button to stop 
recording.

• The number of registered voice 
memo will be displayed.

 Notes

• It is possible to register up to 99 voice 
memos per day.

• A maximum of 5 minutes can be recorded 
in a voice memo.
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Schedule settings [Audio Diary]

Listening to a voice memo:

 1 From the daily display screen, 
press the + or – button to move the 
cursor to a voice memo, and then 
press the `OK button.

• The recorder enters into the voice 
memo’s details display.

 2 Press the + or – button to move 
the cursor to the voice memo you 
want to listen.

• Moving the cursor to a voice memo 
will make it playback automatically.



108

3

EN

Schedule settings [Audio Diary]

Sch
e

d
u

le se
ttin

g
s [A

u
d

io
 D

ia
ry]

Playing audio files from the schedule 
list display

In case of audio files recorded with the 
recorder, an icon will be displayed in the 
schedule list display according to their 
recording date and time. It is possible to 
playback audio files from the schedule list 
display.

 1 From the calendar display, press 
the 9, 0, + or − buttons to 
choose a date you registered into, 
and press the `OK button.

• The recorder enters into the schedule 
list display.

 2 Press the + or – buttons to move 
to a schedule with the A icon, and 
press the `OK button.

• The audio file playback starts.

 3 Press the STOP button to stop 
recording.

 Note

• If you stop the playback of an audio file, 
the recorder will show the stop display. To 
continue, start the above procedure again 
from step 1.
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Editing the schedule

The details of scheduled events can be 
edited.

 1 From the calendar display, press 
the 9 , 0 , + or − button to 
select the day of the event you 
want to edit, and then press the 
`OK button.

 2 Press the + or − button to select 
the event you want to edit, and 
then press the F3 (MENU) button.

 3 Select [F Audio DiaryMenu], 
and then press the `OK or 9 
button.

 4 Press the + or − button to select 
[Edit], and then press the `OK or 
9 button.

• For the procedure for changing event 
details, please see “Add a schedule”. Sch
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Deleting a schedule

Delete the contents of a scheduled event.

 1 From the calendar display, press 
the 9 , 0 , + or − button to 
select the day of the event you 
want to delete, and then press the 
`OK button.

 2 Press the + or − button to select 
the event you want to delete, and 
then press the F3 (MENU) button.

 3 Select [F Audio DiaryMenu], 
and then press the `OK or 9 
button.

 4 Press the + or − button to select 
[Delete], and then press the `OK 
or 9 button.

 5 Press the + or – buttons to choose 
the number of events to delete, and 
press the `OK or 9 button.

Schedule settings [Audio Diary]

1 file Deletes a selected event.

A day
Deletes all the events 
registered in the selected 
day.

A month
Deletes all the events 
registered in the selected 
month.
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 6 Press the + button to select 
[Start], and then press the `OK 
button.
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• The selected number of events will be 
deleted.

 Notes

• Although events are deleted, recorded 
audio files data and the event list display 
icon (A) will be kept. To know more 
about audio files deletion, please refer to 
“Erasing” (☞ P.62).

• All the events set using the [Repeat] 
function will be deleted (☞ P.104).

Deleting a voice memo

Delete a registered voice memo.

 1 From the calendar display, use 
the 9, 0, + or − buttons to 
choose a date that contains voice 
memo you want to delete, and 
then press the `OK button.

• The recorder enters into the schedule 
list display.

 2 Press the + or – buttons to move 
to a voice memo, and then press 
the `OK button.

• The recorder enters in the voice 
memo list display.
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 3 Press the F2(ERASE) button.

 4 Press the + or – buttons to choose 
the number of events to delete, and 
press the `OK or 9 button.

1 file
Deletes a selected voice 
memo.

A day
Deletes the voice memos 
registered in the selected 
day.

A month
Deletes the voice memos 
registered in the selected 
month.

 5 Press the + button to select 
[Start], and then press the `OK 
button.

• The selected number of voice memos 
will be deleted.
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Schedule settings [Audio Diary]

Formatting the schedule

Register to remove all the contents of 
schedule to initialize.

 1 From the [Home] menu display 
select [F Audio Diary], and then 
press the `OK or 9 button.

 2 In the calendar display, press the 
F3 (MENU) button.

 3 Select [F Audio DiaryMenu], 
and then press the `OK or 9 
button.

 4 Press the + or − button to select 
[Format], and then press the `OK 
or 9 button.

 5 Press the + button to select 
[Start], and then press the `OK 
button.

 6 Press the + button again to select 
[Start], and then press the `OK 
button.

• [Format Done] appears when 
formatting ends.

 Note

• Although the schedule is formatted, 
recorded audio files data and the schedule 
list icon (A) will be kept. To know more 
about audio files deletion, please refer to 
“Erasing” (☞ P.62).
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Viewing images (For DM-4)

This recorder can connect to a digital 
camera and import images.
• When [Accessibility] is set to [On], this 

function can not be used. To use this 
function, please set [Accessibility] to [Off] 
(☞ P.76).

The recorder can connect to digital cameras 
that support storage (USB storage class).
You can use the provided USB connection 
cable.

Importing images 

 1 From the [Home] menu display, 
select [E Picture], and then 
press the `OK or 9 button.

 2 Press the + or − button to select 
[Import], and then press the `OK 
or 9 button.

 3 Press the + or − button to select 
[microSD] or [USB], and then press 
the `OK or 9 button to set 
(complete) the media you want to 
import.

• JPEG image files located in the DCIM 
folder can be imported.

[microSD] 
Import images stored on 
a microSD card to this re-
corder.

[USB]
Import images stored on a 
connected digital camera 
to this recorder. 

 4 Press the + or − button to select 
[Built-in] or [microSD], and press 
the `OK or 9 button to set 
(complete) the memory for 
importing destination.

 5 Press the + button to select [OK], 
and then press the `OK button.

• The display changes to 
[Synchronizing] and import starts.

 Note

• Images that can be imported by the 
recorder are JPEG files managed by 
folder configuration complying to DCF 
standards.
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Viewing images (For DM-4)

Viewing images

 1 From the [Home] menu display, 
select [E Picture], and then press 
the `OK or 9 button.

 2 Press the + or − button to select 
[Browse], and then press the `OK 
or 9 button.

 3 Press the + or − button to select 
[Built-in], [microSD] or [USB], 
and then press the `OK or 9 
button.

 4 Select [IMAGE] folder, and then 
press the `OK or 9 button.

• Dates on which images were taken 
are displayed as a list.

 5 Press the + or − button to select 
a date images were taken, and 
then press the `OK or 9 
button.

 6 Press the + or − button to select 
a image file, and then press the 
`OK or 9 button.
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 7 Press the 9 or 0 button to 
move to the next image file. 

Erasing a images

 1 From the [Home] menu display, 
select [E Picture], and then 
press the `OK or 9 button.

 2 Press the + or − button to select 
[Browse], and then press the `OK 
or 9 button.

 3 Press the + or − button to select 
[Built-in], [microSD] or [USB], 
and then press the `OK or 9 
button.

Viewing images (For DM-4)

 Note

• Only JPEG files that support the EXIF 
image format can be displayed by the 
recorder.
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 4 Select [IMAGE] folder, and then 
press the `OK or 9 button.

• Dates on which images were taken 
are displayed as a list.

Viewing images (For DM-4)

 5 Press the + or − button to select 
a date images were taken, and 
then press the `OK or 9 
button.

 6 Press the + or − button to select 
the image file you want to erase, 
and then press the F2 (ERASE) 
button.

 7 Press the + or − button to select 
[File Erase], and then press the 
`OK or 9 button.

 8 Press the + button to select 
[Start], and then press the `OK 
button.

• The display changes to [Erase!] and 
erasing will start. [Erase Done] is 
displayed when the file is erased.

• For details on how to erase a file, 
please see “Erasing from the file 
list display” (☞ P. 63), “Erasing all 
files in a folder” (☞ P. 64), “Erasing a 
folder” (☞ P. 65).
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Using voice recognition (For DM-4)

This recorder is equipped with a voice 
recognition function. This function allows 
complicated key inputs such as date and 
time settings, keyword entry, and folder 
name changes to be performed by voice. In 
addition, it is possible to use voice command 
shortcuts to jump to the various modes and 
menu settings of the [Home] menu display.

Using voice control

 1 If you want to make settings by voice 
for items which have the [ ] mark 
in the instruction manual, press and 
hold the VOICE button (☞ P.16) while 
speaking into the microphone.

• The following explanation of the 
voice control function provides 
examples of actual operations that 
can be performed using this recorder.

[Time&Date] 
Using voice 
recognition for 
time entry

When you are setting the 
“hour”, “minute”, “year”, 
“month”, and “day” in the 
[Time & Date] settings, say 
the “year”, “month” and “day” 
or “time” you want to enter.
Example: When entering 
February 10, 2010

[Timer Rec]
Using voice 
recognition for 
time entry

When entering the [Start 
Time] and [Stop Time] in 
the [Timer Rec] settings, 
say the times.
Example: When the start 
time is 9:30

Example: When the end 
time is 11:00

[Timer Rec] 
Using voice 
recognition for 
keyword entry

Say a “Keyword” that is in 
the template.
Example: When setting 
“Conference”.

[Folder Name] 
Using voice 
recognition for 
settings

When changing a [Folder 
Name], say a “word” in the 
template.
Example: When changing 
the name to “Work”.

[Alarm] 
Using voice 
recognition for 
time entry

When setting the [Start 
Time] setting in the [Alarm] 
settings, say the “time”.
Example: When the start 
time is 6:30

[Schedule 
Setting] 
Using voice 
recognition for 
time entry

When entering the [Start 
Time] and [Stop Time] 
while [Add Schedule] set-
tings, say the “times”.
Example: When the start 
time is 9:30

Example:When the end 
time is 11:00

[Schedule 
Setting] 
Using voice 
recognition for 
keyword entry

Say a “Keyword” that is in 
the template.
Example: When setting 
“Conference”.
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10  february
2010,
10 : 20 AM

9 : 30 AM

11 : 00 AM

9 : 30 AM

11 : 00 AM

Conference

6 : 30 AM

Work

Conference
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Using voice commands

 1 While the recorder is paused at 
the [Home] menu display, press 
the VOICE button and say a voice 
command word.

• Voice commands cannot be used 
when [Recorder] mode is running or 
during an operation.

Voice commands list:

Home Recorder Music

Podcast*1 Book Picture*1

Schedule Preferences Daisy*2

Text Speech*2 Function*3

*1  When [Accessibility] (☞ P.76) is set to 
[On], these voice commands can not be 
used.

*2  When [Accessibility] is set to [Off], these 
voice commands can not be used.

*3  The voice guide announces the functions 
assigned to the Fn buttons.

• The following explanation of the voice 
command function provides examples of 
actual operations that can be performed 
using this recorder.

Transition to 
each mode

Except for recorder mode, 
say the name of the mode 
you want to launch to jump 
to that mode.
Example: When jumping to 
[Music] mode

The mode changes to 
[Music] mode.

Using voice recognition (For DM-4)

 Notes

• Voice recognition is difficult in 
environments with a lot of ambient noise. 
Use this function in quiet environments.

• The recognition rate may be affected by 
the pronunciation or tone of the speaker. 
Speak clearly and slowly.

Music
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Importing DAISY contents (For DM-4)

The recorder can be connected to CD-ROM 
drives with built-in USB connector to directly 
import content.

The recorder can be connected to CD 
players supporting storage (USB storage 
class). To do this, you can use the provided 
USB connection cable.

 1 From the [Home] menu display, 
select [D Audiobooks], and then 
press the `OK or 9 button.

• When [Accessibility] (☞ P.76) is set to 
[On], select [DAISY].

 4 Press the + or − button to select 
[DAISY Import], and then press 
the `OK button.

 5 Press the + button to select 
[Start], and then press the `OK 
button.

• The display changes to 
[Synchronizing] and import starts. 
The process is completed when [End] 
is displayed.

• Imported DAISY content will be 
saved into the [DAISY] folder inside 
[Audiobooks].

Before starting to import, insert the 
DAISY content CD into the CD-ROM 
drive.

• When [Accessibility] is set to [Off], 
please go to step 4.

 2 Press the F3 (Menu) button to 
display the menu.

 3 Press the + or − button to select 
[Daisy Menu], and then press the 
`OK or 9 button.

 Note

• The recorder can import DAISY files 
created using DAISY version 2.0/2.2.
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Using the Olympus Sonority

Saving files in your PC

By being connected to a PC, the recorder 
enables you to do the following:

• Playback voice files on your PC (☞ P.136).
 Voice files recorded using the recorder can 

be played using the “Olympus Sonority” 
software included on the provided CD-
ROM (☞ P.125) or "Windows Media Player" 
(☞ P.150).

• Voice files recorded on the recorder can be 
played and managed on the PC using the 
“Olympus Sonority”.

• Using the “Windows Media Player”, the 
stored WMA or MP3 files on your PC can be 
transferred and played back on this recorder 
(☞ P.153).

• If an upgrade (Option) to the “Olympus 
Sonority Plus” is executed or a Music Editing 
Plug-in is added (Option), various additional 
functions can be utilized (☞ P.148).

Precautions on using the recorder connected 

to a PC

• When you are downloading a file from 
the recorder or uploading a file to the 
recorder, do not remove the USB cable 
even if the screen is indicating you can. 
Data is still being transferred while the LED 
indicator light is blinking. When removing 
the USB cable, be sure to follow the 
description in ☞ P.124. If the USB cable is 
removed before the drive is stopped, data 
may not be successfully transferred.

• On a PC, do not format the drive of the 
recorder. Initialization is not successfully 
achieved on a PC. For initialization, follow 
the instructions in the [Format] display of 
the recorder (☞ P.99).

• Folder (directory) names displayed by 
file management tools such as Explorer 
in Microsoft Windows and Finder in 
Macintosh are different from the folder 
names that can be set with the recorder or 
the “Olympus Sonority”.

• If folders or files stored on the recorder 
are moved or renamed by using a 
file management tool in Windows 
or Macintosh, the order of files may 
be changed or files may become 
unrecognizable.

• Data can be written or uploaded to the 
recorder even though the attribute of the 
recorder drive is shown as Read-only by 
the operating system of the PC.

• As the noise may cause adverse effects on 
electronics devices nearby the recorder, 
unplug the external microphone and 
earphone when you connect the recorder 
to a PC.

Important notice on the explanation of 

software functions

Function items that can be used in Windows 
will be displayed as Windows  and function 
items that can be used in Macintosh will be 
displayed as Macintosh . Items that only have 
Windows  or Macintosh  indicated can only be 

supported by the target system.
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Operating environment

Windows
Operating System:

 Microsoft® Windows® XP Service Pack 2, 3
Microsoft® Windows® XP Professional x64 
Edition Service Pack 2

 Microsoft® Windows Vista® Service Pack 1, 
2 (32bit/64bit)

 Microsoft® Windows® 7 (32bit/64bit)
CPU:

 32 bits (x86) of 1GHz and above or 64 bits 
(x64) processor

RAM: 
512 MB or more

Hard drive space: 
300 MB or more

Drive:

 CD-ROM, CD-R, CD-RW, DVD-ROM drive
Browser:

 Microsoft Internet Explorer 6.0 later
Display:

 1024 x 768 pixels or more, 65,536 colors 
or more (16,770,000 colors or more is 
recommended)

USB port: 
One or more free ports

Others:

• Audio device
• Environment where the Internet can be 

utilized.

Macintosh
Operating System:

 Mac OS X 10.4.11 - 10.7
CPU:

 PowerPC® G5 or Intel Multicore Processor 
1.5 GHz and above

RAM: 
512 MB or more

Hard drive space: 
300 MB or more

Drive:

 CD-ROM, CD-R, CD-RW, DVD-ROM drive
Browser:

 Macintosh Safari 2.0 later
Display:

 1024 x 768 pixels or more, 32,000 colors 
or more (16,770,000 colors or more is 
recommended)

USB port: 
 One or more free ports
Others:

• Audio device
• Environment where the Internet can be 

utilized (Quick Time version 7.2 or more is 
recommended).

 Notes

Windows:
• The support service will not cover if your 

PC has been updated from Windows 
95/98/Me/2000 to Windows XP/Vista/7.

• Any failure on a self-modified PC will 
not be covered under the operational 
warranty.

Macintosh:
• Some functions in "Olympus Sonority" 

require QuickTime 7.2 and above.
 The latest version of QuickTime can 

be obtained from the MacOS Software 
Update.
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Connecting to your PC

Connecting to your PC

Windows    Macintosh

 1 Turn the recorder’s power ON.

 2 Connect the USB connection 
cable to the USB port of the PC.

 3 Make sure that the recorder is 
stopped, and then connect the 
USB cable to the connecting port 
on the bottom of this recorder.

• [Remote (Storage)] is displayed 
on recorder if the USB cable is 
connected.

• When the recorder is using the USB 
connection setting, it will not be 
connected to the PC when [AC] 
is selected. Select [PC] in the USB 
connection setting (☞ P.98).

Windows:
When you connect the recorder to a 
Windows and open [My Computer], it will 
be recognized by the drive name of the 
product name. If a microSD card is inserted, 
[Removable Disc] will be displayed.

Macintosh:
When you connect the recorder to a Mac 
OS, it will be recognized by the drive name 
of the product name on the desktop. If a 
microSD card is inserted, [Untitled] will 
be displayed.

 Notes

• Be sure to use the included dedicated 
cable for the USB connecting cable. If 
any other company’s cable is used, it will 
be the cause trouble. Also, please do not 
connect this dedicated cable to any other 
company’s product.

• When connecting the recorder through 
an USB hub the operation may become 
unstable. In such cases, refrain from using 
a USB hub.
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Connecting to your PC

Disconnecting from your PC

Windows  

 1 Click [ ] on the task bar 
located at the lower-right corner 
of the screen. Click [Safely 
remove USB Mass Storage Device].

• The drive letter will differ depending 
on the PC being used.

 2 Confirm that the recorder LED 
indicator light is gone before 
disconnecting the USB cable.

• The LED indicator light will light up 
(orange) in case of charging, however 
you can still disconnect the USB cable 
in such condition.

Macintosh  

 1 Move the drive icon for this 
recorder that is appear on the 
desktop to the garbage bin by 
Drag & Drop it.

 2 Confirm that the recorder LED 
indicator light is gone before 
disconnecting the USB cable.

• The LED indicator light will light up 
(orange) in case of charging, however 
you can still disconnect the USB cable 
in such condition.

 Notes

• NEVER disconnect the USB cable while the 
LED indicator light is flashing. If you do, 
the data will be destroyed.

• When the recorder is connected to a PC, 
the power will be supplied from the USB 
cable.

• Refer to the user’s manual for your PC 
regarding the USB port on your PC.

• Be sure that you connect the USB cable 
either directly to the USB port on your PC.

• Be sure to push the cable connector all the 
way in. Otherwise, the recorder may not 
operate properly.

• Cancel Hold mode.
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Functions available in the Olympus Sonority

Various functions such as file management and editing are installed in the “Olympus 
Sonority”. For information on operating procedures and detailed settings, please refer to the 
respective items on online help (☞ P.130).

Waveform editing function

Using the Waveform Editing Function Tab, you can easily process the voice data. In the 
Waveform Editing Mode, you can also delete unnecessary parts, paste and re-save the data.

One-touch effect function

Using the One-touch Effect Function, you can easily apply special effects to the voice file and 
carry out noise reduction in any specified area.

Send voice files with E-mail

Voice files are stored in the [Message] folder on the hard disk. Voice file can be sent as an 
E-mail attachment.

Changing user ID

The user ID will be automatically given to files that are recorded with the recorder.

Changing a folder name

You can change a folder name. A folder name can be up to 62 characters long and cannot use 
\ /:*?”<>|.
When changing the folder name using an OS in a language not supported by the main 
device, the words may sometimes be garbled.

Editing file comments

It is possible to add comments to the files downloaded from the recorder by using the “Olympus 
Sonority”.

Changing the file format to other format*

The current saved file format can be changed to other formats.

Joining files*

In “Olympus Sonority” , designated multiple voice files can be joined and one voice file can 
be created.
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Functions available in the Olympus Sonority

Splitting files*

One designated voice file can be split into the two files in “Olympus Sonority”.

Import files using Olympus Sonority

• Import Podcast content from the Internet to a computer.
➥ Please see “About Podcast” (☞ P.139) for details.

• Import DAISY content from the Internet to a computer.**

➥ Please see “About DAISY (For DM-4)” (☞ P.144) for details.

* Changing to a MP3 format upgrade to the “Olympus Sonority Plus” is necessary (☞ P.148).
** DAISY 2.0/2.02 content is supported (☞ P. 144).
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Installing software

Before you connect the recorder to your PC and use it, you must first install the “Olympus 
Sonority” software from the included Software CD.
Be sure to confirm the following before installation:

• Exit all running applications.
• You need to log on as an Administrator.

Windows

 1 Insert “Olympus Sonority” into 
the CD-ROM drive.

• The installation program will start 
automatically. Once the program 
starts, jump to step 4. If it does not, 
follow the procedures in steps 2 and 3.

 2 Opening contents in the CD-ROM 
with [Explorer].

 3 Double-click [Setup] in the CD-
ROM.

 4 When the “Olympus Sonority” 
launch screen is displayed, click 
the desired language to select it.

 5 When [Olympus Sonority Setup] 
is clicked, the Installer Opening 
display will start up. Follow the 
Installer Wizard instructions.

 6 Confirm your acceptance of the 
terms of the Licensing Agreement.

• You must accept the terms of the 
Licensing Agreement to install 
“Olympus Sonority”. After checking 
the [Agree] box, click [Next].

 7 [Registration of User Registration 
Information].

• Please enter your name, company 
name and serial number which is 
listed on the separate sheet. Click 
[Next] after entering.

 8 [Select Setup Type].

• The installation destination can be 
changed. Click [Next] if you do not 
want to change (Select [Custom] if 
you want to change).

 9 [Start Installation].

• Click [Install] to start installing. Do 
not carry out other operations before 
the installation is completed and the 
[Complete] display is displayed.

 10 [Installation Complete].

• When the installation is completed, 
the completed [Install Shield] 
display will be displayed.

• To connect the recorder to a PC, 
refer to “Connecting to your PC” 
(☞ P.123), to start up the Olympus 
Sonority, refer to “Running Olympus 
Sonority” (☞ P.131).
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Macintosh

 1 Insert “Olympus Sonority” into 
the CD-ROM drive.

• Proceed to step 3 when the content of 
CD-ROM is displayed, and go to step 2 
and 3 when nothing is displayed.

 2 Opening contents in the CD-ROM 
with [Finder].

 3 Double-click [Setup] in the CD-
ROM.

 4 When the “Olympus Sonority” 
launch display is displayed, click 
the desired language to select it.

 5 When [Olympus Sonority Setup] 
is clicked, the installer opening 
display will start up. Follow the 
Installer wizard instructions.

 6 Confirm your acceptance of the 
terms of the licensing agreement.

• You must accept the terms of the 
licensing agreement to install 
“Olympus Sonority”. After checking 
the [Agree] box, click [Next].

 7 [Changing the Installation 
Destination].

• The installation destination can be 
changed. Click [Next] if you do not 
want to change (Select [Change 
Installation Destination] if you want 
to change).

 8 [Start Installation].

• Click [Install] to start installing.
• When the installation is completed, 

the completed [Installer] display will 
be displayed.

• To connect the recorder to a PC, 
refer to “Connecting to Your PC” 
(☞ P.123), to start up the “Olympus 
Sonority”, refer to “Running 
Olympus Sonority” (☞ P.131).

• After starting up the “Olympus 
Sonority”, the serial number entry 
dialog box will appear. Serial number 
which is listed on the separate sheet. 
After entering, click [OK] and the 
“Olympus Sonority” will start up.

Installing software
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Uninstalling software

To uninstall any of the software component of the “Olympus Sonority” software installed on 
your PC, follow the steps below.

Windows

 1 Exit “Olympus Sonority”.

 2 Select [Start] from [Control Panel] 
menu.

 3 Click [Add/Remove programs] in 
the control panel window.

 4 When the installed application 
list is displayed, select [Olympus 
Sonority].

 5 Click [Change/Remove].

 6 Confirmation of deleting the file.

• Click the [OK] button to start 
uninstalling. An additional message 
may appear, if so, read it carefully and 
follow the instructions given.

 7 When the [Maintenance 
Complete] display is displayed, 
click [Finish] to complete 
uninstalling.

Macintosh

 1 Exit “Olympus Sonority”.

 2 Open [Finder] and double-click 
the [SonorityUninstaller.pkg] in 
the application folder.

 3 The Uninstaller will start up. 
Follow the wizard instructions.

 4 When the administrator 
password is asked, enter the 
password then click [OK].

 5 Uninstall will start and when 
[Successful] is displayed, click 
[Close].

Files left after uninstallation

The voice files you made are stored in the [MESSAGE] folder. If you don’t need them, delete 
them.
You can confirm the location of the [MESSAGE] folder by clicking [Options] in the [Tools] 
menu before uninstalling.
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Using online help

Windows    Macintosh
To open Online Help, you have the following options.
• While “Olympus Sonority” is running, select [Contents] from the [Olympus Sonority Help] 

menu.

Search by Contents

 1 Once the Online Help display 
appears, click the Contents tab.

 2 Double-click the  icon of the 
desired topic heading.

 3 Double-click the  icon of the 
desired topic.

• An explanation of the topic is 
displayed.

Search by Keyword

 1 Open Online Help and click the 
[Index] item.

• Matching keywords are located 
automatically.

 2 Click keyword.

• An explanation of the topic is 
displayed.

 Note

• For more information on menus and operations, refer to Online Help. You will be able to 
use Online Help after Olympus Sonority is installed.
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Running Olympus Sonority

By connecting the recorder to your PC, you can automatically start the application.

Windows

Disabling automatic start

 1 Right click on the [ ] of the 
taskbar on the lower right of the 
display, and select [Setting].

• The application which enables setting 
will be displayed by dialog.

 2 Click the [ ] of the [Olympus 
Sonority].

• The check mark on [Olympus 
Sonority] disappears. For automatic 
start, select and click “Olympus 
Sonority” to reinstate again.

Manual start

 1 Start Windows.

 2 Click the [Start] button, select 
[All Programs], then [Olympus 
Sonority].

• After start up, a [ ] icon will be 
displayed in task bar in the bottom 
right of the display.

Macintosh  

Disabling automatic start

 1 From the menu bar, click [ ] { 
[System Environment Setting] { 
[ ].

• The setting dialog box will appear.

 2 Turn the automatic start up in the 
setting check box to [OFF].

Manual start

 1 From Finder, double-click 
[Application] { [Olympus 
Sonority] { [Olympus Sonority].

• When starting up for the first time,the 
serial number registration dialog box 
will appear.

 2 Enter the Serial Number.

• For the product serial number, refer 
to the serial number on the separate 
sheet.

• The information display area will 
appear if the serial number is correct.

 Notes

• You cannot run more than one “Olympus Sonority” program or multiple copies of the same 
program simultaneously.

• When other applications such as DSS Player, etc. are opened, close these applications first 
before starting up the “Olympus Sonority”.
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Window names (Olympus Sonority)

1 Menu Bar
The OS standard menu bar.

2 Tool Bar
Tool Bar to be used in the Browse Screen 
will be displayed.

3 Playback Control Bar
Used to play selected files in the File 
Display Area.

4 Main Tree View
Files downloaded from the recorder, files 
recorded in the “Olympus Sonority”, etc., 
and folders containing voice/music files 
managed by the PC’s “Olympus Sonority” 
will be displayed.

Olympus Sonority browse screen

This is the main screen of the “Olympus Sonority” (The display screen is the display screen in 
Windows).

5 Device Tree View
Folders in the connected device will be 
displayed.

6 File List Display Area
Detailed information of the folders 
selected in the Main Treeview or Device 
Treeview and all voice files in the 
recorder will be displayed. 
The Information Display Area (Initial 
Setting) will be displayed when the 
“Olympus Sonority” is started up, and 
the basic information of the “Olympus 
Sonority” can be displayed, updated and 
upgraded (☞ P.148).
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When the “Olympus 
Sonority” is started up for 
the first time, Information 
Display Area will be 
displayed in the File List 
Display Area in the Browse 
Screen.
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Window names (Olympus Sonority)

Olympus Sonority information display area

“Olympus Sonority” Information Display Area Update of the “Olympus Sonority” and 
confirmation and update of the firmware of the connected recorder can be carried out. 
Upgrade to the “Olympus Sonority Plus” and registration of Podcast programs can also be 
carried out.

1 Audio File List
Selects Folder A in the Main Treeview 
and displays the File List Display Area.

2 Opening the Program Guide
Displays the latest information on the 
Podcast Program Guide.

3 Updating latest information
Updates the latest information from 
Olympus.

4 Viewing updated information
Confirms the updated information of the 
“Olympus Sonority” and recorder that is 
connected.

5 Registering the Upgrade Key 
Number
Registers the purchased upgrade key 
number.

6 Upgrade
Select the upgrade you want to 
purchase. When upgrade is completed, 
the button will be replaced by the 
upgrade key.

7 Display/Hide
Select to show or hide the Information 
Display Area the next time “Olympus 
Sonority” is started. When hide is 
selected, the File List Display Area 
(☞ P.132) will be shown.
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Download voice files from the recorder

Windows    Macintosh
There are 3 download options to transfer voice files from the recorder to the PC:

• Download Selected Files

• Download Folders

• Download All

 The following is an explanation of [Download Selected Files]. For explanations of 
[Download Folders] and [Download All], refer to Online Help (☞ P. 130).

Download Selected Files

 1 Select the folder.

• From the Device Tree View, select 
the folder that contains the voice 
file you would like to download. The 
illustration shows that [Folder A] has 
been selected.

 2 Select the voice file.

• Select the voice file you want to 
download from the File List Display 
Area.

To select more than one file:

Windows:

Hold either the [Ctrl] or [Shift] key and 
select files.

Macintosh:

Hold either the [Command] key and select 
files.
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 3 Download the voice file.

• From the [Device] Menu, select 
[Download Selected Files] or click 
[ ] on the Tool Bar.

 4 Download complete.

• Do not disconnect the USB cable 
while the LED indicator light on the 
recorder is flashing. Disconnecting 
the USB cable when the LED indicator 
light is flashing will result in data loss 
or corruption (☞ P.124).

 Notes

• NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will 
be destroyed.

• Depending on the size of the voice file and your PC, it may take some time to download the 
files.

• The downloaded files will be stored in the download tray folder that corresponds to the 
folder in the recorder.

 (Example: A voice file downloaded from [Folder A] will be stored in download [Folder A] 
on the Main Treeview.)

• When the same file name already exists, the new file is saved with another file name 
only when the contents are different. When the contents are the same, it will not be 
downloaded.

Download voice files from the recorder
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Play a voice file

Windows    Macintosh

 1 Select the folder.

• Select the folder that contains the 
voice file you would like to play.

 2 Select the voice file.

• Select the file to playback from the 
File List Display Area.

 3 Play the voice file.

• Click the [ ] (play) button of the 
Play Control Bar.

Other playback control such as Rewind, 
Fast Forward, Stop, Speed Control, Volume 
Control, Time Axis and Index Skip are 
available from the Play Control Bar.
For details, please refer to the Online Help 
(☞ P. 130).

1 2

3
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Using the waveform editing function

Windows    Macintosh
You can use the Waveform Editing Tab in the “Olympus Sonority” to easily process voice data. 
In the Waveform Editing Mode, you can also delete unnecessary parts, paste and re-save the 
data.

 1 From the Browse screen, select 
the file you want to edit, select 
[File] { [Edit].

• The waveform editing screen will 
appear and the waveform will be 
displayed.

 2 Drag and select the waveform 
you want to delete.

• Selected parts will become gray in 
the waveform display.

 3 Select [Cut] from the [Edit] Menu.

• The selected waveforms will be 
deleted.

 4 Click on any waveform display 
part.

• Selected waveforms in the waveform 
display will become gray.

 5 Select [Paste] from the [Edit] 
Menu.

• The waveforms that were cut 
previously will be inserted in the part 
selected.

 6 Click the Write Track Zone [ ].

• The Save dialog box will appear.

Using the one-touch effect function

Windows    Macintosh
Using the one-touch effect function, you can easily apply special effects to the voice file. 
Here we show you how to carry out noise reduction in a specified area.

 1 From the Browse screen, select 
the file you want to edit, select 
[File] { [Edit].

• The waveform editing screen will 
appear and the waveform will be 
displayed.

 2 Drag and select the waveform 
part you want to apply special 
effects on.

• Selected parts will become gray in 
the waveform display.

 3 Press the noise reduction 
adjustment button [ ].

• Noise will be removed from the 
selected part.

 4 Click the start location of the 
selected part and press the [ ]
button on the Playback Control 
Bar.

• The part where noise has been 
reduced will start to play.
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Upload voice files to the recorder

Windows    Macintosh
“Olympus Sonority” has a feature to enable you to upload files from your PC to the recorder.

 1 Select the folder.

• Select the folder that contains the 
voice file to upload from the Main 
Tree View.

 2 Select the voice file.

• Select the file you want to transmit 
from the File List Display Area.

 3 Select the folder to upload.

• From the [Device] menu select 
[Upload Selected Files] or click the 
Upload icon [ ]. Once the folder list 
box where the file is to be uploaded 
is displayed, select the folder from 
which the file is to be uploaded.

 4 Upload the voice file.

• Click [OK] to upload the voice file to 
the recorder.

 5 Upload complete.

• Once the transmission screen closes 
and the LED indicator light on the 
recorder is OFF, upload is completed.

You can also transmit a file by selecting the 
file you want to transmit from the File List 
Display Area, and then drag and drop it in 
the Device Treeview folder (move the mouse 
while pressing the left mouse button, and 
release the button at the destination).

 Notes

• NEVER disconnect the USB while the LED 
indicator light is flashing. If you do, the 
data will be destroyed.

• When the same file name already exists in 
the folder on the recorder, the new file is 
saved with another file name only when 
the contents are different. If contents are 
the same, it will not be uploaded.

U
p

lo
ad

 vo
ice files to

 th
e reco

rd
er



139

4

Drag and drop the 
icon to the Podcast 
registration icon.

About Podcast

Register a podcast program

Windows
You can either drag and drop the Podcast Program Icon to retrieve Podcast contents or 
search and retrieve it by registering the content address.
This function is not supported in Macintosh. Use iTunes, etc. to retrieve Podcast contents.

 1 Start Olympus Sonority.

 2 Open a web browser and go to a 
Podcasting site.

 3 Drag the Podcast registration 
icon and drop it in the [Podcast] 
folder in Olympus Sonority.

• Podcast registration icons differ 
depending on Podcasting sites. 
Please check each Podcasting site for 
details.

 4 Program registration will 
complete.

• When a program is registered, a list of 
broadcasting content provided by the 
program will appear in the [Podcast] 
folder’s list view. By default, the latest 
content at the time of registration will 
be automatically downloaded.

 Note

• About the file format which can be played 
back with the recorder, refer to P.50.
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Update a program

Windows

By default, programs registered in “Olympus Sonority” will be automatically updated. To change 
update intervals, go to [Tools] menu then [Options], and change them in the Options dialog’s 
Podcast tab.  Please see the Online Help for details (☞ P.130). 

If you don’t want to update programs automatically, you can update the using the following 
procedure.
Program registration, update and download functions are not available in Macintosh. Use 
iTunes or other applications for these functions.

 1 Select the [Podcast] folder.

 2 Select a program you want to 
update.

 3 Select [Update Podcast] from the 
[Tools] Menu or press the [ ] in 
the Tool Bar.

• Updating program starts.   
Once the program has been updated 
the new content will be displayed in 
gray. The content displayed in gray 
has not yet been downloaded onto a 
computer.

About Podcast
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1

Download the content

Windows

By default, if new content is found when a program is updated, the latest content will be 
automatically downloaded. This setting can be changed by selecting [Tools] then [Options] 
and going to the Options dialog’s Podcast tab.  Please see the Online Help for details (☞ P.130).

If you want to download manually, the content can be downloaded with the procedure 
described below. 
Program registration, update and download functions are not available in Macintosh. Use 
iTunes or other applications for these functions.

 1 Select the [Podcast] folder.

 2 Click the [ ] button of the 
content you want to download.

• Content downloading will start.
 The status is displayed by the 

percentage while contents are being 
downloaded.

 3 Download will complete.

• Downloaded content can be played 
and transferred to the recorder.
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Transfer content to the recorder

Windows    Macintosh
In the default setting, the content automatically transferred into the [Podcast] folder on 
the recorder when the recorder connects to a computer. This setting can be changed by 
selecting [Tools] under [Options], and by selecting the [Podcast] tab displayed on the 
Option dialog box. Please see the Online Help (☞ P.130) for details.
If you want to transfer content manually, follow the procedure below. 
Podcast contents registered in iTunes, etc. can be transmitted to this recorder by dragging 
and dropping it in the recorder’s [Podcast] folder.

 1 Select the [Podcast] folder.

 2 Select the content you want 
to transfer, and drag it to the 
[Podcast] folder of the recorder 
and drop it.

• Content transfer will start.
 A progress window will appear during 

transfer.

 3 Transfer will complete.

• Content transferred to the recorder 
will have an icon [ ] indicating a 
completed transfer. 

About Podcast

 Note

• NEVER disconnect the USB while the LED 
indicator light is flashing. If you do, the 
data will be destroyed.
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About Podcast

Program guide functions

Windows
OLYMPUS related podcast programs can be easily registered and new contents can be 
automatically downloaded on the “Olympus Sonority”. New contents can also be redirected 
to the recorder by just connecting to the PC.
Program guide functions are not available for Macintosh. 

To register programs

 1 Click [Channel Guide] in the 
online service of the Main Tree 
View.

• Information of programs registered 
online will be displayed.

 2 Click the program you desire 
from the program list.

• Detailed information on the program 
will be displayed in the Program 
Details View.

 3 Click [Subscribe] to register on 
the podcast.

• Once the program is registered, the 
contents broadcast by the program 
will be displayed in the List View of 
the [Podcast] folder.

 Under the initial settings, the latest 
contents being broadcast will be 
automatically downloaded during 
registration.
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About DAISY (For DM-4)

Windows    Macintosh

What does DAISY stand for?

DAISY stands for Digital Accessible Information System. Originally intended as a replacement 
for audio tapes for visually impaired people, the books and information are now used 
by people with various reading disabilities. DAISY is a worldwide accessible information 
system developed and maintained by the Daisy Consortium, an international collaborative 
development organization.

What is multimedia DAISY?

While listening to audio via computer, it is possible to simultaneously view drawings and 
pictures. Since the portion being read is highlighted, it is possible to know what section is 
being read. It is also possible to change the speed of the audio and jump to different pages. 
There are children and students studying with multimedia DAISY as learning materials.

How do you play multimedia DAISY?

After installing the “Olympus Sonority” software supplied with this recorder onto a computer 
(☞ P.127), select the [DAISY tray] folder from the browser window, and then press the play 
button to experience multimedia DAISY. During playback, it is possible to skip text and 
headings, as well as quickly jump to a section by clicking it. If a bookmark is set in advance, it 
is also possible to start playback from that position at any time. For more details, please see 
“Playing contents” (☞ P.146).

Detailed information about DAISY

For more detailed information about DAISY, please visit the following web page (English 
only). Official web page of the Daisy Consortium.
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Importing contents

DAISY book content can be imported into “Olympus Sonority”. The content can be played 
by selecting it from the [DAISY tray]. Import and playback are possible with Version 2.0/2.02 
DAISY content.

 1 Place a DAISY file or folder with 
DAISY files on the desktop of the 
computer.

 2 Start “Olympus Sonority”.

 3 From the [File] menu of “Olympus 
Sonority”, select [Import], and 
then [Import DAISY book].

• A file dialog box is displayed.
• Select the NCC.html file in the DAISY 

contents.

 4 Select the DAISY file to be 
imported and then click [Open].

• Import starts.
• Imported files are displayed as a list.

About DAISY (For DM-4)
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Playing contents

 1 Click [DAISY tray].

• A list of DAISY books registered in 
“Olympus Sonority” is displayed.

 2 From the list, click the title you 
wish to play.

• A file import window is displayed.

About DAISY (For DM-4)

1

2

3

 3 From the playback control bar, 
click [ ] (Play) to play the 
DAISY content.

• The DAISY content starts playing.
• Using the [ ] or [ ] button, 

you can skip to the previous or next 
section.

• Click the [ ] button to display the 
table of contents.
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Transfer content to the recorder

 1 Connect the recorder to a PC, and 
start Olympus Sonority.

• A device tree is displayed in Device 
Manager.

 2 Select the content you want to 
transfer.

• Select the file you want to download 
from the File List Display Area.

To select more than one file:

Windows:

Hold either the [Ctrl] or [Shift] key and 
select files.

Macintosh:

Hold either the [Command] key and select 
files.

 3 From the [Device] menu in 
“Olympus Sonority”, select 
[Upload DAISY book].

• The transfer of content starts.
A progress window is displayed while 
content is being transferred.

 4 Transfer will complete.

• Content transferred to the recorder 
will have an icon [ ] indicating a 
completed transfer. 

About DAISY (For DM-4)

3

2

 Note

• NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will 
be destroyed.
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Upgrade function

Windows    Macintosh
The “Olympus Sonority” can be upgraded 
to the Plus Version (Optional) to expand and 
improve its functions. In addition, in the 
“Olympus Sonority Plus”, you can purchase 
a Music Editing Plug-in to enjoy high-quality 
effect editing. To add a Music Editing Plug-
in, you will need to upgrade the “Olympus 
Sonority Plus”.

Purchase and upgrade

To purchase “Olympus Sonority Plus” and to 
upgrade from “Olympus Sonority” is shown 
in the following procedures.

 1 Start the “Olympus Sonority”.

• Please see ☞ P.131 for the starting 
method.

 2 Select [Purchase Olympus 
Sonority Plus] in the [Help] Menu 
or click the [ ] button in the Tool 
Bar.

• The web browser will start and 
the purchase site of the “Olympus 
Sonority Plus” will be displayed. 
Please operate according to guidance 
on the screen. When the purchase 
procedure is completed, the Upgrade 
Key will be issued by mail.

 3 Select [Upgrade to Olympus 
Sonority Plus] from the [Help] 
menu.

• The [Upgrade to Olympus Sonority  
Plus] dialog will be displayed.

 4 In the [Upgrade to Olympus 
Sonority Plus] dialog, enter the 
Upgrade Key of your purchase, 
and click the [OK] button.

• When starting the application next 
time, “Olympus Sonority” will be 
upgraded to “Olympus Sonority Plus”.

Upgrading to Olympus Sonority Plus

Click the root of the Main Treeview, 
[Olympus Sonority], in the Browse Screen 
to display the Information Screen. You can 
confirm that the upgrade key is registered. 
In addition, when [Version Information] 
in the [Help] Menu is selected, the upgrade 
key registered in “Olympus Sonority Plus” 
will be displayed. The Music Editing Plug-in 
includes more than 20 types of effect 
functions and spectrum analyzer functions. 
For details, please refer to the Online Help 
(☞ P. 130).

 Notes

• To purchase the Upgrade Key, it requires 
an environment where the Internet can be 
utilized.

• Please see the details in the website 
regarding the purchase of the Upgrade 
Key.
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Functions available in the Olympus Sonority Plus

Besides the usual functions, the “Olympus Sonority Plus” also includes various functions to 
edit music files. For information on operating procedures and detailed settings, please refer 
to the Online Help (☞ P.130).

MP3 editing

MP3 file and tag editing and writing function.

Creating music CD

Function to create music CD from voice files registered in the CD writable folder.

Recorder menu setting

Function for settings in this recorder (detailed settings such as recording mode, alarm 
setting, timer recording, etc.).

Functions available with the music editing plug-in

By purchasing a music editing plug-in, you can add high-quality functions to expand the 
music editing range in the “Olympus Sonority Plus”. For detailed purchasing method and 
operating procedures, please refer to the Online Help (☞ P.130).

Effect functions

You can use more than 20 high-quality effect functions to edit your music files.

Spectrum analyzer

Displays in the Waveform Display Screen the waveform distribution of an voice file being 
played in the real time.

Besides unrestricted track editing

It also removes the restriction on the number of tracks that can be edited.
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About Windows Media Player

Using Windows Media Player

5 7 9
6 8 04

32

1

1 Features taskbar

2 Seek slider

3 Shuffle button

4 Repeat button

5 Stop button

6 Previous button

7 Play button

8 Next button

9 Mute button

0 Volume slider

Window names

Windows Media Player 12 Windows Media Player 11

1 Features taskbar

2 Seek slider

3 Shuffle button

4 Repeat button

5 Stop button

6 Previous button

7 Play button

8 Next button

9 Mute button

0 Volume slider

Music files that have been imported to your 
computer from music CDs and acquired over 
the Internet can be transferred to and played 
back with this recorder. It supports WAV, MP3, 
and WMA format music files.
By using Windows Media Player, music files 
from music CDs can be converted (ripped) 
(☞ P.151).
Download Audible content available from the 
Audible web site for a fee to a computer.
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Using Windows Media Player

 1 Insert CD into the CD-ROM drive, 
and start Windows Media Player.

 2 From the Features taskbar, click 
[Rip CD] menu.

• If Internet connectivity is available, 
CD information is searched.

 3 Put a check mark on the music 
file that you want to copy.

Copying music from CD

Windows Media Player 12

 4 Click [Start Rip].

• Files copied to a PC are stored in 
WMA format. Music files copied are 
categorized by artist, album, genre, 
etc. and added to the play list.
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Windows Media Player 11

 1 Insert CD into the CD-ROM drive, 
and start Windows Media Player.

 2 From the Features taskbar, click 
[Rip] menu.

•  After clicking [Rip] menu, click [View 
Album Info] for Windows Media 
Player 10 as necessary.

• If Internet connectivity is available, 
CD information is searched.

 3 Put a check mark on the music 
file that you want to copy.

 4 Click [Start Rip].

•  For Windows Media Player 10: 
Click [Rip Music].

• Files copied to a PC are stored in 
WMA format. Music files copied are 
categorized by artist, album, genre, 
etc. and added to the play list.
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Transferring music file to the recorder

You can transfer the music files saved in your PC to this recorder. For how to copy the music 
files from the CD to your PC, please see “Copying music from CD” (☞ P.151).

Windows Media Player 12

 1 Connect the recorder to a PC, and 
start Windows Media Player.

 2 From the [Organize] menu, click 
[Options]. At the Options dialog 
box, click the [Devices] tab.

 3 From the Devices list, select 
[DM_4(or 2)], and then click 
[Properties].

• Click on the [Create folder hierarchy 
on device] to check.

 If you uncheck and synchronize the 
file, it will be transferred under the 
folder [Home], and the file will not be 
indicated. *1 *2

• The folder with artist name or album 
name is automatically created. This 
will make you find the file you want to 
listen to more easily.

*1 If [Create folder hierarchy on 
device] is checked by default, click 
to uncheck the box once, and click it 
again to check.

*2 After the synchronous transfer to the 
recorder, a file named “WMPInfo.xml” 
is created. If you delete this file, the *1 
may need to be set again.
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 4 Select the desired category from 
[Library] on the left, and select 
music files or albums to transfer 
to the recorder, and Drag & Drop 
them in [Sync list] on the right.

 5 Click [Start sync].

• The file is transferred to the recorder.

Windows Media Player 11

 1 Connect the recorder to a PC, and 
start Windows Media Player.

 2 From the Features taskbar, click 
[Sync].

 3 Click [Sync] menu again to select 
[DVR] { [Advanced Options] { 
[Set Up Sync], and set as follows.

• Click on the [Create folder hierarchy 
on device] to check.

 If you uncheck and synchronize the 
file, it will be transferred under the 
folder [Home], and the file will not be 
indicated. *1 *2

• The folder with artist name or album 
name is automatically created. This 
will make you find the file you want to 
listen to more easily.

 Note

• Refer to the online help of Windows Media Player for details.
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*1 If [Create folder hierarchy on 
device] is checked by default, click 
to uncheck the box once, and click it 
again to check.

*2 After the synchronous transfer to the 
recorder, a file named “WMPInfo.xml” 
is created. If you delete this file, the *1 
may need to be set again.

 4 Select the desired category from 
[Library] on the left, and select 
music files or albums to transfer 
to the recorder, and Drag & Drop 
them in [Sync List] on the right.

 5 Click [Start Sync].

• The file is transferred to the recorder.

 Notes

• Refer to the online help of Windows Media Player for details.
• To transfer the files by using Windows Media Player 9 or 10, check the Olympus website.
• If the music files are transferred to the recorder until it reaches to the maximum memory, 

the message [Can’t make the system file. Connect to PC and delete unnecessary file] 
may appear on this recorder’s display. In such a case, erase the files to make free space 
(hundreds of KB to dozens of MB depending on the music file sizes) for the management 
file (The more capacity for the management file will be necessary as the number of the 
music files increases).
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 1 Insert the blank CD-R/RW into 
the CD-R/RW drive, and start 
Windows Media Player.

 2 From the Features taskbar, click 
the [Burn] tab.

 3 Select the desired category from 
[Library] on the left, and select 
voice files or albums to copy to 
the CD-R/RW, and Drag & Drop 
them in [Burn list] on the right.

Windows Media Player 12

Copying voice file to the CD

You can transfer the voice files in the recorder to your PC and copy them to CD. For how to 
copy the voice files from the recorder to your PC, please see “Download voice files from the 
recorder” (☞ P.134).

 4 Click the [Burn] tab, and select 
[Data CD or DVD] or [Audio CD].

When [Audio CD] is selected:
• A file is converted and copied in 

CD in order to play it by the audio 
equipment which can play CD-R/RW.

When [Data CD or DVD] is selected:
• Copying files with the format to be 

recorded.

 5 Click [Start burn].
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Windows Media Player 11

 1 Insert the blank CD-R/RW into 
the CD-R/RW drive, and start 
Windows Media Player.

 2 From the Features taskbar, click 
the [Burn] menu.

 3 Select the desired category from 
[Library] on the left, and select 
voice files or albums to copy to 
the CD-R/RW, and Drag & Drop 
them in [Burn List] on the right.

 4 Click the [Burn] menu again, and 
select [Audio CD] or [Data CD].

When [Audio CD] is selected:
• A file is converted and copied in 

music CD in order to play it by the 
audio equipment which can play 
CD-R/RW.

When [Data CD] is selected:
• Copying files with the format to be 

recorded.

 5 Click [Start Burn].

 Note

• Refer to the online help of Windows Media Player for details.
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 1 Connect the recorder to a PC, and 
start Windows Media Player.

• If the player is in Now Playing mode, 
click [Go to Library] ( )on the 
upper right corner of the window.

Windows Media Player 12

Creating a playlist (For DM-4)

You can create playlists using Windows Media Player. If you save the playlist to the [Music] 
folder on this recorder, you can play songs in the desired order.

 2 Click the [Play] tab to open the 
list window.

• If it is necessary to delete list window 
content before creating a playlist, 
click [Clear list] from the [ ] icon.

 3 From the music titles displayed in 
the library window, click the title 
you wish to add to the playlist. 
Next, drag the title to the list 
window on the right side of the 
window.

2

3

1
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 4 In the list window, arrange the 
titles in the order you want to.

Using Windows Media Player

 5 From the top of the list window, 
click the [List options] ( ) button. 
From the menu that displays, select 
[Save list as].

 6 At the [Save As] display, enter 
a file name and then select the 
[MUSIC] folder of the recorder as 
[Destination]. Click [Save].

 7 Click the [Sync] tab. Drag the saved 
playlist to the synchronization list 
window on the right side of the 
window.

 8 Click [Start sync].
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 1 Connect the recorder to a PC, and 
start Windows Media Player.

 2 While the library window 
displayed, click [Library] and 
then [Create playlist].

Windows Media Player 11

 3 From the music titles displayed in 
the library window, click the title 
you wish to add to the playlist. 
Next, drag the title to the list 
window on the right side of the 
window.

 4 Click [Untitled playlist]. From the 
menu that displays, select [Save 
Playlist As].

Using Windows Media Player
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 5 At the [Save As] display, enter 
a file name and then select the 
[MUSIC] folder of the recorder as 
[Destination]. Click [Save].

Using Windows Media Player

 6 Click the [Sync] tab. Drag the saved 
playlist to the synchronization list 
window on the right side of the 
window.

 7 Click [Start Sync].

 Notes

• Songs in the built-in memory of the recorder and songs on external memory cannot be 
mixed in the same playlist.

• If the music files on the PC are not arranged as shown on P.164 (the default ripping 
configuration), it may not be possible to play the playlist correctly.
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Using iTunes

Window names

1 Features taskbar

2 Rewind button/
Playback, Pause button/

 Fast Forward button

3 Volume slide

4 Playlist addition button

Music files that have been imported to your computer from music CDs and acquired over the 
Internet can be transferred to and played back with this recorder.
By using iTunes, music files from music CDs can be converted (ripped) (☞ P.163).

5 Shuffle button

6 Repeat button

7 Display change button

8 Disc create button

9 Genius button

0 Genius side button

About iTunes

U
sin

g
 iTu

n
es



163

6

2

65

3 4

4

EN

U
sin

g
 iTu

n
e

s

Copying music from CD

Using iTunes

 1 Insert the CD into the CD-ROM 
drive, and start iTunes.

 2 Click [iTunes] { [Preferences].

 3 Click [Advanced] tag.

 4 Click [Importing] to set the file 
format and bit rate for copying 
music files to your PC, and click 
[OK].

• This recorder is compatible with 
music files in the MP3 and WAV 
formats (☞ P.50).

[Import Using]:
 Set the file format for copying music 

file from a CD. Please select [MP3] or 
[WAV].

[Setting]:
 Set the bit rate for copying music file 

from a CD. You can select a bit rate 
between [128], [160] and [192].

 5 Put a check mark on the music 
files that you want to copy.

 6 Click [Import CD].
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Transferring music file to the recorder

You can transfer the music files saved in your PC to this recorder. For how to copy the music 
files from the CD to your PC, please see “Copying music from CD” (☞ P.163).

 1 Connect the recorder to a PC, and 
start iTunes.

 2 Select the play list to be 
transferred to the recorder, and 
put the check marks on the music 
files that you want to transfer.

• The order of music pieces can be 
changed by Drag & Drop of the music 
file in the play list displayed.

 3 Double-click the corresponding 
drive with the recorder, and open 
[Music] folder.

• When you connect the recorder to a 
Mac OS, it will be recognized by the 
drive name of the product name on 
the desktop.

• Copy to [Music] folder of the recorder 
when transferring the music file.

 4 Select the desired files, and Drag 
& Drop them to [Music] folder.

Using iTunes

 Note

• Music files in the AAC format purchased from a music distribution service such as the 
iTunes Store cannot be played by this recorder.
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Copying voice file to the CD

You can transfer the voice files in the recorder to your PC and copy them to CD. For how to 
copy the voice files from the recorder to your PC, please see “Download voice files from the 
recorder” (☞ P.134).

 1 Insert the CD-R/RW into the CD-
R/RW drive, and start iTunes.

 2 Select the desired playlist, and 
put a check mark on the voice 
files to copy to the CD-R/RW.

 3 Click [Burn Disc]. 

 4 To set the CD format for copying 
voice files to CD-R/RW, and click 
[OK].

When [Audio CD] is selected:
 A file is converted and copied in 

music CD in order to play it by the 
audio equipment which can play 
CD-R/RW.

When [MP3 CD] is selected:
 Copying in MP3 format.
When [Data CD or DVD] is selected:
 Copying files with the format to be 

recorded.

Using iTunes
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First layer Second layer Third layer

Lists created and saved as a file on a computer are called playlist files. By transferring a 
playlist file to the [Music] folder of this recorder, it is possible to play songs in a particular 
order.
• With playlists, it is possible to play multiple songs on this recorder in a freely determined 

order.
• This recorder supports .m3u playlist files.

Creating a playlist

This section explains the procedure to create, transfer, and play a playlist. This explanation 
will use the files and folders shown in the [Music] folder below and play the files in order 
from 1 to 8.

BESTSONG-01.wma 
BESTSONG-02.wma
BESTSONG-03.wma 

HITSONG-01.mp3
HITSONG-02.mp3
HITSONG-03.mp3

LIVE-01.mp3 
LIVE-02.mp3
LIVE-03.mp3

NEWSONG-01.wma
NEWSONG-02.wma
NEWSONG-03.wma

1

2

5

8

7

4

6

3

Music Artist 01

Artist 02 Album04

Album03

Album02

Album01

Folder

File

Playing songs in a particular order

Other features
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 1 Click the [Start] button, select 
[Programs] { [Accessories] { 
[Notepad].

• Notepad opens.

 2 Enter the names of files in the 
[Music] folder in the order you 
want them to be played.

• The file names in the playlist are 
entered in the following manner: 
Drive letter (F:):\Folder name\File 
name.

• The easiest way to ensure that the 
file names are entered correctly is to 
open the properties for the file you 
want to enter into the play list, copy 
the file name, and then paste that 
name into the playlist being created 
in Notepad.

• If there are too many characters, 
playback may not be possible. As a 
guide, try to keep entries on a single 
line to within 256 characters.

A maximum of 999 songs can be 
entered into a single play list.

 3 From the [File] menu, select [Save 
As]. Enter a file name followed by 
the extension “.m3u” and then 
save the file.

Folder name File name

When there are layers of 
folders, use the “\” mark 
to indicate the layers 
when entering informa-
tion.

Playing songs in a particular order

Windows
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Playing songs in a particular order

 4 Drag the saved playlist file to the 
[Music] folder of the recorder to 
transfer it to the recorder.

• Transfer the playlist file to the top 
level (first layer) of the [Music] folder. 
For more details about file transfers, 
please see “Transferring music file 
to the recorder” (☞ P.153).

• For more details about playing 
transferred playlists, please see “File 
search” (☞ P.55).

 Note

• Playing files in a specified order using playlists is limited to files in the [Music] folder (for 
music playback).
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About Audio Books

Windows    Macintosh
Audio Books are books that can be listened to. Digital audiobooks can be played anytime and 
anywhere on players such as this recorder. Audio Books can be enjoyed in various ways. For 
example, they can be listened to while moving by train, doing housework and jogging.
• When [Accessibility] is set to [On], this function can not be used. To use this function, 

please set [Accessibility] to [Off] (☞ P.76) (For DM-4).

Transfer content to the recorder

 1 Connecting the recorder to your 
PC (☞ P.123).

 2 Select the content you want 
to transfer, and drag it to the 
[AUDIOBOOK] folder of the 
recorder and drop it with 
Explorer or Finder.

• The file is transferred to the recorder.

 3 Disconnect the USB cable 
and select [Audio Book] from 
[Audiobooks] in the menu setting 
screen.

• Transferred file list will appear.

 Notes

• NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will 
be destroyed.

• Audiobooks using the Digital Rights Management system (DRM) of the Microsoft 
Corporation are not supported.

• This recorder can play files in MP3 and WMA formats.

Drag & Drop
files here
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About Text Speech (For DM-4)

Windows    Macintosh
If a text file is transferred to this recorder and played, the text file can be read aloud. This 
recorder can read aloud text created in various situations and can be used to confirm or review 
audio content.

Transfer text file to the recorder

 1 Connecting the recorder to your 
PC (☞ P.123).

 2 Select the content you want to 
transfer, and drag it to the [TEXT] 
folder of the recorder and drop it 
with Explorer or Finder.

• The file is transferred to the recorder.

 3 Disconnect the USB cable 
and select [Text Speech] from 
[Audiobooks] in the menu setting 
screen.

• Transferred file list will appear.

 Notes

• NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will 
be destroyed.

• This recorder can play file format, which consists of only character data text file (. txt) only.
• Proper nouns (including names of people, locations, and organizations), symbols, 

acronyms, and foreign languages may not be read correctly.

Drag & Drop
files here
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Loading Audible content

Windows
Use the AudibleManager to load Audible content onto the recorder.
Playback, management, and transfer of Audible content to the recorder can be done using 
the AudibleManager.

Installing AudibleManager

When AudibleManager is not installed on a computer, install the AudibleManager according 
to the procedure described below.

 1 Access one of Audible web 
sites from the web browser and 
download the AudibleManager.

http://www.audible.com/ (United States)
http://www.audible.co.uk 
(United Kingdom)
http://www.audible.fr (France)
http://www.audible.de (Germany)

 2 Start up the downloaded 
executable file.

• The AudibleManager Setup screen 
will be displayed. Select the name of 
the device in use (OLYMPUS DM-4/2) 
and click the [Install] button.

 3 When the [AudibleManager 
License Agreement] is displayed, 
click the [I Accept] button.

 4 Installation starts.

• Wait until process has been 
completed. Once the installation has 
been completed AudibleManager 
starts up automatically.
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Adding device to AudibleManager

If AudibleManager has already been installed, add a device in order to handle the recorder in 
the AudibleManager. Follow the procedure described below.

 1 Select [Add New Device] in the 
[Devices] menu.

 2 When the dialog box displays, 
verify the internet connection 
and click the [Yes] button.

 3 When the dialog box is displayed, 
check the name of the device in 
use (DM-4/2) and click the [OK] 
button.

 4 Installation starts.

• Wait until the process has been 
completed. Once the installation has 
been completed, AudibleManager 
restarts.

 Verify that the device in use has been 
added to the [Mobile Devices] menu.

Purchasing Audible content

Audible content can be purchased from the Audible web site. Access to the Audible web 
site using web browser and download the content by following the purchase procedures 
described on the web site.
With the existing setting, content downloads to the Library folder in the AudibleManager. 
When download has been completed, the AudibleManager starts up and purchased content 
displays on the contents list in the Library.

Loading Audible content
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Transferring Audible content

Windows
Audible content can be transferred into the [Audible] folder on the recorder by following the 
procedure described below.

 1 Connect the recorder to a 
computer.

 2 Select [Library] in the [Audible 
Folders] tree listing.

• A list of content stored in the 
[Library] displays on the right side.

 3 Select the content to be 
transferred to the recorder and 
click the [Add to Device] button.

 4 When the [Activate Your Device] 
entry screen is displayed, enter 
the user name and password for 
Audible and click the [OK] button.

 5 The transfer begins.

• Wait until the transfer of the content 
has been completed. When it has 
been completed, the transferred 
content is displayed in the contents 
listing of the device. Also, the 
transferred content is displayed in the 
Library.

 Notes

• When a content file is transferred to the recorder, a [.pos] file will be automatically created 
for each content file in the Audible folder.

• When the [*.pos] file is deleted, using Explorer, the stored Playback Position will be deleted. 
The next time the file is selected, playback starts from the beginning of the file.

• When a content file is transferred to the recorder, a system file will be created as a hidden 
file inside the Audible folder. When this file is deleted using Explorer, it is no longer possible 
to playback the Audible content.
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Enjoy Audible content with the recorder

Audible content that has been transferred into the [Audible] folder on the recorder from 
a computer can be enjoyed with an exclusive mode optimally suited for the operation of 
Audible content.

Audible mode

When you select the [Audible] folder in the [Audiobooks] folder, the recorder automatically 
switches to the Audible mode. The Audible mode is an exclusive mode for enjoying Audible 
content (mode 4 format) transferred from a computer. The operating method for Audible 
mode differs from when other folders on the recorder are selected (Normal mode). Please see 
the “Operating recorder in Audible mode” (☞ P.176) for details.

File Display screen in Audible mode

In the Audible mode, play mode becomes the file setting 
regardless of the menu settings and the recorder stops after 
playing back one file. In addition, icon ( ) which 
indicate Audible files are also displayed on the File display 
screen.
a Audible file indicator

Re-playable Audible files

Files of mode 4 format can be played back in the Audible mode. Only those Audible files 
that have an [.aa] extension are displayed in the Audible mode (in the Audible folder on the 
recorder).

Re-playable Audible files format

Mode Codec

4( ) MP3 (32kbps)

 Notes

• This recorder does not support the Audible modes 2 and 3 formats.
• This recorder does not support the Audible Enhanced Audio format.
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Enjoy Audible content with the recorder

Playback position and section

In the Audible mode, the starting position can be moved easily by referring to the Playback 
Position which is the positional information stored from previous stops for each file, and by 
referring to “Section” where the content distributor has preset the position.

Playback position

The Playback Position (positional information) is stored in the [.pos] file, which is created 
automatically by the recorder for each Audible content file ([.aa] file).
The Playback Position is initially located at the beginning of the file, and the stop position will 
be updated by playback or the use of S. Play (slow playback)/F. Play (fast playback).
Press the 9 or 0 button to move the stop position while the recorder is stopped. The 
Playback Position will not be updated.

Section

Up to a maximum 100 divisions (chapters of a story or segments of news) are set arbitrarily for 
each file by the distributor of the content.

 Notes

• When a content file is transferred to the recorder, a [.pos] file will be automatically created 
for each content file in the Audible folder.

• You can not set the Index marks in the Audible mode.
• When the [*.pos] file is deleted, using Explorer, the stored Playback Position will be deleted. 

The next time the file is selected, playback starts from the beginning of the file.
• When a content file is transferred to the recorder, a system file will be created as a hidden 

file inside the Audible folder. When this file is deleted using Explorer, it is no longer possible 
to playback the Audible content.
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Operating recorder in Audible mode

The operating method on the recorder is different in the Audible mode when the [Audible] 
folder or Audible file is selected, then while in the Normal mode.

Enjoy Audible content with the recorder

Forwarding

Press and hold the 9 button while the 
recorder is stopped.

➥ When the button is released fast 
forwarding stops. The Playback 
Position is not updated. When the 
`OK button is pressed playback 
resumes from that position.

Press and hold the 9 button while 
playing a file.

➥ When you release the 9 button 
the recorder will resume normal 
playback.

• If the starting position of a section 
(☞ P.175) and the playback position are in 
the middle of a file, the recorder stops at 
that position.

• When the 9 button is held down while 
the recorder is stopped, the recorder 
moves to the end of the file and then 
stops.

 If the 9 button is still held down, 
the recorder moves to the next file and 
continues fast forwarding from the 
beginning of the file. After fast forward 
reaches the end of the last file, the 
recorder stops at the beginning of the last 
file.

• When the 9 button is held down 
during playback and the end of the file 
is reached, the recorder goes back to the 
beginning of the file and stops.

Rewinding

Press and hold the 0 button while the 
recorder is stopped.

➥ When the button is released fast 
rewinding stops. The Playback Position 
is not updated. When the `OK button 
is pressed playback resumes from that 
position.

Press and hold the 0 button while playing 
a file.

➥ When the button is released playback 
resumes from that position.

• If the starting position of a section 
(☞ P.175) and the playback position are in 
the middle of a file, the recorder stops at 
that position.

• When the 0 button is held down while 
the recorder is stopped, the recorder 
returns to the beginning of the file and 
then stops. If the 0 button is still held 
down, the recorder moves back to the 
end of the previous file and continues fast 
rewinding.

• When the 0 button is held down 
during playback and the recorder reaches 
the beginning of the file, the recorder 
starts playback from the beginning of that 
file.

• If the 0 button is kept pressed while 
the recorder is stopped at the start of 
the top file, the recorder will fast rewind 
starting from the end of the last file.
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File Skip and Section Skip

Press the 9 button while the recorder is 
stopped.

➥ The recorder skips to a playback 
position or the starting position of a 
section, whichever is closer in the file, 
and stops.

 After a stop position, if there is no 
playback position, or a starting position 
of a section, the recorder will skip to a 
playback position in the next file and 
stop.

Press the 0 button when the recorder has 
stopped at the beginning of a file.

➥ The recorder skips to the Playback 
Position of the previous file and then 
stops.

Press the 0 button if the recorder has not 
stopped at the beginning of a file.

➥ The recorder skips to a playback 
position or the starting position of a 
section, whichever is closer in the file, 
and stops.

Press the 9 button during playback.
➥ The recorder skips three seconds 

forward, or to the starting position of 
the next section, whichever is closer, 
and starts to playback the file. After 
reaching the end of the file the recorder 
stops at the beginning of the file. The 
Playback Position is updated to the 
beginning position of the file at this 
time.

Press the 0 button during playback.
➥ The recorder skips three seconds back, 

or to the starting position of the current 
section, whichever is closer, and starts 
to playback the file. When the recorder 
reaches the beginning of a file the file 
plays from the beginning.

• The [Skip Space] (☞ P.75) setting is invalid 
in the Audible mode.

Enjoy Audible content with the recorder
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Using as external memory of the PC

In addition to its uses as an IC recorder and a music player, this recorder can also be used as 
external memory for a computer by storing data from a computer and reading it back out.
With the recorder connected to your PC, you can download data from the memory to your PC 
and upload data stored on your PC to the memory.

Windows

 1 Connecting the recorder to your 
PC (☞ P.123).

 2 Open the Explorer window.

• When you open [My Computer], it 
will be recognized by the drive name 
of the product name.

 3 Open the product name folder.

 4 Copy the data.

 5 Disconnect the recorder from the 
PC (☞ P.124).

Macintosh

 1 Connecting the recorder to your 
PC (☞ P.123).

• When you connect the recorder to a 
Mac OS, it will be recognized by the 
drive name of the product name on 
the desktop.

 2 Double-click the product name 
icon on the desktop.

 3 Copy the data.

 4 Disconnect the recorder from the 
PC (☞ P.124).

 Note

• While transmitting data, [Busy] is displayed, and the LED indicator light flashes. NEVER 
disconnect the USB while the LED indicator light is flashing. If you do, the data will be 
destroyed.

USB Microphone/USB Speaker

You can connect the recorder to a computer as a USB microphone or USB speaker.

 Note

• When using it as a USB microphone, regardless of the recording mode of this recorder, it 
becomes the USB stereo microphone. If you want to connect an external microphone to 
this recorder, use a stereo microphone.
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Other information

Alarm message list
Message Meaning Explanation Action

[Battery Low] Low battery power. Battery power is getting 
low.

Charge the battery 
(☞ P.24 to P.25).
If you run out of battery soon 
after the charge, the battery 
life has ended. Replace with 
new battery (☞ P.23).

[File Protected] Erase-locked. Tried to delete a locked file. Unlock the file (☞ P.77).

[Cannot record in this 
folder]

Not an audio-recording
folder.

Recording has been 
attempted with a [Music], 
[Podcast], [Audiobooks] 
(DAISY, Audible, Audio 
Book, Text Speech) folder.

Select a folder from 
[Folder A] through 
to [Folder E] and try 
recording again (☞ P.34).

[Index Full] Index full.
The file is full of index 
marks (maximum of 16 
marks).

Erase index marks that 
are no longer required 
(☞ P.53).

[Folder Full] Folder full. The folder is full of files 
(maximum of 999 files).

Erase unnecessary files 
(☞ P.62).

[Memory Error] Error in the memory. Error in the memory.

This is a malfunction, so 
go to the store where you 
purchased the recorder or 
an Olympus service station 
for repair (☞ P.186).

[Card Error] Error in the memory. microSD card is not 
recognized correctly.

Remove the microSD card 
then put it again (☞ P.32 
to P.33).

[Licence Mismatch] Illegally copied file. The music files copied 
illegally. Erase the file (☞ P.62).

[Memory Full] Zero remaining memory. No remaining memory. Erase unnecessary files 
(☞ P.62).

[No File] No file. No files were found in 
the folder.

Select another folder 
(☞ P.55 to P.61).

[Format Error] Formatting error.
There was an error while 
formatting the recorder’s 
memory.

Reformat the memory 
(☞ P.99).

[Can’t make the 
system file. Connect 
to PC and delete
unnecessary file]

The management file 
cannot be created.

The file for management 
cannot be created due to 
a shortage of capacity for 
remaining memory.

Connect the recorder to a 
computer and delete any 
unnecessary files.

[Cannot play this file]
File which cannot be 
played. Incompatible format.

Please confirm the file 
that can be played on this 
recorder (☞ P.50).
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Symptom Probable cause Action

Nothing appears on 
the display

The battery is not loaded properly. Check the direction of the battery 
(☞ P.23).

Battery power is getting low. Charge the battery (☞ P.24 to P.27).

The power is off. Turn the power on (☞ P.28).

Won’t start

Battery power is getting low. Replace with new battery (☞ P.23 to P.27).

The power is off. Turn the power on (☞ P.28).

The recorder is in HOLD mode. Release the recorder from HOLD (☞ P.29).

Unable to record

Low remaining memory. Erase unnecessary files (☞ P.62).

The maximum number of files has 
been reached.

Change to the another folder
(☞ P.34).

No playback tone 
heard 

The earphone is connected. Unplug the earphones to use the 
internal speaker.

The volume level is set to [00]. Adjust the volume level (☞ P.48).

The recording level has not been 
adjusted.

Adjust the recording level and then try 
recording once more (☞ P.69).

Recording level too 
low

The microphone sensitivity is too low. Set the microphone sensitivity to [High] 
or [Middle] mode and try again (☞ P.69).

This could potentially be because 
the output level for the connected 
external devices are too low. 

Adjust the output level for the
connected devices.

Message Meaning Explanation Action

[Please Select The 
File]

Unselected File File is not selected.
Please select a file then 
carry out the operation 
(☞ P.55 to P.61).

[Same folder. Can't be 
moved(copied).]

File cannot be moved 
(copied).

Attempting to move (copy) 
into the same folder.

Please select another 
folder.

[Same files. Can't be 
moved(copied).]

File cannot be moved 
(copied).

File in the destination 
with the same name, or 
file with DRM.

Please select another file.

[This file can't be 
divided.]

File which cannot be split.
Attempting to split a file 
besides the PCM files 
recorded in this recorder.

Please select another file.

Alarm message list/Troubleshooting
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Symptom Probable cause Action

Voice files are not 
recorded in stereo

The connected external microphone 
is monaural.

When recording while an external 
monaural microphone is connected, 
sound will only be recorded by the 
L-channel.

[Rec Mode] is set to a monaural 
recording mode.

Set [Rec Mode] to the stereo
recording mode (☞ P.69).

Cannot find the 
recorded Voice File

Wrong folder. Switch to the correct folder
(☞ P.34).

Noise heard during 
playback

The recorder was shaken during 
recording. --------

The recorder was placed near a cell 
phone or fluorescent lamp while 
recording or during playback.

Move the recorder.

Unable to erase the 
file

The file is locked. Unlock the file (☞ P.77).

The file is read-only. Unlock the file or cancel the read-only 
setting of the file on the PC.

Unable to erase the 
folder

There are files which cannot be 
recognized with the recorder.

Connect the recorder to PC for erasing 
files.

Noise is audible 
through the recording 
monitor

Acoustic feedback is occurring.

When the built-in speaker amps and 
the like are connected there is a risk 
that audio feedback will occur while 
recording. It is recommended that you 
use earphones for the recording monitor.

Conduct adjustments like separating 
the earphones from the microphone 
further, do not point the microphone 
at the earphones, lower the volume on 
the recording monitor, and so on.

Unable to set index 
marks

The maximum number of marks has 
been reached. Erase unnecessary marks (☞ P.53).

The file is locked. Unlock the file (☞ P.77).

The file is read-only. Unlock the file or cancel the read-only 
setting of the file on the PC.

Cannot charge
Contains battery other than the 
specified battery.

Please insert the chargeable battery 
provided.
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Accessories (optional)

Accessories exclusive to the Olympus IC recorder can be purchased directly from Online Shop  
on our company’s website. Sales of accessories are different according to the country. 

s USB connecting AC adapter: A514
DC5V AC adapter for USB connection

s 2 channel microphone 
(omni-directional): ME30W
Two ME30 monaural microphones come 
in a set with a miniature tripod and a 
connection adapter. These are highly 
sensitive omni-directional microphones 
supported by plug-in power which 
are well-suited to recording musical 
performances.

s Compact Gun Microphone 
(unidirectional): ME31
The directional microphones useful for 
recordings such as outdoor recording of 
wild birds singing. The metal-cut body 
provides a sturdiness to the high rigidity.

s Highly sensitive noise-
cancellation monaural 
microphone (unidirectional): 
ME52W
This microphone is used to record sound at 
a distance while minimizing surrounding 
noise.

s Tie clip microphone 
(omni-directional): ME15
Small concealing microphone with a 
tie-clip.

s Telephone pickup: TP7
Earphone type microphone can be 
plugged into your ear while phoning. 
The voice or conversation over the phone 
can be clearly recorded.

s Connecting cord: KA333
Connecting cord which has stereo 
mini-plugs (ø3.5) with resistance at both 
ends. Use to connect from the earphone 
jack output of the recorder to the 
microphone input jack when recording. 
Converting plug adapters (PA331/PA231) 
which convert to the monaural mini plug 
(ø3.5) or monaural mini plug (ø2.5) are 
also enclosed.

s Lithium ion battery: LI-50B 
This lithium ion rechargeable battery 
is manufactured by Olympus. It is best 
paired with the LI-50C battery charger.
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Specifications

General points

4 Recording medium:
Built-in memory
DM-4: 8 GB
DM-2: 4 GB
microSD card (512 MB to 16 GB)

4 Recording format:
Linear PCM (Pulse Code Modulation) 
MP3 (MPEG-1 Audio Layer3)
WMA (Windows Media Audio)

4 Input level:
[Mic Sense]: [Middle] - 60 dBv

4 Maximum working output:
280 mW (8 Ω speaker)

4 Maximum headphone output:
≤_ 150 mV (according to EN 50332-2)

4 Wide band characteristic 
headphone output:
75 mV ≤_  (according to EN 50332-2)

4 Speaker:
Built-in ø 23 mm round dynamic speaker

4 MIC jack:
ø 3.5 mm mini-jack, impedance 2.2 kΩ

4 EAR jack:
ø 3.5 mm mini-jack, impedance 8 Ω or 
more

4 Input power requirement:
Battery: Lithium ion battery
External power supply:  AC adapter(A515) 

5 V
4 External dimensions:

113.6 mm × 45.6 mm 15.2 mm
(without protrusions)

4 Weight:
98 g (including battery)

4 Operating temperature:
0°C - 42°C

Overall frequency response

4 During recording or playback 
mode:

 Linear PCM format

Recording mode
Overall frequency 

response

48 kHz 40 Hz to 23 kHz

44.1 kHz 40 Hz to 21 kHz

 MP3 format

Recording mode
Overall frequency 

response

320 kbps 40 Hz to 20 kHz

256 kbps 40 Hz to 20 kHz

192 kbps 40 Hz to 19 kHz

128 kbps 40 Hz to 17 kHz

 WMA format

Recording mode
Overall frequency 

response

ST XQ 40 Hz to 19 kHz

ST HQ 40 Hz to 16 kHz

ST SP 40 Hz to 9 kHz

HQ 40 Hz to 13 kHz

SP 40 Hz to 8 kHz

LP 40 Hz to 3 kHz

4 Built-in stereo microphone 
(During recording mode):
70 Hz to 20 kHz
However, when recording by the MP3 
format or the WMA format, the upper 
limit value of the frequency response 
depends on each recording mode (see 
above diagram).
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Guide to recording times

4 Linear PCM format:

Recording
mode

Built-in 
memory 

(4 GB)(DM-2)

Built-in 
memory 

(8 GB)(DM-4)

microSD card

2 GB 4 GB 16 GB

48 kHz 5h.5min. 10h.40min. 2h.40min. 5h.30min. 22h.15min.

44.1 kHz 5h.30min. 11h.40min. 2h.55min. 6h. 24h.15min.

4 MP3 format:

Recording
mode

Built-in 
memory 

(4 GB)(DM-2)

Built-in 
memory 

(8 GB)(DM-4)

microSD card

2 GB 4 GB 16 GB

320 kbps 24h.30min. 51h. 13h. 26h.30min. 107h.

256 kbps 30h.30min. 64h. 16h. 33h. 133h.

192 kbps 40h.30min. 85h.30min. 21h.30min. 44h. 178h.

128 kbps 61h. 128h. 32h.30min. 66h. 267h.

4 WMA format:

Recording
mode

Built-in 
memory 

(4 GB)(DM-2)

Built-in 
memory 

(8 GB)(DM-4)

microSD card

2 GB 4 GB 16 GB

ST XQ 60h. 125h. 32h. 64h.30min. 261h.

ST HQ 120h. 251h. 64h. 129h. 523h.

ST SP 240h. 503h. 128h. 259h. 1046h.

HQ 240h. 503h. 128h. 259h. 1046h.

SP 473h. 991h. 253h. 510h. 2060h.

LP 939h. 1967h. 502h. 1014h. 4089h.

 Notes

• The above values are strictly rough guides.
• Variations in the available recording time will arise as there may be differences in the available 

memory depending on the microSD card.
• Caution is required, since the differences in the available recording time will increase when 

the bit count and bit rate are low.
• Available recording time may be shorter if many short recordings are made (The displayed 

available recording time and recorded time are approximate indications).
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4 Linear PCM format:

48 kHz 3h.

44.1 kHz 3h.20min.

4 MP3 format:

320kbps 29h.40min.

256kbps 37h.10min.

192kbps 49h.40min.

128kbps 74h.30min.

4 WMA format:

ST XQ 72h.50min.

ST HQ 145h.40min.

ST SP 291h.30min.

HQ 291h.30min.

SP 574h.

LP 1139h.20min.

Specifications 

 Notes

• The maximum capacity for a single file is limited to approx. 4 GB for WMA and MP3.
• The size limit for a file in the Linear PCM format is approx. 2 GB.

Guide to battery life

4 Lithium ion battery:

Recording mode

Built-in stereo 
microphone

(During recording 
mode)

Built-in 
speakers

(During playback 
mode)

Earphone Playback

PCM 48kHz 13h. 12h. 20h.

MP3 128kbps 25h. 12h.30min. 20h.

ST XQ 24h. 12h.30min. 21h.

LP 29h. 13h. 22h.

 Notes

• The above values are strictly rough guides.
• Battery life is measured by Olympus. It varies greatly according to the type of battery used 

and the conditions of use.

Specifications and design are subject to 
change without notice.

Maximum recording time per file
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Technical assistance and support

The following are contact information for technical support for Olympus recorders and 
software only.
s Technical Hotline Number in the U.S. and Canada

1-888-553-4448
s User Support E-mail address in the U.S. and Canada

distec@olympus.com
s Technical Hotline Number in Europe

Toll free number: 00800 67 10 83 00
available for Austria, Belgium, Denmark, Finland, France, Germany, Italy, Luxemburg, 
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, United Kingdom
Charged numbers for the Rest of Europe
 + 49 180 567 1083
 + 49 40 23773 4899

s User Support E-mail address in Europe
Audio.Support@olympus-europa.com

Declaration of Conformity

Model Number : DM-4/DM-2
Trade Name : DIGITAL VOICE RECORDER
Responsible Party : OLYMPUS IMAGING AMERICA INC.
Address :  3500 Corporate Parkway, P.O. Box 610, Center Valley, PA 18034-0610, 

U.S.A.
Telephone Number :1-888-553-4448

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

Canadian RFI

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in 
the Radio Interference Regulations of the Canadian Department of Communications.

Cet appareil numérique ne dépasse pas les limites de la Catégorie B pour les émissions de bruit radio émanant d’appareils 
numériques, tel que prévu dans les Règlements sur l’Interférence Radio du Département Canadien des Communications.

Tested To Comply 
With FCC Standards
FOR HOME OR OFFICE USE
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